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Easy Data Transform data wrangling software for Windows and Mac.



Getting started

1 Getting started

1.1 Introduction

Easy Data Transform allows you to quickly transform table and list data into new and more
useful forms, without programming. The step-by-step visual transformation is quicker, more
interactive, more repeatable and less error prone than other approaches.

Please take a couple of minutes to read the Quick Start Guide.

1.2 System requirements
The suggested requirements for running this software are:

e Operating system: macOS 13.x to 10.13.
e Screen resolution: 1280x720 pixels or better.

If your operating system is more recent than the above, check our website to find a
compatible version of Easy Data Transform.

You may be able to run the software satisfactorily on lower specification systems or more
recent operating systems, but we can't guarantee it. If in doubt, try running an unlicensed trial
version before you buy a license.

1.3  Quick start guide

This is a quick tour of some of Easy Data Transform's features. It should only take a few
minutes to complete.

Start Easy Data Transform. If the Free Trial window appears, click Continue free trial. If the

Getting Started window appears, click I got this! (or you will just end up back on this page).
You should now see the main window.

Easy Data Transform © 2023 Oryx Digital Ltd
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L] L] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
Dhe&gag . : oS a3 ® * How Do I?
v Input
From File @

From Cliphoard (7}

Add datasets you want to transform by:
- dragging dataset files here; or
- clicking the 'From File' or 'From Clipboard’ buttons

[ Email us questions/feedback

Make sure that Auto Run tool bar button is checked (pressed in), so that any changes you
make are processed automatically after a short delay.

0 E’ﬁhD

Drag a data file you want to transform onto Easy Data Transform. For example a CSV file or
an Excel .xlIsx/.xls file. XML, JSON, fixed width, plain text and vCard formats are also
supported.

Easy Data Transform © 2023 Oryx Digital Ltd
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Ll L] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)
D8 o Q&8 3 @ * How Do I?
v Input vaccination.csv @ ey
From Fiie @ File: [UsarsfandybiDesktop/ vaccination,csv =
From Cliphoard (7} Type: Delimited text [ 2]
¥ Transform Delimiter:  Automatic (2]
Al transtarms (2] Quoting:  Automatic
Case @
Encoding:  Automatic a
Chap (:’)
- Ignere: First O row(s) =)
N
Clane &) has header
Compare Cobs (3) frim whitespace
N simplify whitespace
concat Cols  (2) ianare empty rows
Conza Rows (Z) watch file
Copy Cols @ o Meta info:  Not added
vaccination.csv
Count @ L Alias: vacsination
) 3 cols x 50K rows BETEl Warnings | info | Comment | Results
(2
— 3 cals x 5,780 rows
Date Format  (7)
= C K £ = Show first 10 rows (@
Decode @)
country time bcg_vacc
Dedupe @ 2 &=
1 aig 1382 10
Extract @
2 af 1883 10
Fill @ C
af 1984 N
Firar @) 3 afg
. i
Gather @ 4 afg 1985 17
Header @ 5 alg 1986 1B
o @ 8 afg 1987 27
iresert @ 7 alg 1988 40
)} 8 alg 1989 38

[ Email us questions/feedback

Notice that the available transforms are shown in the Left pane and the selected dataset is
shown in the Right pane.

In the Right pane, you can check has header, depending on whether you want to treat the
first row of the dataset as a header. For some input formats, such as JSON and XML, the
header is added automatically.
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File

lgnore

ClE

vaccination.csv

Type:
Delimiter:
Quoting:

Encoding:

®|#

: [Users/andyb/Desktop/vaccination.csv

Delimited text
Automatic
Automatic

Automatic

: First O row(s)
+ has header
espace

' simplify whitespace
+ ignore empty rows

watch file
Meta info: Mot added
Alias: vaccination
Data Warnings Info Comment Results

3 cols x 5,780 rows

Vel

Show first 10 rows

country time | becg_wvacc

£ £ £» 4>

L]

L4

I
et

Transforms are shown in the Left pane. Hover over the transforms to see tooltips explaining

what they do. Click on the

? next to a transform button for more details.

Ensure the input item is selected and click on the Case transform button to change the case of

your data.
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DBBE o ® * How Do I?
v Input vaccination.csv @[22
a § -
a1 ) File: [UsersfandybfDesktep vaccination.csv
From Cliphoard (7} Type: Delimited text &
¥ Transform Delimiter:  Automatic ]
Alllzrsfarms _ & Quoting: Automatic
 Case |
T Encoding: Automatic &
T A
N Ignore: First O row(s) -
N
Clane &) + has header
Compaca Cols  (3) o trim whitespace
+ smplify whitespace
cancatCols  (3)  ignore empty rows
Conza Rows (Z) watch file
Copy Cals @ X ) Meta info: Mot added i+
vaccination.csv
Count @ L Alias: vacsination
=) 3 cols x 50K rows Data ‘Warnings Infa  Commant Results
(2
— 3 cals x 5,780 rows
Date Format  (7)
. [l P2l Show first 10 rows &
Decode @)
country time bcg_vacc
Dedupe @ 2 &=
1 aig 1382 10
Extract @
2 af 1883 10
Fill @ C
af 1984 N
Fater ® 3 o
- i
Gather (_3.3 4 afg 1985 17
= 5 afg 1986 18
Header @
- @) 8 afg 1987 27
iresert @ 7 afg 1988 40
3 8 alg 1989 38
] Email us questions/feedback
A Case transform item will now be added.
L] L Easy Data Transform v1.16.0 (licensed to Oryx Digital Ltd)
ODBEBEE o~ Q@8 #£ & * How Do I?
v nput Gase o[z
P
From File @ =
= CLF
From Cliphoard (7}
@ country
v Transform tima
Al transfarms (2] beg_vace
[ )
= ® 0 of 3 columns selected
-,
Chop @ Change case to:  Lowar case B8
3) .
Clone Q) ‘Change the case in the selected calumn(s),
3
Compare o8 (3) W warnings | info | Comment | Resuits
Cancat Cels 3 3 cols x 5,780 rows
Concat Rows ©) IEYC YA Show first 10 rows
Copy Cols @ L couniry time  beg_vace
vaccination.csv Case
Count @ A3 —_— 1 afg 1882 10
.@ 3 cols x 5.8k raws Aools x 58K rows 2 afg 1883 10
Date Format @ 3 afg 1984 1
Decode @ 4 alg 1985 17
Fey
Dedupe 2 5 afg 1986 18
g )
Extract &) & alg 1987 27
=
Fill @ 7 afg 1988 40
~ 5
Fiter Q) 8 afg 1989 38
o =)
Gather @ 9 afg 1980 30
=,
=
Hender @ 10 afg 1981 2
v e
Irsgarn 7)
@ Last 5,770 rows not shawn
)

[=] Email us questions/feedback
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In the Right pane, check one of the columns and set Change case to to Upper case. All the
text in that column will now be converted to upper case once you have stopped making
changes in the Right pane. You don't have to click a 'run’ button.

Case @ ::f" Ei
E |Cl Filter columns ~_|

country

time
bcg_wvacc

1 of 3 columns selected

Change case to:

Change the case in the selected column(s).

m Warnings | Info | Comment | Results

3 cols % 5,780 rows

FNEAPAIES Show first 10 rows

country time @ bcg_vacc

1 1982 10

2 1983 10

You can create a sequence of transforms to easily perform complex manipulations.

Jvaccination.csv v Case v Filter v Sort

3 wls x 5.8k mws 3 cok x58krows 3 cols x4.5krows 3 cols x 4.5k rows

Some transforms require more than one input dataset. For example, to stack two datasets,
one on top of the other:

e Select File>New to start again. Don't save the changes.

Drag two data files onto the Center pane.

Select both input items (by dragging a box around them or using Cmd+click).

Click the Stack transform button (you may need to scroll the Left pane to see the button).
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DEBE o~ OQ@&Aad4# @ vHwoor
=t = o (RA
i vaccination.cav @ P2
@
(:\ File: fUsarsfandybfDesktop vaccination.csv
=
,
Type: Delimited text &
interpolate (7
Delimiter:  Automatie ]
Interasst @
@ Quoting:  Automatic =
&)
-
Encoding:  Automatie s
Jein @ ng;
P bgnore: First O row(s) :
Loakup (2)
k t] + has h
vaccination.csv a5 hoader
@ + trim whitespace
o) 3 cols x 5.8k rows + simplify whitespace
Ly + ignore empty rows
@ wateh file
@ Metainfo: Mot added ¢
@) Alias: vaccination
@ Data ‘Warnings Info  Comment Results
@ 3 cols x 5,780 rows.
C B £ = Shaw first 10 rews &
vaccination2.csv country | time | beg_vace
3 cols x 4.5k rows 1 afg 1982 10
2 afg 1983 W0
3 afg 1984 11
4 alg 1885 17
5 afg 1986 18
& alg 1987 27
< 7 afg 1988 40

8 afg 1989 38

] Email us questions/feedback

The tables are now stacked one on top of the other in a new dataset item. You can choose to
match the columns by Header name or Column number.
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Ll L] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)

DEBE o~ Q% a#H @ * How Da 1?

- ® Stack @B (52
L) p—
e @ Align columns by:_ Header name )
- Merge input ets one on top of another.Orders by the
&) vertical of the input datasets.
® Warnings | Info | Comment | Results
&
- als x 10,258 rows
Jweaseript o) )
- G &R 2o Show first 10 rows  [B)
Q)
L2 =
= country  time  beg_vacc
7
(2 et
=~ vaccination.csv 1 afg 1882 10
Navw C @
2 alg 1983 10
Mum Format Q) 3 cols x 5.8k rows
. 3 afg 1284 M
Fad @
\2)
4 af 1985 17
Pivot @ 9
= Stack 5 alg 1986 18
Remave Cols
f
Rename Cals @ 3 cols x 10.3K rows & afg 1887 27
7 ai 1988 40
Reordaer Cols (:’-J g
Rapiace @ 8 afg 1989 38
e Hm ® vaccination2.csv a af 1980 30
£}
Samale @ 3 cols x 4.5k rows 10 afg 1991 21
Slicw @
Sart @ Last 10, 248 rows not shown
Sgilit Cail @
Split Foorws (@)
Spread @
[0

Stamp

[ Email us questions/feedback

Note that the vertical (Y) position of the inputs affects the order the datasets are stacked. Try
swapping the two inputs around and re-select Stack to see the affect.

Any changes to input options will cause the input file to be automatically re-read. Any
changes to input datasets or transform options will be automatically propagated
‘downstream’.

To export your transformed dataset to a file or the clipboard, view it in a local editor or see it
with whitespace displayed, click on the appropriate button in the Right pane.

Stack @1IE=dlpte

Align columns by: Header name <

Merge input datasets one on top of another.Orders by the
vertical positions of the input datasets.

Data Warnings Info Comment Results
3 cols x 10,258 rows

{@ Show first 10 rows o

You can also add an output item to automatically write a dataset to file whenever it changes.
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Ll L] Easy Data Transform v1.15.0 (licensed to Oryx Digital Lid)

DB8RE «n Q& # @ ¥ How Do l?

= b
Ramave Cols  (2) Stack el b
Feannmma Cals @ Align columns by:  Header name
= Merge input datasets one on top of another.Orders by the
Reorder Cods \E) vertical positions of the input datasets,
Aoplace & m warnings | Infe | Comment | Results
@)
= 3 cols x 10,258 rows
Faw Num @
=y G B 2| = Shaw first 10 rows
Samale Z)
- @ country time  bog_vacc
Sart @) vaccination.csv 1 afg 1882 W
af 1 ¥
Splh Sl @) 3 cals x 5,8k raws Y ¥ e L
Split Rows @ 3 afg 1884 1
Spread @ 4 afg 1985 17
@ Stack 5 alg 1986 18
o,
Stamp @ 3 cals 1 103k raws 6 afg 1987 27
Stats ® 7 afg 1988 40
Subsiitute @ 8 afg 1989 38
6 vaccination2.csv 8 alg 1880 30
Sumenary @ 3 cols x 4.5k rows 10 afg 1g@
Tatal @
Transpose @ Last 10, 248 rows not shown
Uriique @
Units @
Whitespace Q)

= Qut

('_-____Io Fie 3 @

[=] Email us questions/feedback

You will be asked for a file to write to. You can choose amongst CSV, Excel, HTML, JSON,
Markdown, Plain text, TSV, vCard, XML and YAML file formats. Select CSV file.

Save As: output ™
Tags:
Where: 5 andyb H

v CSV file (*.csv)
Excel fileM*x|sx)

- n e T [ [e—

Your dataset will then be written to this file every time it changes.
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Getting started

Ll L] Easy Data Transform v1.15.0 (licensed to Oryx Digital Ltd)

DEBE o~ Q% a#H @ * How Da 1?

1©) BUtPUL.CEV all - Ik
-
= File: [Usersjandyb/Desktop/output.cav -
L2}
® Type: Delimited text
= Delimiter: Comma () a8
(2
o Quating:  As needed 8
\Z)
) Ling endings: Autarmatic
L)
@ Enceding: UTF-8 2]
@ o & Byte Order Mark
~ Jvacunahun.cs-v Write mode:  Ovarwrite [
Lk
ool
C’\ e Alias: output
")
warnings | Info | Comment | Resuits
=
€ Stack - 3 cols x 10,258 rows
= ac output.csv
@ —_— P C B 7| = Show first 10 rews
@ 3 ols ¥ 10.3% rows 3 oois x 1003 rws
= couniry time beg_vacc
=
@ 1 afg 1982 10
=
('-J vaccinaion2.csv 2 sl 1883 W
@ <
- 3 cols x 4.5% rows 3 afg 1984 1
@
4 alg 1886 17
@
5 afg 1886 18
& afg 1987 27
@
7 afg 1988 40
@
. 8 afg 1989 38
L0,
9 alg 1980 30
s Output
& 10 afg 19 A
(2)

[ Email us questions/feedback

You can also specify the Delimiter, Quoting, Encoding, Line endings etc for your CSV files
in the Right pane.

output.csv @ tf‘ E ﬂ
File: jUsers/andyb/Desktopfoutput.csy
Type: Delimited text &
Delimiter: Comma (,) L+
Quoting: As needed o
Line endings: Automatic 4
Encoding: UTF-8 4
+ Byte Order Mark
Write mode: Overwrite S
Alias: output

You can save your transforms to a .transform document to use again with File>Save.

Have a play!
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Getting started

Tips:

e You can also watch a short introductory video.

e Check the show advanced check box in the Left pane to see all the available transforms.

¢ You can paste in data from the clipboard (for example, a table from a web page or Word
document) using the From Clipboard button in the Left pane.

e Transforms such as Compare Cols, Filter, If and Sort take account of dates, numbers and
text. You can define what date formats to recognize in the Preferences window.

e New columns are always added to the right of a dataset.

e Comparisons of text are sensitive to case, unless stated otherwise. E.g. "CASE", "case" and
"Case" are treated differently.

e Comparisons of text are sensitive to whitespace (e.g. spaces and tabs), unless stated
otherwise. You can use the Whitespace transform to remove unnecessary whitespace.

e The contents of input and output data files are not saved in an Easy Data Transform
.transform file, only their locations.

e As well as stacking two datasets, you can also Join them, side-by-side, if they have a
common (‘key') column.

e You can insert a new transform between existing items by selecting the connection between
the items and then adding the transform.

e To be more productive with Easy Data Transform see expert tips.

We are interested in your feedback, so please contact us to ask a question, report a bug or
request an enhancement.
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2 Reference
2.1 User Interface

2.1.1 Main window

The Main window comprises:
e Main menu
Tool bar

Left pane
Center pane

Right pane
e | 0Qg pane

Status bar

Tool bar Left pane Center pane Note Right pane

COVID-latest with notes. tranfform - Easy Data Transform v1.34.0 (licensedito Oryx Digital Ltd)

gaaa H# @ ¥ How Do I?

output.xlsx | F|E |3
@ (@ Output to fike:
From Cipboard (%) By date OQutput to:  Single file 5]
R Transform File: [Users/andyb/Desktopfoutput.xlsx
AN transforms a pa Type: Excel XLSX %]
shem sdvanced
] Transtorm keywor R [eon [ e A Formatting:  Automatic (2]
Calculate @ e === \'_ SR = \ e s
Write mode:  Owerwrite B Fie B
Case @
- = write header
3 L) )
e @ o DhEe ve W L Pl L Alias: output
= IEEH characters | wamnings| iafe | Comment| Details
Cluster 7)
a € cols x 155 rows & Writtan
=
Compars Cols 7 .
b o) @B/ O HE YV | bk
Concat Cols @ fp e L Bem L Fee L MemFowas | euputde
B — " — — countriesAndTe. Grand Sum dateRegp
Concat Aows @ A Bel 7765 2020-05-03
Per 10k country elgium TS 2020-05-0
Copy Cols @ By
2 Spain 25100 2020=-05=03
Count @
Italy 28710 2020=05=03
Cross @ .
_ - 4 United_Kingdom 28131 2020-05-03
DateTims Farmat G w  J5 item(s) processed in 1.581 second(s)
= I'p to date: 18, Needs updating: 0, Error: 1 5  Frane 24760 2020-05-03
Dabdh W [§] [ iremis) with warnings
& Heth 4987 2020-05-03
Dedups @ tarted run at: Thu Sep 15 13:53:20 2022
Extract @ Processed Output "output.xdsx’ (6 cols x 155 rgvs) in 0,138 second(s) [Wrigen] Up to date T Gweden 2669 2020-05=03
Ended run at: Thu Sep 15 13:53:20 2022
Fill @ 1 item(s) processed in 0.212 second(s) L Ireland 1265 2020=05=03
Up to date: 19, Meeds updating: 0,Error: O . 5 58 ) B
Filtisr @ 1 item(s) with warnings 2 United States_ §E385 2020=05=03
Gathar @ 10 Switzerland 1466 2020-05=-03
@14 01 Memdly usage: 0.4% of 4068 [=] i [ Email us questions fesdback
Input Log pane Transform  Output Status bar

You can split the Right pane onto a separate monitor (if available) by selecting View>Two
Screen Mode.
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2.1.2

2.1.3

2.14

2.15

2.1.6

Left pane

The Left pane shows all the available actions you can perform. Which actions are visible will
depend on what is shown in the Center pane. Which actions are enabled depends on what is
selected in the Center pane.

Center pane

The Center pane show the inputs, transforms and outputs you are using to transform your
data.

Right pane

The Right pane shows details of an input, transform or output item you have selected in the
Center pane.

Log pane

The Log pane shows a text representation of processing on the current .transform file. It
shows a maximum of 5000 rows.

e Click the X button to clear all text in the pane.

e Click the [E! button to select all text in the pane.

e Click the & button to copy selected text in the pane to the clipboard.

e Select View>Log (or the corresponding status bar button) to hide/show the pane.

Preferences window

General tab

Check give option to disable outputs when opening a .transform file if you want the
option to disable any outputs with write mode set to overwrite or append. This prevents
accidentally writing over existing files. Note that this check is never made when you open
.transform files with Run>Auto Run checked or using the -cli command line argument.

Check use native file windows to use the native Mac file open/save windows.

Check make a sound when processing completed if you want to make a system sound
every time processing is completed.

Set At start-up depending on what you want to happen when Easy Data Transform starts.

Set User interface theme to Automatic to follow the theme of the operating system or
override it by setting Light or Dark. This is only available if your operating system supports a
dark theme. Changing User interface theme does not update the Center pane colors. You
can also toggle between themes using a keyboard shortcut.
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Set Tool bar icon size to the size of the icons you wish to display in the tool bar.

Set Copy data to clipboard text/plain as according to how you want data to be formatted,

when it is copied to the clipboard with MIME type text/plain.

e Comma Separated Value uses comma as a column delimiter and quotes carriage returns,
commas and quotes within data.

e Tab Separated Value uses tab as a column delimiter and converts carriage returns and
tabs to spaces within data.

¢ Plain text outputs without any column delimiter.

Data is also copied to the clipboard with MIME type text/csv in Comma Separated Value

format and to MIME type text/html as an HTML fragment.

Set Optimize processing for to:

¢ Minimum memory use to use memory compression to reduce the memory used. This is
usually recommended. It works best when columns contain repeated values.

e Maximum speed to turn off memory compression. This might be faster, but uses a lot
more memory. It might also be slower if the memory required is more than your RAM. It
might also cause Maximum memory usage to be exceeded.

Set Maximum memory usage to the maximum amount of memory that you want Easy Data
Transform to be allowed to use. If this limit is exceeded the program will try to exit cleanly.

Set Right pane processing delay depending on how long you want to wait after changes in
the Right pane before starting processing, when Run>Auto Run is checked. Setting the
value to 0 is generally not recommended, as this means that every single click in the Right
pane will cause processing.

Set Zoom wheel behavior according to how you want the mouse wheel to work in the
Center pane. Hold down the Option key while moving the mouse wheel to switch between
zoom and scroll. If Scroll direction: Natural is checked in your Mac Settings>Mouse then
the directions will be reversed.

User interface font shows the font used for the application user interface, apart from data
tables (see below). Click Choose... to choose a new font. Click Default to set it back to the
operating system default.

Data table font shows the font used in the data tables in the Right pane. Click Choose... to
choose a new font. You might prefer a monospaced (fixed width) font such as Monaco or
Courier New. Click Default to set it back to the operating system default.

The Locale language and country setting affects how some numbers and dates are displayed.
Consequently it may have an affect on some transforms. It does not change the language of

the user interface, which is English only.
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Dates tab

Set Supported date formats to the date formats you wish to recognize. List the date formats
in order of preference, with the most likely to be used first.

Click Default (US) to replace the current supported date formats with US defaults.

Click Default (non-US) to replace the current supported date formats with non-US defaults.

Input Extensions tab
Set the default file types corresponding to input file extensions.

Click in the Extension column and type to change an input file extension. The text will be
trimmed of whitespace, converted to lower case and any "' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an input file extension.

Click Add to add a new input file extension.
Click Remove to remove the selected input file extension(s).
Click Default to set the input file extensions back to the default setting.

The order in which input file extensions are shown is not significant.

Output Extensions tab
Set the default file types corresponding to output file extensions.

Click in the Extension column and type to change an output extension. The text will be
trimmed of whitespace, converted to lower case and any "' characters removed.

Click in the Default type column and change the drop-down list to change the file type to
associate with an output file extension.

Click Add to add a new output file extension.

Click Remove to remove the selected output file extension(s).
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Click Default to set the output file extensions back to the default setting.

The order in which output file extensions are shown is not significant.

Colors tab

Select a Color scheme for the Center pane. A Preview is shown in the Preferences window.
Choose Custom to choose your own color scheme.

2.2 Input
22.1 Inputdata

You need to input data before you can transform it. Data can be input by:
e dragging a file onto the Center pane; or
e clicking the From File or From Clipboard button in the Left pane

Enter the file location in File or click the browse button. For Excel spreadsheets you also need
to add a sheet name, e.g. 'MySpreadsheet.xIsx[Sheet1]".

Easy Data Transform can input data from files in the following formats:
e delimited text file (e.g. CSV or TSV) with various delimiters

e Excel xlsx or xIs

e fixed width

e Plain text

* JSON

e vCard

o XML

You can select the input item in the Center pane and change any related options in the Right
pane.
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. . RA
vaccination.csv ff ]

(%) Input from file.
File: /Usersfandyb/Dropboxfvaccination.csv

Type: Delimited text

Delimiter:  Automatic

Quoting: Automatic
Encoding: Automatic
Ignore: First 0 row(s) :
has header
trim whitespace
simplify whitespace
ignore empty rows
watch file
Meta info: Mot added
Alias: vaccination
m Warnings | Info | Comment | Details

3 cols x 5,780 rows ) Read

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Input Extensions tab of the Preferences window.

For text files Easy Data Transform will treat CRLF, LF or CR control characters as line endings.

Easy Data Transform will make an intelligent guess at the:

e column delimiter and quoting for delimited text files (e.g. comma)

e column widths for fixed width text files

e text encoding for text files (e.g. UTF-8)

e presence of a header row in the data

But you can also do this manually by selecting the input item and changing the Delimiter,
Columns, Encoding and has header fields in the Right pane.

Set Ignore to the number of rows you want to skip before you start inputting. Note that this
takes place before any empty rows are removed by Ignore empty rows.

For delimited text you can:
e Set Delimiter to the delimiter character.
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e Check ignore repeated delimiters if you want to treat 2 or more consecutive delimiters as
a single delimiter.

e Set Quoting according to whether " quoting is used so that the delimiter can appear within
values.

See delimited text for more details.

For fixed width set Columns to Manual to set column widths. See fixed width for more
details.

For JSON or XML set Format to Long (more rows) or Wide (more columns) depending on
how you want to treat arrays/repeat values. See JSON or XML for more details.

Check trim whitespace to trim any whitespace (e.g. tabs or spaces) off the start or end of
data values.

Check simplify whitespace to:

e Replace any tabs or line feeds within data values with spaces.

e Replace non-standard spaces (such as non-breaking space, thin space etc) within data
values with spaces.

e Remove carriage returns within data values.

Check ignore empty rows to remove any rows that have only empty values (whitespace is
not considered empty).

Check ignore empty columns to remove any columns that have only empty values
(whitespace is not considered empty). Header values are ignored when deciding if a column

is empty.

Check ignore hidden rows and columns to remove any hidden rows or columns (Excel files
only).

Check watch file if you want :

¢ Run>Auto Run selected: the input to automatically reload the file every time that Easy Data
Transform detects that it has been changed.

¢ Run>Auto Run not selected: the input to be marked as 'Needs update' every time that
Easy Data Transform detects that it has been changed.

Use Meta info if you wish to add some meta information about the input dataset, e.g. the
name of an input file or the date it was created.

Use Alias to identify the file for batch processing.
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To change the file being used by an input, select the input item and change the file location in
the Right pane (e,g, by clicking the "..." browse file button), rather the disconnecting the input
and connecting a new one. Otherwise column-related parameters downstream will be reset.

2.3 Transforms
2.3.1 Transform data

Transforms operate on datasets from input data or other transforms. Some transforms only
have a single input (e.g. Case), some transforms have two inputs (e.g. Join) and some
transforms have two or more inputs (e.g. Stack).

To create a transform, select one or more input and/or transform items in the Center pane
and then click the appropriate button in the Left pane.

Select from the drop-down list in the Left pane to choose which types of transform are
displayed, e.g. select Merge Transforms to show only transforms related to blending data.

Check the show advanced checkbox in the Left pane to see all available transforms.

You can select the transform item in the Center pane and change any options related to the
transform (e.g. which columns it acts on) in the Right pane.

The transform will be updated automatically if any input or transform 'upstream' of it changes.

2.3.2 Calculate

Description
Performs a calculation on 1 or 2 columns and creates a new column.

Examples
Round a column of numbers to the nearest integer:
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date elol

1 1920-09-26 1503.947
2 1920-10-03 1503.42

3 1920-10-03 1503.42

V

Calculate Oq E Eg

@ Perform calculations on 1 or 2 columns to creat...

Operation: Round v
Value 1:  elo1l v
date elo1 Round(elo1)

1 1920-09-26 1503.947 1504

2 1920-10-03 1503.42 1503

3 1920-10-03 1503.42 1503

Divide a column of numbers by 100:
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Percentage

1 100.0

2 552

3 45.3

4 15.6

Calculate tf} e Ei

@ Perform calculations on 1 or 2 columns to creat...
Operation:  / Divide v
Value 1: Percentage hd
Value 2 type: Constant v

Value 2: 100.0

V

Percentage Percentage/100.0
1 100.0 1
2 95.2 0.952
3 453 0.453
4 15.6 0.156

Multiply 2 columns of numeric values:
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ItemID Quantity Cost
1 HG89397834 1 99.00
2 LK02384030 4 9.95
i
i 3 HG99200444 2 7.95
Calculate Ciﬁ == Ei
@ Perform calculations on 1 or 2 columns to creat...
Operation:  * Multiply v
Value 1: Quantity v
Value 2 type: Column v
Value 2: Cost v
ItemID Quantity Cost Quantity*Cost
1 HG89397834 1 99.00 99
2 LK02384030 4 995 398
3 HG99200444 2 795 159

Add a days column to a date column:
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Start Duration
1 31/12/2019 7

2 01/01/2021 14

3 07/01/2021 1

v

Calculate CF = Eg
@ Perform calculations on 1 or 2 columns to creat...
Operation:  + Add v
Value 1: Start v
Value 2 type: Column v
Value 2: Duration v

Start Duration Start+Duration
1 31/12/2019 7 7/1/2020
2 01/01/2021 14 15/1/2021
3 07/01/2021 1 8/1/2021

Calculate the difference in days between 2 date columns:
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Start End
1.31/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

'

Calculate tf} Ec
® Perform calculations on 1 or 2 columns to creat...
Operation: - Subtract v
Value 1: End v
Value 2 type: Column v
Value 2: Start ‘ b

Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

Inputs
One.

Options

e Set Operation to the operation you wish to perform.

¢ Set Value 1 to the first column of values you wish to operate on.

e Set Value 2 type depending on whether you wish to use a single value or a column of
values for the second value (binary operations only).
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e Set Value 2 to the second column of values or constant value you wish to operate on
(binary operations only).

Notes
e The following operations are supported.
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Easy Data Trdg

Operation Value 1
+ Add Number
Date
- Subtract Number
Date
Date
* Multiply Number
/ Divide Number
A Power Number
% Modulus Integer
number
Abs Number
And Boolean
Ceiling Number
DateTimeT I[SO
oMSecs datetime

axe)

Value 2 Notes

Number  Numerical addition.

Integer Adds days to the

number date.

Number  Numerical
subtraction.

Integer Subtracts days from

number the date.

Date Days the date in
Value 1 is after the
date in Value 2
(negative if before).

Number  Numerical
multiplication.

Number  Numerical division.

Number  Value 1 to the power
Value 2 (Value 1Value
2

).

Integer Remainder after
number  Value 1 is divided by
Value 2.

N/A The absolute value.

Boolean  Logical AND.

N/A The smallest integer
that is not less than
the value.

Integer Convert an ISO

number datetime to the
number of
milliseconds since
1970-01-

01:00:00:00.000 UTC

Examples

1.2 + 3 =4.2

31/01/2021 + 7
07/02/2021

1.2 - 3 =-1.8

31/01/2021 - 7
24/01/2021

31/01/2021 - 24/01/2021
=7

24/01/2021 - 31/01/2021
= -7

N R
>N ~ N
(@)

~J
o° oo
o N

Abs (
Abs (

1.2 ) = 1.2
-1.2 ) =1.2

And (
false
And (
And (

true, false ) =
1, 1 ) = true
0, FALSE ) = false

Ceiling( 1 ) =1
Ceiling( 1.2 ) =
Ceiling( -1.2 ) =

2
-1

DateTimeToMSecs ( 1970-
01-01 ) =0
DateTimeToMSecs ( 2022-
09-15T21:06:10 ) =
1663272370000
DateTimeToMSecs ( 1969-
12-30T13:42:23.211z ) =
-123456789

DateTimeToMSecs ( 2022-

© 2023 O
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e Each row is calculated separately.

e Whether values are interpreted as number, dates or text depends on Supported date
formats and locale.

e To concatenate text in different columns use the Concat Cols transform.

e To compare 2 columns use the Compare Cols transform.

For logical operations use the If transform.

For operations on whole rows or columns use the Stats transform.

For more complex calculations, including number/date, use the Javascript transform.

To modify the numerical precision of the results use the Num Format transform.

e To add a new column of values use the New Col transform.

See also:
e Video: How to convert a Unix timestamp

2.3.3 Case

Description
Changes the case of text in one or more columns.

Example
Set names to title case:
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First Last

1 john smith

2 JANE SMITH

Case tf:' @ E:
® Change the case in the selected column(s).

EI Q Filter columns
v First

Last
v

2 of 2 columns selected |

Change case to: Title case v
First Last
1 John Smith
2 Jane Smith
Inputs
One.
Options

e Check the column(s) you wish to transform.
¢ Set Change case to according to the case you want:
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Case Description Example output for '
WORD word Word !

Lower case Converts all letters to lower =~ word word — word !
case.

Upper case Converts all letters to upper ~ WORD WORD  WORD !
case.

Title case Converts the first letter of Word Word  Word !

each word to upper case and
all other letters to lower
case.

Sentence case Converts the first letter to Word word word !

upper case and all other
letters to lower case.

Lower camel case Converts the first letter for wordWordWord!

the second and subsequent
words to upper case and all
other letters to lower case.
Removes whitespace.

Upper camel case Converts the first letter of WordWordWord!

each word to upper case and
all other letters to lower
case. Removes whitespace.

Kebab case Replaces mu|t|p|e -WORD-word-Word-!

consecutive whitespace
characters with a single -
(dash) character.

Snake case Replaces mu|t|p|e _WORD_word_Word_!
consecutive whitespace
characters with a single _
(underscore) character.

Inverted case Convert lower case lettersto ~ word WORD  wORD !

upper case and upper case
letters to lower case.
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See also

e Whitespace
23.4  Chop

Description
Remove characters from the start or end in one or more columns.

Example
Remove leading zeros:

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

ID
1 0000001

2 0000002

3 0000003

¢

R A

Chop Cf} ¥ N
@ Remove a number of characters from the start o... |
E Q Filter columns

JID

1 of 1 columns selected

Length: 6 .
From: Start v
ID
1 1
2 2
3 3
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ Set Length to the number of characters you want to remove.

e Set From to Start or End depending on whether you want to remove characters from the
start or end.

Notes

e If you can to keep the original column use Copy Cols to copy the column first.

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before chopping.

e If you want to set a column to a fixed length use Pad and Chop together.

See also
e Extract

2.3.5 Clone

Description
Makes an exact copy of the input dataset.

Inputs
One.

Options

e None.

Notes
e Clone can be useful to simplify complicated layouts.

2.3.6 Cluster

Description
Classify rows with similar text into clusters

Examples
Clustering products by type:
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product unit cost stock
1 French red wine 23.95 9
2 BULGARIAN RED WN 11.95 15!
3 Red Label Whisky 38.45 1
4|/Gordon's Gin 25 7
5 German White Wine 14.95 6
6/Larios Gin 19.90 50
7 Black Label Whisky 45.50 8
8Wine, White, Dessert 30.00 1
9 Cocoa Cola 1.95 200
Cluster CP EC
@ Classify rows with similar text into clusters.
Column:  product ¥
Clustering: Manual v
GIN
RED WINE
WHITE WINE
Closeness: | 20% :
case sensitive

product unit cost stock Cluster Closeness
1 French red wine 23.95 9 RED WINE 53
2 BULGARTAN RED WN 11.95 13 RED WINE 5
3 Red Label Whisky 38.45 1 WHISKY 37
4 Gordon's Gin 25 7 GIN 2z)
5 German White Wine 14.95 6 WHITE WINE 58
Easy Data Tra x Digital Ltd
6 Larios Gin 19.90 50 GIN 30
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Correcting the state in an address:
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Street City State
1589 Timbercrest Road Haines Alaska
21289 Jerry Toth Drive ALASKA

3 3597 Blackwell Street Anchorage Alaksa

4 344 George Avenue Mobile Alabam
5/2555 Lonely Oak Drive Mobile ALABAMA
6 28le Barrington Court Pine Bluff arknsas
Cluster d:"' Eﬂ

@ Classify rows with similar text into clusters.

Column:  State v
Clustering: Manual v
Terms: AMERICAN SAMOA =
ALABAMA
ALASKA
ARIZONA
ARKANSAS
CALIFORNIA -
Closeness: 50% :
case sensitive
Street City State Cluster Closeness
1 589 Timbercrest Road Haines Alaska ALASKA 100
21289 Jerry Toth Drive ALASKA ALASKA 100
3 3597 Blackwell Street Anchorage Alaksa ATASKA 66
4344 George Avenue Mobile Alabam ALABAMA 85
52555 Lonely Oak Drive Mobile ALABAMA ALABAMA 100
628lc Barrington Court Pine Bluff arknsas ARKANSAS 87
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Inputs
One.

Options
e Select the Column whose values you wish to use for clustering.
e Select Clustering as:
o Manual to cluster by Terms you provide (one per line).
o Guided to find clustering terms automatically, starting with the Terms you provide (one
per line).
o Automatic to find clustering terms automatically.
e Set the minimum Closeness percentage for a value to a term to be clustered with a term.
¢ Set Max clusters to the maximum number of clustering terms (Guided and Automatic
only).
¢ Set Max time to the maximum amount of time allowed for trying to improve the terms
(Guided and Automatic only).
e Uncheck case sensitive to ignore case.

Notes

e Fuzzy matching is used to classify each row value according to which of the user supplied
Terms it is closest to.

e Additional Cluster and Closeness columns are added. The Cluster column shows the
closest matching of the Terms (or the one highest one in the Terms list if 2 or more match
equally). The Closeness column shows the fuzzy match score between 0 (no match) and
100 (exact match).

e Row values that do not meet the minimum Closeness score for any term are set to
<None>.

¢ Set the minimum Closeness score to 0% to force all values to be assigned.

e You can use a Filter to list all the rows with <None> in the Cluster column to guide you on
any additional Terms you might want to add in Manual mode.

See also:
e Ngram
e Video: How to cluster text

23.7 Compare Cols

Description
Creates a new column with a comparison of two other columns.

Examples
Compare 2 numerical columns:
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Reference

Value1 Value2
1 183.34 9267

2 7 7
3 -345 -8934
Compare Cols d} 555 EC
@ Compare the values of two columns.
Column 1:  Value1 v
Comparison: > Greater than v
Column 2:  Value2 v

v case sensitive

V

Value1l Value2 Valuel>Value2

1 183.34 926.7 false
2 7 7 false

3 -345 -893.4 true

Compare 2 date columns:
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Datel Datel
1 7/1/2021 01/01/2021

2 1/1/2021  01/01/2021

3 31/12/2020 01/01/2021

V

Compare Cols if} = Eg
@ Compare the values of two columns.
Column 1:  Datel v
Comparison: >= Greater than equal b2
Column 2: Date2 v
V' case sensitive

V

Date1l Date? Datel>=Date?2

1 7/1/2021 0170172021 true

2 1/1/2021  01/01/2021 true

3 31/12/2020 01/01/2021 false

Inputs
One.

Options

e Select the two columns you wish to compare as Column 1 and Column 2 and the
Comparison operator.

e Check case sensitive to use case sensitive matching for text.
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Notes

e Number, date and text values are treated differently for Equal to, Greater than, Less than,
Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than 0, because they will be compared as
text. So you might want to replace empty values with 0 or remove those rows with Filter,
before comparing them.

e Comparisons of text are whitespace sensitive. You can use Whitespace to remove
whitespace before filtering and Replace to get of other unwanted characters (e.g.
whitespace inside the text).

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

e See here for more details on Regular expressions (regex).

See also
e Split Cols

2.3.8 Concat Cols

Description
Creates a new column by concatenating text from existing columns.

Example
Concatenate 'First' and 'Last' columns with a comma between:
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Reference

First Last
1 John Smith

2 Jane Smith

RA

Concat Cols d: R

@ Concatenate selected columns into a single new...
E Q Filter columns

First
v

Last
v

2 of 2 columns selected
Delimiter: ,

keep empty

First Last First+Last

1 John Smith John,Smith

2 Jane Smith Jane,Smith

Inputs
One.

Options
e Check the columns you wish to concatenate.
e Supply the Delimiter you wish to place between concatenated text (optional). For example

noun
7.

e Check keep empty if you wish to keep the delimiter for empty columns.
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Notes

e If there is a header, the header of the new column is formed from the header of the
concatenated columns. You can use Rename Cols to change the new column name.

e Concatenating a single column makes a copy of the column.

e The values in the column are in the order of the original columns. You can change the
column order before concatenation with Reorder Cols.

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

e The opposite of Concat Cols is Split Col.

See also
e Concat Rows
e Substitute

2.3.9 Concat Rows

Description
Concatenate multiple consecutive rows into a single row.

Examples
Concatenate every 2 rows to 1:
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sensor datetime value

1 sensor1 1/1/18 0:00 578

3 sensor1 1/1/18 0:10 541

4 sensor2 1/1/18 0:10 702

y

Concat Rows d} =2 EQ
@ Concatenate multiple consecutive rows into a si...
Mode: Fixed v |
Create 1 row from every: 2 = .

v

sensor datetime value sensor datetime wvalue

1 sensor1 1/1/18 0:00 578 sensor2 1/1/18 0:00 764

2 sensor1l 1/1/18 0:10 541 sensor2 1/1/18 0:10 702

Concatenate values until empty:
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1 2

l

‘l‘John Smith
‘2|1 The Street

i 3/Townsville

' 4 |Wiltshire

!
|
i 5

9
Concat Rows tf’ EC
(?) Concatenate multiple consecutive rows into a si... :
Mode: Variable = .
Concatenate:  Until |
Matches: = Equal to v |
Value:

v case sensitive :

New row value: Omit v

1 2 3 4

1/John Smith 1 The Street Townsville Wiltshire




Reference

Concatenate values while not starting with 'ID":
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1
1 ID387423

2 Blue widget

3 100.00
4 123.45
5 ID&30300

& Green widget
7 78.90

& | ID835644

9 Red widget

10 12.34

11 111.11

12 7.7

Concat Rows tf} a5 EC

@ Concatenate multiple consecutive rows into a si...
Mode: Variable v
Concatenate: While v
Matches: I~ Doesn't start with x
Value: ID

v case sensitive
MNew row value: Add to row start v
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Concatenate consecutive rows with the same Orderld:

OrderId Item Price
1 1| 238533| 3432.89
2 2 526252 12.73
= 2. 012322- 231.98

Concat Rows Q{} E g

@ Concatenate multiple consecutive rows into a si...
Mode: By key v

v

Key column: Orderld

v repeat key column

v case sensitive

\

o ——r

OrderId Item Price OrderId Item Price
1 1 238933 3432.89

2 2| 526252 12.73 2 012322 231.98
=) 3| 823002' 11.99
Inputs
One.
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Options
e Set Mode to:
o Fixed to concatenate a fixed number of rows from the current dataset to make each new
row.
o Variable to concatenate values while or until a match to make each new row.
o By key to concatenate consecutive rows with the same value in a key column to make
each new row.
¢ Set Create 1 row from every to N, to concatenate every N rows into 1 row (Mode=Fixed
only).
¢ Set Concatenate to Until or While to keep concatenating until/while a match is found for
Matches and Value (Mode=Variable only).
e Check case sensitive to use case sensitive matching for text (Mode=Variable or By Key
only).
e Set New row value depending on what you want to do with the value that denotes a new
row (Mode=Variable only).
e Uncheck repeat key column to keep only the first key column (Mode=By Key only).

Notes

Use Sort before this transform if you need to change the row order.

Use New Col if you need to add additional columns before concatenating rows.
Use Filter if you need to remove rows before concatenating row.

Use Rename Cols if you need to change column names after concatenating rows.
The opposite of Concat Rows is Split Rows.

See also
e Spread

e Unique
e Concat Cols

2.3.10 CopyCols

Description
Creates one or more copies of the selected column(s).

Example
Copy 2 columns, once each:
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Reference

First Last
1 John Smith

2 Jane Smith

Copy Cols o || <
@ Copy selected columns.

o — s g
E] Q Filter columns

First
v I.I'S.

Last
v o

2 of 2 columns selected

Copies: 1

1)

First Last First Last

1 John Smith John Smith

2 Jane Smith Jane Smith

Inputs
One.

Options

e Check the columns you wish to copy.

¢ Set Copies to the number of copies you want to make of each checked column.
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Notes

e If there is a header, the header of each new column is the original column name. You can
rename columns with Rename Cols.

e The new columns are added at the right end. You can change the column order with
Reorder Cols.

See also
e New Col

2.3.11 Count

Description
Counts the number of occurrences of each item of text in the selected column.

Example
Count unique values in the 'Response’ column:
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Response

1YES
2 NO
3 NO

4 NO

Count Cf} E g

@ Count the occurences of text in the selected col...
Column: Response v
Sort by: Count b4

Order: Ascending v

v case sensitive

Response Count Response

1 YES 1
2 NO 3
Inputs
One.
Options

e Select the Column whose values you wish to count.

¢ Set Sort by depending on whether you wish to sort alphabetically by the Text in the left
column or numerically by the Count in the right column.

e Set Order depending on whether you wish to sort Ascending or Descending.
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e Uncheck case sensitive to convert everything to lower case before counting.
e Check drilldown to allow double-clicking a row in the data table to drilldown to the rows
that contributed to this value in the upstream data.

Notes

e Date and number values are treated as text.

e Use Rename Cols to change the new column name.
e Use Scale to convert the results to percentages.

See also
e Ngram

2.3.12 Cross

Description

Creates an output from combining every possible row combination of each input. E.g. if the
first input has N1 rows and the second input has N2 rows, then the result will have N1 X N2
rows. Also known as a 'Cartesian product' or ‘cross join'.

Example
Cross 2 small datasets:
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letter
B e — letter number
' Clipboard 1A 1
"-\ 1 col x 3 rows 2A 2
3C b
3A 3
Cross 48 1
V4 s
2 cols x 9 rows 5B 2
number 6B 3
11 y Je
., Clipboard
| 8C 2
) 1colx3rows
-
33 9C 3
Inputs

Two or more.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

Notes
e It can create a very large number of rows!

See also
e Join
e Stack
2.3.13 DateTime Format

Description
Changes the date and/or time format in one or more columns.

Examples
Change day/month/year to month-day-year:
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Reference

Date
131/12/2020

21/1/2021

42!112021 }

R

DateTime Format o dll = IIVE¢
@ Change the date and/or time format in the sele... r

E Q Filter columns ;

Date

v

1 of 1 columns selected

Format from: d/M/yyyy

S TEW WYY Y W OWT T v — pwr

Format to: MM-dd-yyyy

\

Date

112-31-2020

2‘01—01-2 021

3‘01-02—2{]21

Change 24 hour time to AM/PM time:
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Time

19:07:11

2‘13:14:15

3‘23:12:10

DateTime Format tf: D i
@ Change the date and/or time format in the sele...
E Q. Filter columns

Time

v

1 of 1 columns selected

Format from: h:mm:ss

Format to:  hh:mm:ss AP

\J

Time

109:07:11 AaM

201:14:15 PM

311:12:10 PM

Change datetime to ISO format:
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DateTime

131/12/2020 9:07:11 AM

21/1/2021 1:14:15 PM

32/1/2021 11:12:10 PM

B

DateTime Format dj E i

® Change the date and/or time format in the sele...
E’ Q Filter columns

DateTime

v

4 L8

1 of 1 columns selected

Format from: d/M/yyyy h:mm:ss AP

Formatto:  yyyy-MM-dd'T"HH:mm:ss ]

12020-12-31T09:07:11

DateTime

22021-01-01T13:14:15

| 3‘2021—0 1-02T23:12:10

Example formats for 21 May 2001 14:13:09.120 with locale set to English/United States:
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Format to Output

dd.MM.yyyy 21.05.2001

yyyy-d-M 2001-21-5

ddd MMMM d yy Mon May 21 01
hh:mm:ss.zzz 14:13:09.120

hh:mm:ss.z 14:13:09.12

hhmmss 141309

h:m:s ap 2:13:9 pm
yyyy-MM-dd'T'HH:mm:Ss.zzz 2001-05-21T14:13:09.120
HH:mm:ss 'in yyyy-MM-dd HH:mm:ss 14:13:09 in HH:mm:ss format
format'

Inputs

One.

Options

Check the columns you wish to transform.

Supply the existing date and/or time format in Format from (see below).

Supply the new date and/or time format in Format to (see below).

Use Non-date to set what to do for values that don't match Format from.

Use With value for values that don't match Format from when Non-date is set to Change
to user defined.

The following date and/or time formats are supported for input and output:
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Relates to Format

Date Years Yy

YYvy

Months M

MMM

Days d

dd

ddd

Meaning

The year as a two
digit number (00 to
99).

The year as a four
digit number. If the
year is negative, a
minus sign is
prepended in
addition.

The month as
number without a
leading zero (1 to
12).

The month as
number with a
leading zero (01 to
12)

The abbreviated
localized month
name (e.g. Jan' to
‘Dec'). Uses the
locale to localize the
name.

The long localized
month name (e.g.
‘January' to
‘December'’). Uses
the locale to localize
the name.

The day as number
without a leading
zero (1 to 31).

The day as number
with a leading zero
(01 to 31).

The abbreviated
localized day name
(e.g. 'Mon' to 'Sun’).



Reference

If not set, the default values are:

Value Default
Year 1900
Month 1

Day 1

Hour 0
Minute 0
Second 0
Milliseconds 0

Notes

e An exact match is expected for the input date. E.g. Format from is yyyy-MM-dd then
2020-12-17 will be converted, but 2020-12-17T14:58 won't. You can extract just the
date or time part here using Split Col with T as the delimiter.

e Use the correct case for the format text (e.g. yyyy-MM-dd, not YYYY-mm-DD).

e The locale is used to decide how the date is represented (e.g. names of months and days).

e Any non-empty sequence of characters enclosed in single quotes will be included verbatim
in the output string (stripped of the quotes), even if it contains formatting characters. Two
consecutive single quotes (' ') are replaced by a single quote in the output. All other
characters in the format string are included verbatim in the output string.

e Formats without separators (e.g. ddMM) are supported but must be used with care, as the
resulting strings aren't always reliably readable (e.g. if dM produces 212 it could mean
either the 2nd of December or the 21st of February).

¢ You can also use Split Col to split a date into its component parts. For example to split
"31/1/2019" into day, month and year components using the "/" delimiter.

e If the date to be converted has only two year digits, it is treated as a date between 1900
and 1999. E.g. "31/1/19" is interpreted in d-M-yy format as 31st January 1919. You can
avoid that issue by explicitly setting the century, e.g.:

Format from: MM/dd/yy
Format to:  MM/dd/20yy

Or you can use Replace. For example to replace 01/15/18 with 01/15/2018:
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Match Type Replace With
1/ Regex ¥ [(\d\d)/(\d\d)/(\d\d) \1A2/20\3

e Some dates do not exist, so cannot be converted. For example, 29-02-2023 matches the
format dd-MM-vyyyy. However the date does not exist, so won't be converted.

e Some datetimes do not exist, so cannot be converted. For example, if your Locale is
Spanish / Chile then 03-09-2023 0:00:00 may not be converted with Format from
dd-MM-yyyy H:mm:ss, as in Chile the clock is changed at 24 : 00 first Saturday of
September, so 0:00 of next Sunday doesn't exist. This can also depend on the time zone
set in your operating system.

e Warnings are shown in the Warnings tab for values that don't match Format from or don't
correspond to a real date or datetime.

¢ You can also do date and time format conversion using the Javascript transform.

See also
e Num Format

2.3.14 Decode

Description
Convert to/from Base64 encoding, URL encoding, escaped HTML or escaped XML.

Example
Convert <'Hello World!'> to base64 encoding:
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1
1 <'Hello World!' >

Decode d:' E Ea:
@ Convert to/from base64, URL, HTML or XML enc...
IE' Q Filter columns

v, 1

1 of 1 columns selected

Change: To base64 encoding v

1
1 PCdIZWxsbyBXb3JsZCEnPg==

Type Plaintext Encoded

Based64 encoding <'Hello World!'> PCdIZWxsbyBXb3JsZCEnP
g::

URL encoding <'Hello World!'> %3C%27Hello%20World%
21%27%3E

HTMLescaping <'Hello World!'> &lt; '"Hello

World!'&gt;

XML escaping <'Hello World!'> &1t; &apos;Hello
World! &apos; &gt;

Inputs
One.

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Options
e Check the column(s) you wish to transform.
e Set Change according to how you want to decode/encode the selected columns.

Notes
e This is distinct from text encoding (e.g. UTF-8 vs UTF-16) which is handled on input and
output.

e Use Copy Cols to copy columns before you transform them.
e Data input from XML files and output to HTML and XML files is unescaped/escaped
automatically.

2.3.15 Dedupe

Description
Remove duplicate rows.

Example
Keep the first row for each unique 'Customer Id":
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Name Customer Id Product ld Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown 89456 10.55 01/10/2020 |
3 Charlie Jones CO17783 96352 19.95 02/10/2020

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones CO17783 38746 25.00 03/10/2020}

v

Dedupe d} = Eg
® Remove duplicate rows by matching values in al...
Explore Duplicates...

El Q Filter columns
Name =
Customer Id
v .
Product Id
. -
1 of 5 columns selected
Matching: Exact v
Vv case sensitive
Mode: Remove duplicates v
Name Customer Id Product Id Cost Date

1 Alice Anderson C018930 13574 29.95 01/10/2020
Y T L T ~rA o094 AOACE 4R CC A4 0 090
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Inputs
One.

Options
¢ Click Explore Duplicates... to explore which rows are duplicates.
e Check the column(s) you wish to look for duplicate values in.
¢ Set Matching to Exact to use exact matching to find duplicates and Fuzzy to match with
some differences. Fuzzy matching is much slower.
¢ Set Closeness to how close a fuzzy match has to be to be considered a match. E.g. set it to
80% to make 2 values that are 80% the same a match. For Fuzzy matching only.
e Check case sensitive to use case sensitive matching.
e Check ignore whitespace to ignore whitespace characters when matching.
e Check ignore punctuation to ignore punctuation characters when matching.
e Set Mode according to what you want to do with duplicates.
o Remove duplicates removes all duplicate rows.
o Keep only duplicates keeps only the duplicate rows (the inverse of Remove
duplicates).
o Add duplicate information adds extra columns with information about duplicate rows at
the end. Reorders rows, but does not remove them. The additional columns are:
» Group: Each row and its duplicates are given a unique group number, starting at 1.
» Row: The number of the row in the input dataset.
» Closeness: How close a match the duplicate is as a percentage. 100% = exact match.
* Duplicate: Set to true if the row is a duplicate and false if not.
» Duplicates: Set to the number of duplicates a non-duplicate has.
e Check drilldown to allow double-clicking a row in the data table to drilldown to this row
and it's duplicates in the upstream data. This is only available when Matching is set to
Exact and Mode is set to Remove duplicates.

Notes

e Rows are considered duplicates if they match in all the checked columns.

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before deduping and Replace to get of other unwanted characters (e.g. whitespace inside
the text).

e When several rows are duplicates, only the top one is retained. So you may want to Sort
your dataset first.

e The Unique transform is a more powerful (but more complex and slower) alternative to
Dedupe.

See also
e Dedupe a dataset
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2.3.16 Extract

Description
Extract text in one or more columns.

Examples
Extract the first 2 digits from the 'Product Id' column:

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Product Id
1 C13574

2 AB9456

13/A96352

V

Extract d} EC :
@ Extract text in the selected column(s).

E| Q Filter columns

Product Id

4

1 of 1 columns selected

Using: Text v
Length: 2 :
From: Start =
Offset: 0 =
Product Id

1C1

2 A8

3 A9
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Extract the last group of digits from an IP address:

IP
1 82.69.52.10

2 66.249.66.92

3 86.28.107.100

.

Extract Oﬂ @ E;
@ Extract text in the selected column(s).
|E’ Q Filter columns |

JIF’

1 of 1 columns selected
Using: Regex v
Matching: \d*&.&d*\.\d*‘\.[\d*ﬂ

v case sensitive

¥

1P
1 10
2 92
3 100

Extract titles from a name:
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Name

1 Mr John Black
2 Mr. Ben Brown
3 Ms Jill Green

4 Mrs. Jenny White

5 Bill Grey

V

Extract Ij: D :

® Extract text in the selected column(s).
El Q Filter columns

v Name

T T W W

ST EEEW TTT YT

1 of 1 columns selected
Using: Regex v
Matching: ~(Mr|Mrs|Ms|Miss)\.?\s

case sensitive

\

o ——

Name
1 Mr
2 Mr
3 Ms
4 Mrs
:



Reference

Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Using depending on whether you want to extract a fixed length of text or with a regular
expression.

¢ Set Length to the length you want values in selected columns shortened to. Text match
only.

¢ Set From to Start or End depending on whether you want to take from the start or end.
Text match only.

¢ If From is Start then Offset is the offset of the first character from the start (0 to start with
the first character). If From is End then Offset is the offset of the last character from the
end (0 to start with the last character). Text match only.

¢ Set Matching to a regular expression. Regex match only. If the expression contains capture
parentheses the first capture will be extracted. Otherwise it will try to capture the whole
regular expression. For example:

Value Regular expression Extracted
12.34.567.89 (\d*) \.\d*\.\d*\.\d* 12
12.34.567.89 Nd*N AR\ AAFN L (\d*) 89
12.34.567.89 \d*\.\d* 12.34

ip 12.34.567.89 AYe AW Ve LANAYe LA W Ve by 12.34.567.89
ip 12.34.567.89 AMd*F\ L AdF N \dFN L \dFS

¢ Check case sensitive to use case sensitive matching. Regex match only.

Notes

e If you can to keep the original column use Copy Cols to copy the column first.

e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before extracting.

e If you want to set a column to a fixed length use Pad and Extract together.

e Use Replace If you want to extract multiple captures from a value using a regular
expression.

See also
e Chop
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2.3.17 Fill

Description
Fill empty cells in selected columns with the adjacent non-empty values.

Example
Fill down:
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Country Area City
1 Country 1 Area 1 ‘City 1
2 City 2
3 City 3
4 Area Z‘Citjﬂ
5 City 2
Fill { B o<

@ Fill empty cells in selected columns from adjace...
E] Q Filter columns

v Cnum?r}i

Area

g I}
v Y

3 of 3 columns selected

Direction: Down .

'

Country Area City

1 Country 1/Area 1 City 1

2 Country 1 E City 2

3 Country 1/Area 1 City 3

4 Country 1 /Area 2 City 1

5 Country 1 /Area 2 City 2
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Inputs
One.

Options
e Check the column(s) you wish to fill.
¢ Select Direction depending on the direction you wish to fill to.

Notes
e Cells containing whitespace are not considered empty.
e To fill empty values with something else use the Replace transform.

See also

e Unfill

e Slide

e Whitespace

e Impute
2.3.18 Filter

Description
Removes rows based on number, date and text values in selected columns.

Examples
Keep rows with at least 1 non-empty value.

Filter % Q{} E S

@ Filter rows by text, date or numeric values in selected columns.

@ ® E%ﬂ @I'%_L X Keep ¥ Matching any

Column Op. Value
1 <Any> ik ¥

Keep only rows where the 'Tax' value is greater than 0 and the 'Country’ value is 'US'.
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2 KA
Filter d: g
@ Filter rows by text, date or numeric values in sel...

® ® [ & X Keep ¥ Matchingall

Column Op. Value
1 Tax ¥i|> *|0
2 Country ¥|= ¥ |US

Remove rows where the 'Transaction' value is greater than the 'Threshold' value (using a
column variable).

i R A
Filter = Q{} N

@ Filter rows by text, date or numeric values in selected col...

@ ® E% é::j X Keep ¥ Matching any

Column Op. Value
1 Transaction ¥ > ¥ §(Threshold)

Inputs
One.

Options

e Click the ® button to add a new filter criteria.

o Click the ® button to delete the selected filter criteria.

e Click the [ button to copy terms to the clipboard.

e Click the & button to paste terms from the clipboard.

e Click the X button to clear all terms.

e Select Keep if you want to keep matching rows and Remove to remove matching rows.

Select Matching all to match on all criteria (e.g. criteria 1 and criteria 2). Select Matching

any to require a match on one or more criteria (e.g. criteria 1 or criteria 2).

Set Column to the column you wish to match.

Set Op. to the comparison operator.

Set Value to the value you wish to compare. You can use a column variable.

e Check case sensitive to use case sensitive matching for text.

e Check disable filtering to turn off filtering. If sampling is disabled, the transform does
nothing.
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Notes
e A text summary of the filters is shown:

@ ® I?El} é‘% X Keep ¥ Matchingall ~

Column Op. Value
1 Country ¥ l= ¥ |UK
2 Units Sold ¥ |[>=7¥|5
3 Unit Cost ¥ |>= ¥ |10

Keep (Country = 'UK') AND (Units Sold >="5") AND (Unit Cost >="10')

e Afilter row is ignored if the Value column is empty , except when Op. is Equal to, Not
equal to, Matches regex or Doesn't match regex.

e Number, date and text values are treated differently for Equal to, Greater than, Less than,
Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than O, because they will be compared as
text. So you might want to replace empty values with O or remove those rows with Filter,
before comparing them.

¢ All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

¢ Y can use Subtract to see rows removed by filtering if there is unique key column.
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Subtract

14 cols x 585 rows

]

orders.csv rows removed
by filtering

L/

9

14 cols x 830 rows

o Filter

14 awols x 245 rows

e If you are pasting in filter terms, the format expected is comma delimited text with 3
columns.
o The first column is the 0-based index of the Column drop-down list.
o The second column is the 0-based index of the Op. drop-down list.
o The third column is the Value.
For example, pasting in:

0,0,YES

Will add:

Column Op. Value
1 <Any> ¥ Ic ¥ |YES |

You can also try copying terms to the clipboard and pasting into a text file to see the format.
If you only paste in 1 column of text, it will be assumed to be a list of Value. You can, of
course, use Easy Data Transform to create the appropriate filter terms and paste them into
memory.

See also
e Compare Cols
e Slice
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2.3.19 Gather

Description
Gather multiple columns into new key and value columns. Also called unpivot, long pivot or
group by.

Example
Gather 'Q1', 'Q2', 'Q3' and 'Q4' columns into 1 column.
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2 Bob East 45 79 8 33

v

Gather QQ &= Eﬂ

@ Gather selected columns into key and value col...
E] Q Filter columns
salesman

darea

v
v

.

g

4 of 6 columns selected

Key column name: Quarter

Value column name: Amount

v

salesman area Quarter Amount

1 Alice North/Q1 1.3
2 Alice NUH.‘I‘E
3 Alice North' Q3 443



Reference

Inputs
One.

Options

e Select the Columns you wish to gather.

¢ Set Key column name to the name of the new key column, which will have values based on
the names of the columns selected.

¢ Set Value column name to the name of the new value column, which will have values
based on the values in the columns selected.

Notes

e New columns are added at the right end. You can change the column order with Reorder
Cols.

e You can merge the value and key columns into a single column with Concat Cols.

e The opposite of Gather is Spread.

See also
e Video: How to unpivot Excel

e Split Rows
2.3.20 Hash

Description
Perform one-way hashing on selected columns.

Example
Compute the MD5 hash of <"Hello World!'>:
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1
1 <'Hello World!"'>

'

Hash o E i!'
@ Perform a one-way hashing.

E| Q Filter columns

vr‘l

1 of 1 columns selected

Algorithm: MD5 v
1

1 f0d946347af462d489af835d3737fe70
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Type

SHA1

SHA-256

SHA-512

SHA3-256

SHA3-512

Keccak-256

Keccak-512

MD5

Plaintext

<'Hello
World!'>

<'Hello
World! '>

<'Hello
World!'>

<'Hello
World! '>

<'Hello
World!'>

<'Hello
World! '>

<'Hello
World!'>

<'Hello
World! '>

Secret

Hashed

4a700d8555aae49
7cc54d32f6£3d74
78200abdea

2c6139a5d874b96
26e3ae2443fa85c
dfelfcl18£148034
8267f8bf71a783f
738a

23728b865af0f17
bb9bfaaf064£f711
bf00626c07e5389
dcbbl18365aceldc
2394d7a00066c0b
6a7112dab528e62
106a855ddobc4ld
0c262fb72e9f47e
10f1652c¢c

0701263723cdbdf
11el1£7118e62d7d
29d61£01£8490ef
775e4991558634b
d719

6lcbfoflle864af
592626d9430271a
5ad6f39edf7e097
19a97¢57b5¢3222
cdf24bd70£1£692
7Tb7b41eb948bbdd
felad4ae965688a4
a6882df7be36492
ade653ab0

1a45dd8df9de650
49692d9192509b3
0560b69c1£fd881c
5702cf4607e85b3
569f

2741b7ddfe0d4c4
726d476cc719fdb
b3b7db88feb6dfla
1df00723547c546
496ac490bd82e940
09f4572d3a31fe0
fc50bcelee3c7/6d
983f8ddc480b7da
9cdled02

£0d946347af462d
489a£835d3737fe

70



Reference

Inputs
One.

Options

e Check the column(s) you wish to transform.

e Set Algorithm to the hashing algorithm you wish to use

e Set Secret to the secret key you wish to use (HMAC-MD5 only). The default value is
randomly generated.

Notes

e There is no known way to reverse these hashes.

e As the chance of 2 different inputs generating the same hash value by chance (a 'collision’)
is infinitesimally small, hashing can be used to anonymize data or to help find duplicates of
long data values.

e The MD?5 algorithm is now considered weak as a cryptographic hash. But remains suitable
for other non-cryptographic purposes.

e Use Copy Cols to copy columns before you transform them.

2.3.21 Header

Description
Move rows from the top of the dataset into the header.

Example
Append the first row to the header:
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Sample Sample Sample

1 1 2 3
2 22334 2389 1935

3 82.2 5059 93451

Header d} Eg
@ Move rows to the header.
Top rows to move: 1 :
Existing header:  Append v

Delimiter: -

Sample-1 Sample-2 Sample-3
1 22334 23.89 19.35

2 82.2 5059 93451

Inputs
One.

Options

e Set Top rows to move to the number of rows you want to move from the top dataset into
the header. Setting it to 0 means the transform does nothing.

¢ Set Existing header to Overwrite to ignore the existing header values and Append to add
to the existing header values.

¢ Set Delimiter to any text you want to put between column elements. It can be left empty.
Ignored if Existing header set to Overwrite and Top rows to move set to 1.
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Notes

e Empty cells are ignored.

e You can Sort and Filter your dataset to change the top rows.

e You can add the header from one dataset to another dataset using Stack.

See also
e Headers
2.3.22 |f

Description
Sets the value of a new column based conditionally on values in one or more other columns.

Examples
Add a new column based conditionally on 'Payment’ and 'Currency' columns:
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Payment Currency

1 4626.97 USD
2 647.54 USD

3 6353.12 GBP

Y

If ol =z(hie

@ Create a new column with values conditional on value...

MNew column name: Convert

@EesElF Panp N L ®

Logic Column Op. Value
1/IF Currency ¥ |= ¥ |USD
2 THEN= No
3 ELSE IF  Currency Y = Y GBP
4 AND Payment ¥ >= ¥ 1000
5 THEN= Yes
6 ELSE= No

v case sensitive

\

Payment Currency Convert

1 4626.97 USD No
2 64754 UsD No

3 6353.12 GBP Yes

If the 'h1' value is 1 use the value of the 'h2' column, otherwise use the value of 'h3' column
(using column variables).:
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h1 h2 h3
1A A 1
2B B 2
3c C 3
4d D 4
If * FEC]|

@ Create a new column with values conditional on oth...

New column name: If

@ESEIF (PDanp T L X

Logic Column Op. Value
1I1F h1 Y = ¥ |3h2
2 THEN= $(h2)
3 ELSE= $(h3)

v case sensitive

v

h1 ha h3 |If
1A A 1A
2B B 2B
3/C C 3 3
4d D 4 4
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Inputs
One.

Options

¢ Set New column name to the name of the new column you want to create.
e Click the ®ELSE IF button to add a new IF/ELSE IF. THEN condition.

e Click the ®AND'button to add an AND to the selected IF/ELSE IF.THEN.

o Click the ® button to delete the selected IF/ELSE IF.. THEN/AND.

e The Logic column shows the type of row.

¢ Set Column to the column you wish to match.

e Set Op. to the comparison operator.

¢ Set Value to the value you wish to compare.

e Check case sensitive to use case sensitive matching for text.

Notes
e The IF, THEN and ELSE values can use column variables, as in the second example above.
e You can simulate OR with multiple IF statements. For example:

IF x=10R vy =2
THEN 3

Is equivalent to:

IF x =1
THEN 3
ELSE IF y = 2
THEN 3

e Number, date and text values are treated differently for Equal to, Greater than, Less than,

Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than O, because they will be compared as
text. So you might want to replace empty values with 0 or remove those rows with Filter,
before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,

Doesn't start with, Doesn't end with and Doesn't match regex operations.
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e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

See also
e Looku

2.3.23 Impute

Description
Infer values of missing data from other values in the same column.

Examples
Impute the missing age of Titanic passengers based on the average age of all passengers:
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Pclass Sex Age SibSp Parch |+ E

21 2male 35 0 0 i
22 2 male 34 0 0 i
)

23 3 female 15 0 0 ]
24 1l male 28 0 0 '
25 3 female 8 3 1 i
26 3 female 38 1 5 :
27 3 male 0 0 E
28 l male 19 3 2 i
29 3 female 0 0 It
30 3male 0 0 i
=il 1l male 40 0 0 E

impute FELS

@ Infer values of missing data.

o — 11
E] Q Filter columns

Pclass
Sex
Age
v g
-
1 of 9 columns selected
Using: Average v

Easy Data Tran$ Of }:'l." rows x Digital Ltd
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Impute the missing age of Titanic passengers based on the median age of passengers with
the same passenger class and sex:
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Pclass Sex Age SibSp |Parch (4 E
21 2Zmale 35 0 0 i
22 2 male 34 0 0 i
)
23 3 female 15 0 0 E
24 1 male 28 0 0 '
25 3 female 8 3 1 i
26 3 female 38 1 5 ;
27 3male 0 0 E
28 1 male 19 3 2 i
29 3 female 0 0 t
30 3male 0 0 i
=hb l male 40 0 0 E
Impute C‘P Eg

@ Infer values of missing data.

o =
El Q Filter columns

Pclass -
Sex
Age

v g

1 of 9 columns selected

Using: Median v




Reference

Inputs
One.

Options

e Check the column(s) which have empty values you wish to impute.

e Set Using to impute using the Average (mean), Median or Mode of non-empty data
values in each column.

e Set Of to:

o All rows to fill empty values in each column with the Average, Median or Mode of all
non-empty values in the same column.

o All rows with matching values for to fill empty values in each column with the Average,
Median or Mode of all non-empty values in the same column where values match in the
checked columns below.

e Set Matching to Exact match if every field has to match and Best match to use rows that
have the most matching values (or all rows, if no matches). For example, if you are
matching on passenger class and sex then:

o Exact match will only use values from rows where the passenger class and sex both
match.

o Best match will use values from rows where the passenger class and sex both match, if
available. Otherwise it will use values from rows where either the passenger class or sex
match, if available. Otherwise it will use values from all rows.

e Check case sensitive to use case sensitive matching.

Notes

¢ Average and Median only work on numerical data (non-numerical values are ignored).

e Mode treats all non-empty data values as text. Case and whitespace are taken into account.

e If Mode is selected and there are multiple values with the same maximum frequency, one
will be picked at random.

e If you need to convert some values to empty before imputing, you can do this using a
Replace transform.
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Replace Qﬂ E ;

@ Replace multiple text in the selected column(s).
|E| Q Filter columns

v ge.ncler-
group
salary

1 of 3 columns selected

@ 1TV I®E & X

Match Type Replace With
1 Text ¥ Unknown

e You can use a Filter transform to remove rows with missing values instead of imputing
values.

e Use a Sequence transform to add missing date or integer values in a sequence before
imputing.

See also

e Video: How to impute missing data
o Fill

e Interpolate
2.3.24 Insert

Description
Append/prepend text to one or more columns.

Example
Add 'ID-' to the front of a column of text:
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ID
1230933

2 223441

3 323412

Y

Insert CF E Q
@ Append/prepend text in the selected column(s).
|E| Q Filter columns

\;ID B | |

1 of 1 columns selected

Insert: ID-
At: Start v |:
ID
11D-230933
2 ID-223441
31D-323412
Inputs
One.
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Options

e Check the column(s) you wish to transform.

¢ In Insert put the text you want to insert. You can use a column variable.
e In At put the position you want the text inserted.

Notes
¢ You can use Whitespace to remove whitespace before inserting.

See also
e Pad
e Extract

2.3.25 Interpolate

Description
Interpolate values for a dataset based on numerical sample-value pairs in another dataset and
puts the result in a new column.

Example
Interpolate time and temperature datasets for sensors A and B with different sampling
frequencies:

RA
time A temperature A Interpolate o N
1 0.0 1134 @ Create a new column in the top dataset by inter...
Top sample column: time A >
Bottom sample column: time B v
3 20 2773 Bottom value column:  temperature B v
sensor-A.csv
4 Interpolation type: Linear v
2 cols X 6 rows
5 40 3333 /
time A temperature A Interpolate temperature B !
6. 50 2874 Interpolate 17 00 1134 |
0 > * b
A 3 cols x 6 rows 1.0 778 !
time B temperature B 2 ° 3.
1 0.0 0.000 3 2.0 2773
sensor-B.csv
2 20 4 3.0 5.039
2 cols x 4 rows
3 40 2.697 5 40 2333
4 60 6 5.0 2.874
Inputs
Two.
Options
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Place the dataset you want to modify as the top input and the dataset you want to sample
values from as the bottom input.

Select Top sample column for the column whose values you wish to sample.

Select Bottom sample column for the column that matches the top sample column in the
bottom dataset.

Select Bottom value column for the column that contains the values.

Set Interpolation type to the type of interpolation you wish to use.

Piecewise interpolation (image from Wikipedia)
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Linear interpolation (image from Wikipedia)

Notes

e If your sample is below the first sample in the bottom dataset, the first value will be
returned.

e If your sample is above the last sample in the bottom dataset, the last value will be
returned.

e Easy Data Transform will try to guess sensible default values for Top sample column,
Bottom sample column and Bottom value column based on column contents.

e If the first input has a header, this will be used for the output.

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

e Use Num Format to change the precision of the results.

e Messages are shown in the Warnings tab for non-numeric values in either dataset.

e Messages are shown in the Info tab for Top sample column outside the range of values in
Bottom sample column .
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See also

e Lookup

e Impute
e Join

2.3.26 Intersect

Description
Keep only rows from the top dataset with key values that are present in the lower dataset.

Example
Keep rows in the top dataset that also have their ids in the bottom dataset:

Id  First Intersect togll =2 53
1 001 Alice @ Keep only rows from the top dataset whose key value... |
intersect-1.csv Top key column:  Id v

2 002 Bob * o
Bottom key column: 1D
3| 003 Charlie 2 cols x 4 rows /

v

4 004 Dwayne

Intersect a__ A
(/] v * 1. 001 Alice

2 cols x 2 rows

[a%]

ID
intersect-2.csv

zﬁ 1 col x 2 rows

Inputs

Two.

Options

e The output depends on the vertical (Y-axis) position of the inputs.

¢ Click Explore Keys... to compare key values in the 2 datasets.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select Bottom key column for the column you want to match in the bottom input dataset.
e Check case sensitive to use case sensitive matching for keys.
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Notes

o If there are 10k rows or less in both datasets, Easy Data Transform will try to guess sensible
default values for Top key column and Bottom key column based on column header
names and contents.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the intersect.

¢ Does not remove duplicates. You can use Unique to do this.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.

e You can use Row Num to create a unique key column.

See also
e Subtract

2.3.27 Javascript

Description
Create a custom transform using Javascript (ECMAScript).

Easy Data Transform allows you to carry out a wide range of data transformations without
programming. But sometimes you might need a specialist transformation that can't be done
with the built-in transforms. For that you can use the Javascript transform. It allows you to
write the body of a Javascript function, to calculate a value for each row in a new column.
Existing column values can be used as variables.

Javascript is a fully-fledged programming language and can perform arbitrarily complex
transforms. It can handle strings, numbers, dates and text.

Examples
Multiply the value in column ‘items' by the value in column 'item price":
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items item price

1 1 11.45
2 5 0.95

3 2 9.95

Javascript dﬁ = 3;
@ Script your own custom transform in Javascript.

New column name: cost

Type columns as:  Number/Boolean/String v

Javascript:

return $(items) * $(item price);

items item price cost
1 1 11.45 11.45
2 5 0.95 475
3 2 995 199

To concatenate 'last' and 'first' columns with a comma and a space:

return $(last) + ', ' + $(first);

To calculate the biggest of numeric columns 'v1' and 'v2":
return Math.max( $(vl), $(v2) );

To find the number of characters in column 'v1':
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return String( $(vl) ).length;

To determine whether phone numbers in the 'phone_num' column are valid using a regular
expression:

const validPhoneNum = /~[\+]1?2[(]12[0-91{3}[)12[-\s\.12[0-9]1{3}[-\s\.]?
[0-9]11{4,6}$/;
if ( validPhoneNum.test( $(phone num) ) )
return "valid";
else
return "invalid";

To replace the last comma in the 'Location’ column with a ;' using a regular expression:

return $(Location).replace(/ (.*), ([* 1*)S$/, '$1:$2'");

To calculate the number of years difference between Javascript compatible dates in column 1
and column 2:

return new Date( $(1) ).getFullYear() - new
Date( $(2) ).getFullYear();

To calculate the number of milliseconds between a datetime in the ‘datetime’ column and 1st
Jan 2000:

return new Date( $(date) ) - new Date( "2000-01-01T00:00" );

To calculate the number of whole days difference between a date in the 'created’ column and
today (negative for future dates):

return Math.floor( ( new Date() - new Date( $(created) ) ) /
( 1000*60*60*24 ) );

To use the value of the 'n' column if it is a number and O if it isn't;

if ( isNaN( $(n) ) )
return O;

else
return $(n);

To reverse the text in the 'key' column:

var a = $(key);

var newString = "";

for (var 1 = a.length - 1; i >= 0; i--) {
newString += al[i];

}

return newString;
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To convert meters to feet using a function:

function metersToFeet( x )

{
return 3.28084 * x;

}

return metersToFeet ( $ (meters) );

Inputs
One.

Options
¢ Set New column name to the name of the new column you want to create.
¢ Set Type column as to:
o Number/Boolean/String to pass:
= A column that is numeric values as Javascript Number type.
= A column that is true and false values as Javascript Boolean type.
= Anything else as Javascript String type.
o String to pass data all columns with Javascript String type.
e Enter your script into the Javascript field. The script should be the body of a Javascript
function.
e Select a column from Insert variable to add that column variable into the Javascript field
at the current cursor position.
e Click the Evaluate button to evaluate your Javascript expression over every row and show
any errors (only available if Run>Auto Run is checked).

Notes
e If Run>Auto Run is checked, the Javascript transform is calculated every time:
o The Evaluate button is pressed.
o The Javascript transform item is unselected in the Center pane and script changes have
been made without the Evaluate button being clicked.
o An item upstream of it changes.
e An empty string is passed as an empty Javascript string variable (*"), not null. To test if the
'v' column has an empty value:

if ( $(v).length === 0 )

{ // empty cell

élse if ( String( $(v) ).trim().length === )
{ // blank cell (whitespace only)

}
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e Numeric values should use dot ('.") as the decimal separator and have no group separator.
E.g. 1234.5 is valid, but 1,234.5 and 1.234,5 are not, regardless of the locale. You can use
the Num Format and Replace transforms to put numeric data in the correct format before
processing a Javascript transform.

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

e The Javascript Date() object evaluates to the number of milliseconds since 1 January 1970
UTC.

e Date values passed to Javascript Date() objects should be in ISO ('yyyy-mm-dd') format,
e.g. '2020-01-31' (not '2020-1-31").

e If you want to carry out your transform across more than one dataset, you should merge
them first, e.g. using Join.

e The Javascript transform is very versatile and quite fast. But is not as fast as built-in
transforms. So we recommend you use built-in transforms where possible.

e Javascript running in Easy Data Transform is not 'sandboxed' and has the same privileges as
the Easy Data Transform executable. However the Javascript does not have access to
window(), XMLHttpRequest() or ActiveXObject(). So we aren't aware of any way that a bad
actor could damage your system from Javascript sent in a .transform file.

e Javascript is far too big a topic to cover here. However there are many detailed resources
online. If you are stuck contact support.

e If you only want to combine text from columns, use the simpler Substitute transform.

e Warnings are shown in the Warnings tab for:

o Javascript syntax errors
o Ambiguous column references
e For simple arithmetic operations on numbers and dates use the Calculate transform.

See also
¢ Find the difference between dates/datetimes

2.3.28 Join

Description

Merge two inputs based on common (key) columns, e.g. on an email address or id column
present in both inputs. The bottom dataset (by vertical position) is joined to the right of the
top dataset.

Example
Join two datasets side-by-side using the 'ID' columns:

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Name

1D

DOB

1/John Black 001 1966-07-01

2 Paul White 002 1973-03-11 *9 employees.csv

2 004

|
3 Jill Green 003 1977-12-30 3 cols x 4 rows
4 Ahmed Ali 004 1980-11-05
ID  Department Level

1 001 Engineering 1

Marketing l . odetails.csv

3 003

3 cols x 4 rows

Engineering 2

4 002

Inputs

Two.

Options

Sales

2

g
/

Join d} EC
@ Merge 2 input datasets side by side using com...
Top key column: ID v

include top non-matching row
Bottom key column: ID v

include bottom non-matching

/

Join

5 cols x 4 rows

D DOB

Name Department Level
1/John Black 001 1966-07-01 Engineering 1
2/Paul White 002 1973-03-11 Sales 2

3 Jill Green 003 1977-12-30 Engineering 2

4/Ahmed Ali 004 1980-11-05 Marketing 1

¢ The output depends on the vertical (Y-axis) position of the inputs.

e Click Explore Keys... to compare key values in the 2 datasets.

e Select Top key column for the column you want to match in the top input dataset.

¢ Select include top non-matching rows if you want to include in the output any rows in the
top input with no matching value in the bottom input.

¢ Select Bottom key column for the column you want to match in the bottom input dataset.

e Select include bottom non-matching rows if you want to include in the output any rows
in the bottom input with no matching value in the top input.

e Check detailed report to show detailed information in the Warnings and Info tabs on
duplicate keys in each dataset, overlap of keys in the 2 datasets and leading and trailing
whitespace in keys. This slows down the join significantly.

e Check case sensitive to use case sensitive matching for keys.
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Reference

include top non-matching include bottom non- Also known as:

rows checked matching rows checked

No No Inner join

No Yes Right outer join

Yes No Left outer join

Yes Yes Full outer join
Notes

¢ Join merges two datasets side-by-side (horizontally). To merge datasets one on top of the
other (vertically) use Stack.

e |f there are 10k rows or less in both datasets, Easy Data Transform will try to guess sensible
default values for Top key column and Bottom key column based on column header
names and contents.

o All values are treated as text. You can use Whitespace to remove whitespace before the
join.

e If a key value occurs M times in the first dataset and N times in the second dataset, you will
get M x N rows with this key value. You can use Unique to remove rows with duplicate key
values.

e If you need more than one column for the key, use Concat Cols to create that column.

e Use Row Num to create a unique key column.

e Use Sort to sort the results.

e Use the Cross transform for cross joins.

e Messages are shown in the Warnings tab for keys that occur more than once in either
dataset (duplicates).

e Messages are shown in the Info tab for keys that only occur in 1 of the 2 datasets (misses).

e Use Subtract to see rows not joined from the top or bottom dataset (an 'anti-join’). The
Clone is necessary to get the correct Y position of the bottom dataset for the Subtract.
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Clone
9
14 cols x 750 rows
Filter » . Subtract
-6 »9
11 cols x 87 rows 11 cols x & rows
Join
/]
24 cols x 720 rows
Filter Subtract
-8 L/
14 cols x 750 rows 14 cols x 30 rows

e Cascade multiple joins to join more than 2 datasets.

CLUS [OIM & S.C5v

L]

11 eods x 91 Ews

Join

]

14 @l xE30 mws 28 colsx 22k rows

;Mlals = 830 row 5
orders.csv Join
/0

order details... Join

(]

Scals x 22k rows Feslsx22krows

° products.csv

W= 77 mws

suppliers.csv
9

12 colsx 23 rows

See also
e Video: How to join Excel files
e Cross

e Lookup
e Interpolate
e Merge datasets

Easy Data Transform

'\
"

Rows not joined
from top dataset

Rows not joined
from bottom dataset

Join

48 eolsx 22k mws

51 cols x 2.2k rows

o
/"

cabegans C5V

4 eslsx 8 rows
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Reference

2.3.29 Lookup

Description

Looks up the values of a column in the top input dataset in the bottom input dataset and puts
the result in a new column.

Examples
Lookup category name in a second dataset using '‘Category ID":

Lookup & (f" =] ::
@ Create a new column in the top dataset using values looke...
Explore Keys...
Top key column: Category ID n
Bottom key column:  Category ID v
Bottom value column: Product Name ¥
Matching: Exact v
Product ID Product Name Supplier ID Category ID Bottom values used: - (fit v
3 1 Chai 1 1 If no match: Use no match value A
No match value:
2 2 Chang 1 1 I © products.csv v case sensitive
3 3 Aniseed Syrup 1 2 OGS G
4 4 Cajun Seasoning 2 2
5 5 Gumbo mix 2 2

, Lookup
5 cols x 5 rows

Category ID Category Name Descript

1 1|Beverages soft drinks categories.csv Product ID Product Name Supplier- ID Category ID Lookup Category Name
2 2 Condiments sauces, relishes and seasonings* e eI 1‘ 1 Chai 1 1 Beverages
3 3| Confections dessers and candies 2‘ 2 Chang 1 1 Beverages

3‘ 3 Aniseed Syrup 1 2 Condiments

4‘ 4 Cajun Seasoning 2 2 Condiments

5‘ 5 Gumbo mix 2 2 Condiments

Fuzzy lookup of company stock '‘Symbol' by ‘Name":
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Reference

Name Symbol H
LW N N N N N N N Ny Sy NN

o - T A ‘
3 |Amazon.com AMZN ‘
4 Bank of America BAC |

‘I_I_III,I_I_III,IIIH

1/Amazon
11 Home Depot (The) HD

2 Bank of America WSS YW WA W SNy

3 Home Depot

4 McD 1d 1B a8, L& Ce A LD 0L 0. atbt 4 M |
cDonalds ‘

17 McDonald's MCD
S5NVIDAT

oo B g B S S oS S
6 Pepsi

L (P 2 S Jda M. L

21|/ NVIDIA NVDA !

S Y N S Y N S A N N N Ny N

24 PepsiCo PEP i
Lookup % i

® Create a new column in the top dataset using v...

Explore Keys...

Top key column: Company v
Bottom key column: Name v
Bottom value column: Symbol v
Matching: Fuzzy v
Closeness: 60% :
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Inputs

Two.

Options

e Place the dataset you want to modify as the top input and the dataset you want to lookup
values from as the bottom input.

e Click Explore Keys... to compare key values in the 2 datasets.

e Select Top key column for the column whose values you wish to lookup.

e Select Bottom key column for the column that matches the lookup in the bottom dataset.

¢ Select Bottom value column for the column that contains the values.

¢ Set Matching to Exact to use exact matching to find duplicates and Fuzzy to match with
some differences. Fuzzy matching is much slower.

¢ Set Closeness to how close a fuzzy match has to be to be considered a match. E.g. set it to
80% to make 2 values that are 80% the same a match. For Fuzzy matching only.

e Set Bottom values used to:
o All if you want to use all matches. Duplicate values are only shown once.
o First if you want use the first match in Bottom lookup column. For Exact matching only.
o All best if you want to use the best matches. If there are multiple values that are equally

good, use all of them. Duplicate values are only shown once. For Fuzzy matching only.
o First best if you want to use the best match. If there are multiple values that are equally
good, use the first one. For Fuzzy matching only.

¢ Set Delimiter to the delimiter you want to use to separate multiple values returned for
Bottom values used of All or All best.

¢ Set If no match to Use not match value or Leave unchanged, depending on what you
want to do for values in Top lookup column that do not match in Bottom lookup column.

¢ Set No match value to the value you want to use for values in Top lookup column that do
not match in Bottom lookup column when If no match is set to Use no match value.

e Check case sensitive to use case sensitive matching for keys.

Notes

e Easy Data Transform will try to guess sensible default values for Top lookup column,
Bottom lookup column and Bottom value column.

e Bottom values used is only important if there are duplicate values in the Bottom lookup
column.

e If the top input has a header, this will be used for the output.

e If you want to see what bottom dataset keys are matched to each top dataset key, you can
set Bottom value column to the same column as Bottom key column.

e All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the lookup.

e If you want to lookup values in multiple columns, use Concat Cols to join several columns
together to form new columns.
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e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.
e Warnings are shown in the Warnings tab for:
o Values that cannot be found in the bottom dataset (misses).
o Values that occur more than once in the bottom dataset (duplicates), if Bottom values
used is First.

See also
o If

e Interpolate
e Join

2.3.30 Moving

Description
Add a new column with a moving average/median/sum/min/max of the selected column.

Examples
Calculate a 7 day moving average for the sales column, leaving the first 6 days empty.
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Easy Data Transform

Date Sales

2020-07-01 100
2020-07-02 120
2020-07-03 90
2020-07-04 145
2020-07-05 95
2020-07-06 15
2020-07-07 125
2020-07-08 130
2020-07-09 95

Moving

Column:

Calculation:

Interval:

Offset:

Date

2020-07-01

2020-07-02

2020-07-03

® Add a new column with a moving average/sum/...

Incomplete values: Set empty

% B e

Sales &
Average =
7 v
0 v

4

Sales Moving Average Sales
)
100

120]

9G_|
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Calculate the sum of the current row and the rows above and below, where available, for the
sales column.
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Date Sales
12020-07-01 100
22020-07-02 120
32020-07-03 90
4 2020-07-04 145
52020-07-05 95

Moving ‘s d} EZ
@ Add a new column with a moving average/sumy/...
Column: Sales v
Calculation: Sum v |
Interval: 3 -
Offset: 1 :
Incomplete values: Calculate from available v
Date Sales Moving Sum Sales

12020-07-01 100 220

22020-07-02 lED! 310
i T

32020-07-03 90 355
h.#_r

42020-07-04 1145

52020-07-05 95 240
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Inputs
One.

Options

e Select the Column you wish to calculate a moving
average/median/sum/minimum/maximum for.

e Set Calculation to the statistic to be calculated.
o Average shows the arithmetic mean of the values in the interval (Simple Moving

Average).

o Median shows the median of the values in the interval.
o Sum show the sum of the values in the interval.
o Minimum shows the smallest value in the interval.
o Maximum shows the largest value in the interval.

e Set Interval to the number of rows to include in each moving
average/median/sum/minimum/maximum value.

o Set Offset to the number of rows above (if negative) or below (if positive) the current row
to end each interval at.

¢ Set Incomplete values according to what you want to show for rows without a full interval
of data. For example the first 6 rows when Interval is 7 and Offset is 0.

Notes

e Non-numeric values are ignored. E.g. a 7 day moving average that includes 2 non-numeric
values will be shown as an average of the 5 numeric values.

¢ You will be warned of any non-numerical values in the selected column.

See also

¢ Video: How to calculate moving averages
o Offset

e Stats

2.3.31 New Col

Description
Adds a new column, filled with a given value.

Example
Add a new column full of '1' values:
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Reference

price

1 11.45
2 095

3 995

New Col 0” EC
@ Add a new column filled with a specified value.

New column name: quantity

New column value: 1

price quantity
1 11.45 1
2 095 1
3 995 1

Inputs

One.

Options

¢ Set New column name to the name of the new column you want to create.
¢ Set New column value to the value for every cell of the new column. You can leave it
empty for an empty column.

Notes
e New columns are always added at the right end. You can change the column order with
Reorder Cols and the column name with Rename Cols.
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See also
e Copy Cols
e Remove Cols

2.3.32 New Rows

Description
Add new rows.

Examples
Add an empty row above every row with an invoice number:
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Reference

Invoice Lineltem Value

1 00456 1 150.00

2 2 95.00

3 3 50.0

4 00457 1 845.00

5 2 12.50

New Rows d] E Ei

@ Add new rows.
Number added: Same for every row v
Number value: 1 :
As: Blank row(s) v
Location: Above each row v
For: Rows where v
Column: Invoice "
Matches: I= Not equal to =

Value:

v case sensitive

.

Invoice Line ltem Value

2 00456 1 150.00

3 2 9500




Reference

Copy each row the number of times in the ‘'ltems' column:

Orderld Items

1 12345 0

2 12346 1

3 12347 2

New Rows Cf} @ Eg

@ Add new rows.
Number added: Set from a column v
Number column: Items v
As: Copied row(s) v
For: Every row =

v

Orderld Items
1 12345 0

2 12346 1

3 12346 1
4 12347 2
4 12347 2

6| 12347 2
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Inputs
One.

Options
e Set Number added according how many rows to add for each existing row.
o Set Number value to the number of new rows to create for each existing row (available
when Number added is Same for every row).
o Set Number column to get the number of new rows to create for each existing row from
a column (available when Number added is Set from a column).
e Set As to add either blank rows, copies of existing rows or user defined rows.
¢ Set With value to set the value used for each column of the new row (available when As is
User defined row(s)).
¢ Set Location depending on whether you want new rows added above or below existing
rows (available when As is Blank row(s) or User defined row(s)).
¢ Set For depending on whether you wish to add rows to all rows or only rows that meet
certain conditions.

Notes

e You can use Calculate or Javascript transforms to calculate the number for the Number
column. E.g. to subtract 1 from the final number of copies wanted to give the number of
New rows.

See also
e Offset

e Sequence
2.3.33 Ngram

Description
Counts the number of times each sequence of consecutive words appear in the selected
column.

Examples
Find ngrams of 2 to 3 word length (bigrams and trigrams) in the 'Keywords' column:
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Keywords Impressions

1 EDT 47

2 easy data transform 1598

3 Easy Data Transform 964

4 easy data transformer 345

5 data transformer 19343

6 EASY,DATA, TRANSFORM 23
Ngram CP = Eii
@ Count sequences of N consecutive words in the sel... i
Column: Keywords ¥
Minimum N: 2 : ]
Maximum N: 3 - :

Sum: Rows \

case sensitive

‘

Keywords Ngrams Words Rows
1 easy data transform 3 3
2 easy data transformer 3 1
3 easy data 2 4
4 data transform 2 3
5 data transformer 2 2
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Sum the impressions associated with each 2 to 3 word ngram:
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Keywords Impressions
1 EDT 47
2 easy data transform 1598
3 Easy Data Transform 964
4 easy data transformer 345
5 data transformer 19343
6 EASY,DATA, TRANSFORM 23
Ngram * tfi @ EG'
@ Count sequences of N consecutive words in the sel... .
Column: Keywords v i
Minimum N: 2 -
Maximum N: 3 - |
Sum: Impressions v
case sensitive iE
Keywords Ngrams Words Impressions
1 easy data transform 3 2585
2 easy data transformer 3 345
3 data transformer 2 19688
4 easy data 2 2930
5 data transform 2 2585
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Inputs
One.

Options

¢ Select the Column you wish to analyze for ngrams.

e Set Minimum N to the minimum number of words in an ngram.

e Set Maximum N to the maximum number of words in an ngram.

e Set Sum to:
o Rows to count the number of rows containing the ngram.
o A column to sum numeric values in that column for all rows containing the ngram.

e Uncheck case sensitive to convert everything to lower case before counting ngrams.

e Check drilldown to allow double-clicking a row in the data table to drilldown to the rows
that contributed to this row in the upstream data.

Notes

e Words are made up of letters, digits and apostrophes ('). All other characters are treated as
word separators.

o All letters are converted to lower case.

e If you have set Sum to a column then only numeric values in that column will be summed.

e The output sorted by number of words in the ngram, then the count and then the ngram.
Use a Sort transform to sort it in a different order.

e Use a Replace transform before the Ngram transform to remove/replace any words or
letters you don't wish to analyze.

See also
e Video: How to find NGrams in data for PPC, SEO and NPL
e Count

2.3.34 Num Base

Description
Change the number base of integer values, e.g. decimal to hexadecimal.

Examples
Convert from decimal (base 10) to hexadecimal (base 16):
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Reference

6

Value

01

10

20

9999595399

Y

il

Num Base

Value

v

Base from :

Base to :

Easy Data Transform 3

Non-integer:

10
16

Leave

Value

1 of 1 columns selected

'

@ Change the number base of integer values, e.g. ...

p— - .
E Q Filter columns

K A
“a QI} =2 ¥ N

4pr 4>

0

1

1 © 2023 Oryx Digital Ltd
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Convert from guessed base to decimal (base 10):

Value
1 0100
2 100
30x100
Num Base %S O{} 53

@ Change the number base of integer values, e.g. ...
E] Q Filter columns

Value

v

1 of 1 columns selected

Base from: Guess —
Base to : 10 :
Non-integer: Leave v

Value
1 64
2 100
3- 256
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Inputs
One.

Options
e Check the column(s) you wish to convert.
¢ Set Base from to the base of the current values. If you set it to Guess, it will guess the base
for each value using C conventions:
o Numbers starting with Ox (e.g. 0x123) are assumed hexadecimal (base 16).
o Numbers starting with 0 (e.g. 0123) are assumed octal (base 8).
o All other values (e.g. 123) are decimal (base 10).
¢ Set Base to to the base wanted.

Notes

e The values to be converted should be integers (whole values) without group separators
(e.g. no commas or decimal points).

o |f Base from and Base to are the same, no change is made.

¢ Negative numbers are represented using unsigned values (e.g. twos complement for
binary) if Base to is anything other than 10.

e Warnings are shown in the Warnings tab for non-integer values.

e Use Copy Cols to copy columns before conversion.

e Use Num Format to change the format of numbers (e.g. remove group separators).

e You can use Insert to add characters to the front of values, e.g. to add '0x' to hexadecimal
values.

See also
e Video: How to convert base
e Decode

2.3.35 Num Format

Description
Change the number format in one or more columns.

Examples
Set numeric values to 2 decimal places:
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Reference

Value

1 1.27239
2 23.52035

3 49.7877

v

Num Format o Qﬂ B Eg

@ Change the number format in the selected colu... |
E] Q Filter columns |

Value

v

1 of 1 columns selected

Decimal symbol from: Automatic v i
Format to: f A
Precision to: 2 -

use group separator

Non-numeric: Leave v

'

Value
11 1.27

2123.52

3 49.79
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Set numeric vales to the shortest accurate number:
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Reference

Value

1 1.2720000
2/23.0035000

3 4.0787770

* R A

Num Format 4= Qﬂ ¢ N

@ Change the number format in the selected colu...
El Q Filter columns

Value

v

1 of 1 columns selected
Decimal symbol from: Automatic v
Format to: s b

use group separator

Non-numeric: Leave v o

v

Value

1 1.272
2 23.0035

3 4078777
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Change European style numbers to US/UK style locale numbers
(Preferences>General>Locale set to United States):
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value

11234567, 8

21.224.567,8
31 234 567,8
41"234'567,8

5€1.234.567,8

‘ R A

Num Format “a Oﬂ ¢ N

@ Change the number format in the selected colu...
E Q Filter columns

value

v

1 of 1 columns selected
Decimal symbol from: Automatic v
Format to: s v

v use group separator

Non-numeric: Leave .t

v

value

1] 1,234,567.8
2 1,234,567.8

3 1,234,567.8




Reference

Inputs
One.

Options
e Check the column(s) you wish to transform.
e Set Decimal symbol from according to the decimal separator in the input dataset:
o Automatic: Make an intelligent guess for each column, based on the input data. This is
usually the best choice.
o US/UK. (dot): Use . (dot) as the decimal separator.
o European, (comma): Use , (comma) as the decimal separator.
o Locale in Preferences: Use the decimal separator from Locale in the Preferences
window.
¢ Set Format to to the new number format (see below).

Formatto Meaning

e Format as [-]9.9e[+]-]999.
E.g. 1234567.89 is shownas 1.235e+06.

E Format as [-]9.9E[+|-]999.
E.g. 1234567.89 is shown as 1.235E+06.

f Format as [-]9.9.
E.g. 1234567.89 is shown as 1234567.89.

g Use e or f format, whichever is the most concise.
G Use E or f format, whichever is the most concise.
S The shortest accurate representation for the given

number without exponents.
E.g. 1234567.00 is shown as 1234567.

e Set Precision to to the precision desired.
o For the e, E, and f formats, Precision to represents the number of digits after the decimal
point.
o For the g and G formats, Precision to represents the maximum number of significant
digits (trailing zeros are omitted).
o For the s format Precision to is ignored.
e Check use group separators to include the group separators for your locale. E.g. to turn
1234567 to 1,234,567 for a UK or US locale.
¢ Set Non-numeric according to what you want to do with non-numeric values in
transformed columns. NaN means Not a Number.
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Notes

The locale is used to decide how the number is output (e.g. group and decimal separators).
Numbers should be base 10 (decimal).

$, £ and € characters are ignored.

If Decimal symbol from is set to Locale in Preferences the allowed group separators are
set by the locale. Otherwise dot (if not used as the decimal separator), comma (if not used
as the decimal separator), whitespace (including thinspace) and apostrophe characters are
ignored.

e You can also use Extract and Pad to change the number of characters.

e Warnings are shown in the Warnings tab for non-numeric values.

See also
e Video: How to convert decimal separators and number formats
e DateTime Format

2.3.36 Offset

Description
Moves values in selected columns up or down.

Example
Move the 'v2' values down 1:
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v V2
1 1 1
2 2 2
3 3 3
4 4 4
5 5 5
Offset FBE3 Offset FELT
@ Offset values up or down in selected columns. @ Offset values up or down in selected columns.
E Q Filter columns |E| Q Filter columns
vl i vl
, v2 v v2 |
1 of 2 columns selected 1 of 2 columns selected i
Offset: 1 - Offset: 1 -
Direction: Down v Direction: Down v
wraparound V| wraparound .
New value: 0 New value: F
vi *2 vi *vz
1 1 0 1 1 5
2 2 1 2 2 1
3 3 2 3 3 2
4 4 3 4 4 3
5 5 4 5 5 4
Inputs
One.
Options

e Check the column(s) you wish to transform.

e Set Offset to the number of rows you wish to offset values by.

¢ Set Direction to the direction you want to offset in.

e Check wraparound if you want values pushed off the bottom of the table to be added to
the top or values pushed off the top to be added to the bottom.
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¢ Set New value to the value you wish to set for any cells newly created by the offset.

Notes
e You can use Copy Cols to create copies of columns before you offset them.

See also
e New Rows
e Slide

2.3.37 Outliers

Description
Find outlier numerical values.

Examples
Set outliers empty based on quartiles and add a column with the outlier score:
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Reference

Height

1 0.00

2 -k

3 1.71

4 1L - 71

£y 1.73

6 1L 7/E

7 1.77

8 1.84

9 1.89

10 15595

11 2.10

12 5.00

Outliers el wEe
@ Find outlier numerical values.
Column: Height v
Score by: Inter Quartile Range v
Threshold: 1.50 -
Action: Set value v
Value:
Non-numeric: Treat as not outlier v
v add score column
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Remove rows with values that are more than 1 Standard Deviation from the mean:
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Weight
1 67
2 69
3 59
4q 98
5 103
6 84
7 71
8 75
9 83
10 0
11 300
Qutliers e Q{} 3:
@ Find outlier numerical values. I€
Column: Weight v
Score by: Standard Deviation v
Threshold: 1.00 -
Action: Remove outlier rows v
Non-numeric: Treat as not outlier v
add score column

\

Weight

1 67
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Inputs
One.

Options

e Select the column you wish to check for outliers.

¢ Set Score by depending on how you wish to score outliers.

o Inter Quartile Range scores values on how far they are above Q3 or below Q1 as
proportion of the Inter Quartile Range. For example:
= Avalue 2 IQRs above Q3 scores 2.0.
= Avalue 11QR below Q1 scores -1.0.
= A value between Q3 and Q1 scores 0.0.

o Standard Deviation scores values on how many deviations they are from the average
(mean). This is also known as a Z-score. For example:
= A value 2 Standard deviations above the average scores 2.0.
= Avalue 1 Standard deviations below the average scores -1.0.

e Any score that is greater than Threshold or less than -Threshold is considered an outlier.
E.g. if the threshold is 1.5 then values that scores more than 1.5 or less than -1.5 are
considered outliers. The corresponding upper and lower ‘fence’ values are shown in the
Info tab.

¢ Set Action to the action to take for outliers:

o Change to threshold: Value greater than the upper fence value or less than the lower
fence value are set to the nearest fence value. Non-numeric values are not changed, as it
isn't clear which fence value to set them to.

o Remove outlier rows: Rows with outlier values are removed.

o Keep outlier rows: Only rows with outlier values are kept.

o Set value: Outlier values are changed to the value provided in the Value field.

¢ Set Non-numeric depending on whether you want to treat non-numeric values as outliers.

¢ Check add score column if you want to add an extra column with the outlier scoring.

Notes

e Warnings are shown in the Warnings tab for non-numeric values.

Use Num Format to change the format of numbers (e.g. remove group separators).

Use Impute to impute any missing values.

Use Sort to sort by values in the score column.

e You can convert dates into numerical values (e.g milliseconds since 1970 or Julian day)
using Calculate or Javascript.

See also:
e Video: How to find outliers in data
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2.3.38 Pad

Description
Pad text to a minimum length in one or more columns.

Example
Pad the 'ld' column to 10 digits using zeros:
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Reference

Id Name
1 1 Alice
2 2 Bob
3 3 Charlie
< 4 Dwayne
Pad o dll==: [P

® Pad the selected column(s) to a fixed length.

EI Q Filter columns
Id
v

Name

1 of 2 columns selected

Minimum length: 10 =

Pad: Left v

Pad with: Zeros s
Id Name

1 0000000001 Alice
2 0000000002 Bob
3 0000000003 Charlie

4 0000000004 Dwayne
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Minimum length to the length you want values in selected columns padded to. Values
this length or longer are unaffected.

¢ Set Pad to Left or Right depending on where you want any padding characters added.

e Set Pad with to the character you want to pad with.

Notes
e Whitespace is counted when calculating length. You can use Whitespace to remove
whitespace before padding.

2.3.39 Pivot

Description
Creates a pivot table to summarize values for one or two columns.

Example
Pivot to sum 'Amount’ by 'Area’ and 'Currency":
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Reference

Area Currency Amount
1 Europe EUR 13937.00
2 North America 22894.90
3 Africa 12745.55

4 North America 48356.95

5 Europe GBP 1100.00

6 Europe m 5905.80

Pivot (‘f —= EG!

@ Create a pivot table to summarize the selected ...

Columns: Currency hd

Rows: Area ¥

Values: Amount v

Summarize by: Sum v

Set non-calculated: Zero v

v add totals
Total by: Rows and columns v
Area EUR GBP USD @B Grand Sum

1 Africa 0 0 0 12745.55 12745.55
2 Europe 19842.8 1100 0 0 20942.8
3 North America 0 0 71251.85 0 71251.85
4 Grand Sum 19842.8 1100 71251.85 12745.55 104940.2
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Inputs
One.

Options

e Set Columns to the column values you want to use as columns in your pivot table.

¢ Set Rows to the column values you want to use as rows in your pivot table.

¢ Set Values to the column you wish to summarize.

e Set Summarize by to how you wish to summarize the values:

o Sum show the sum of the values. Non-numeric and empty values are ignored.

o Minimum shows the smallest value. Non-numeric and empty values are ignored.

o Maximum shows the largest value. Non-numeric and empty values are ignored.

o Average shows the arithmetic mean of the values. Non-numeric and empty values are
ignored.

o Median shows the median of numeric values in the column. Non-numeric and empty
values are ignored.

o Mode shows the mode of numeric values in the column. Non-numeric and empty values
are ignored.

o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s). Non-numeric and empty values are ignored.

o Count shows the number of non-empty values. A value that contains whitespace or 0 is
not considered empty.

o Count distinct show the number of non-empty values. Duplicates are not counted. A
value that contains whitespace or 0 is not considered empty.

¢ Set Set non-calculated depending on how you want to set cells not calculated by the
pivot.

¢ Check add totals to add row and/or column totals.

e Set Total by depending on whether you want to total by Rows and columns, Rows or
Columns. This is only available if add totals is checked and Columns and Rows are
selected.

e Check drilldown to allow double-clicking a cell in the data table to drilldown to the rows
that contributed to this value in the upstream data.

Notes

e Column and row values are ordered alphabetically. You can change the order using
Reorder Cols (for columns) and Sort (for rows).

e Mode may not work as expected with non-integer values, due to precision issues. You can
fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.

e To add a column of 1 values to Sum (e.g. to find out how many rows a value occurs in) use
a New Col transform.
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See also
e Count
e Stats

e Summary
2.3.40 Random

Description
Adds a new column, filled with pseudo-random numbers.

Example
Add a new column of random real values between -1 and +1:
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Reference

v
1 0
2 1
3 2
4 3
5 4
Random = d} E':

@ Add a new column filled with pseudo-random n... |

New column name: RNG

Type: Real v I
Seed: 0 =
Minimum: -1.00 -
Maximum: 1.00 -
v RNG

1 0 -0.3584059983

2 1 0.0231829141

3 2 -0.5275243884

4 3 -0.6523676871

5 4 0.7553240687
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Inputs
One.

Options

¢ Set New column name to the name of the new column you want to create.

¢ Set Type depending on whether you wish to generate Real (floating point) or Integer
(whole number) values.

e Set Seed to the seed value used by the pseudo-random generator algorithm.

¢ Set Minimum to the minimum value you want to generate. The value may be equal to
minimum, but not less.

¢ Set Maximum to the maximum value you want to generate. The value may be equal to
maximum, but not more.

Notes

e The numbers output are a sequence of pseudo-random numbers based on the Seed value.

e The same sequence is always output for the same options.

¢ The default Seed value is based on the system clock when the transform was first created.

e To generate random text (strings) use Random with Type set to Integer and then use the
results in conjunction with Lookup to lookup text values using an integer key.

e To generate random dates or datetimes then use Random with Type set to Integer and
then use the results in conjunction with Calculate with Operation set to
MSecsToDateTime.

e To generate a real random value between numerical values in Min and Max data columns:
o Generate real values between 0 and 1 using Random.

o Use the Javascript transform to calculate a new value in the desired range, e.g.:

return ( $(Max) - $(Min) ) * $(Random) + $ (Min);

e To generate passwords use Random in conjunction with the Hash transform.
e New columns are always added at the right end. You can change the column order with
Reorder Cols.

See also
e Sample

2.3.41 Remove Cols

Description
Removes columns.

Example
Remove the 'Area' column:
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Reference

Area Currency Amount

1 Europe EUR 13937.00
2 North America USD 22894.90

3 Africa ZAR 12745.55

y

Remove Cols Q{} =

KA

[T

@ Uncheck columns you wish to remove.

[ — _—
E Q Filter columns

:
Area !
c E
urrenc '
v oo |
i
Amount
v i
g
Currency Amount
1 EUR 13937.00
2 UsD 22894.90
3 ZAR 12745.55
Inputs
One.
Options

¢ Uncheck the column(s) you wish to remove.
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Notes
e The column will be removed from any dataset ‘downstream'.

See also
e New Col

2.3.42 Rename Cols

Description
Rename column headers.

Example
Rename columns 'first' to 'First' and 'Last' to 'last":

first last
1 John Smith
2 Jane Smith
Rename Cols GP Eg
@ Rename column headers.
a || A ||Aa||2
Old name New name
first First
last Last

First Last
1 John Smith
2 Jane Smith
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Inputs
One.

Options

e Change the column headers using the New name column.

e Click Lower to change all the names to lower case.

¢ Click Upper to change all the names to upper case.

e Click Title to change all the names to title case.

¢ Click Replace to replace name text using text, exact text or Regular expression matching.
e Click Prefix/Suffix to add text to the front or back of all the names.

¢ Click Unique to add '-2', '-3" etc to duplicate names, to make them unique.

e Click Reset to change all the names back to their original name.

Notes
e The names of column headers do not have to be unique.
e Warnings are shown in the Info tab for duplicate column names (case sensitive).

2.3.43 Reorder Cols

Description
Reorder columns.

Example
Reorder 'Last’, 'First' and 'Title' columns:
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Reference

Last Fil Title
1 Smith John Mr

ESmiIhMDI

Reorder Cols Qﬂ EEs EG
@ Drag columns to reorder.

B WEEC

Title

First
Last

Title |First | Last

1 Mr  John Smith
2 Dr Smith
Options

Drag the columns into the desired order (left-most at the top).

Click the Move first button to move the selected columns to be first.

Click the Move up button to move the selected columns up one place.

Click the Move down button to move the selected columns down one place.
Click the Move last button to move the selected columns to be last.

Click the Sort ascending button to sort the columns in ascending order.
Click the Sort descending button to sort the columns in descending order.
Click the Reset button to restore the original column order.

Inputs
One.
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Notes

e You can also rename columns with Rename Cols and remove unwanted columns with
Remove Cols.

e Number, date and text values are treated differently for sorting purposes, when sorting
columns.

2.3.44 Replace

Description
Replace text in one or more columns.

Examples
Replace US state initials in the 'Address' column:
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First Last Address

1Jane  Smith 100 W St, Tucson, AZ
2 Ahmed Ali 17 N St, Anchorage, AK

3 Josh  Jones 123 S St, Fort Smith, AR

‘

Replace o4 ate
@ Replace multiple text in the selected column(s). ...
E Q Filter columns

Last -

y, ﬂFIdress

1 3
1 of 3 columns selected

@MV ®ERS&S X

Match Type Replace With
1 Text ¥ AK Alaska
2 Text ¥ AR Arkansas
3 Text v AZ Arizona

v case sensitive

y

First Last Address

1 Jane  Smith 100 W St, Tucson, Arizona

2 Ahmed Ali 17 N St, Anchorage, Alaska

3 Josh  Jones 123 S St, Fort Smith, Arkansas
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Reformat phone numbers using a regular expression:
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| c
‘ Home Business

10123456789 0123489404

20139384892 0129347236

N

R A
Replace o A
@ Replace multiple text in the selected column(s). Can use powerf...
[ =] (aFilter columns

H
v 'D.I'T'I'E‘.

Business

v

2 of 2 columns selected

@ TV ®E S X

Match Type Replace With
1/ Regex v opd\d\d\d)(drdvd\drd) (+44) \1\2

V

Home Business

1 (+44) 1234 56789 (+44) 1234 89404

Vv case sensitive

2 (+44) 1393 84892 (+44) 1293 47236

3 (+44) 1534 98348 (+44) 1509 23404

Replace empty values:
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! nl n n3

1 123.8 9876.1

2981234 23.3
3 288
Replace d} E C

@ Replace multiple text in the selected column(s). Can use powerf...

El Q Filter columns

ni

v

v "

JHE

3 of 3 columns selected
@ T VB & X

Match Type Replace With
1 Empty v 0.0

- !
Vv case sensitive

y

ni nZ n3

11 123.89876.1 0.0

2981234 00 233

3 288 00 00
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Remove symbols:
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Amount
1 $100.0
2 $95.2
=) $45.3
4 $15.6
Replace * Cf: = Ei

® Replace multiple text in the selected column(s).
E IEI Q Filter columns

Amount

v

1 of 1 columns selected

@1 VRS X
Match Type Replace With
1 Symbols v

V

Amount
1 100.0
2 95.2
3 45.3
4 15.6
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Inputs
One.

Options
e Check the column(s) you wish to transform.
e Click the ® button to add a new filter criteria.
e Click the T button to move the selected terms up.
e Click the ¥ button to move the selected terms down.
e Click the ® button to delete the selected filter terms.
e Click the 5 button to copy all terms to the clipboard.
e Click the & button to paste terms from the clipboard.
e Click the X button to clear all terms.
e Add the terms you wish to replace and how you wish to replace them.
o Choose the Match type as:
» Text to replace matches contained in the text.
= Exact text to replace the text only if it matches exactly (whitespace sensitive).
= Regex to match using a Regular expression.
= Empty to match empty cells (cells with whitespace are not empty). The Replace value is
ignored.
» Letters to match letters, e.g. 'a'. The Replace value is ignored.
= Digits to match numeric digits, e.g. '1'. The Replace value is ignored.
* Punctuation to match punctuation characters e.g. ',". The Replace value is ignored.
» Symbols to match symbol characters e.g. '$'. The Replace value is ignored.
» Space to match whitespace characters. The Replace value is ignored.
o In Replace put the text you want to replace for Text, Exact text or Regex matching. You
can use a column variable.
o In With put the text you want to replace it with. You can use a column variable.
e Check case sensitive to use case sensitive matching for Text, Exact text or Regex
matching.

Notes

e If you can to keep the original column use Copy Cols to copy the column first.

e Comparisons are whitespace sensitive. You can use Whitespace to remove whitespace
before replacing.

e If you are pasting in replacement terms, the format expected is comma delimited text with
3 columns.
o The first column is the 0-based index of the Match Type drop-down list.
o The second column is the text Replace.
o The third column is the text With.

For example, pasting in:
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0,YES, 1
2,7Ys,1
Will add:

Match Type Replace With I

1 Text v YES 1 :

2/ Regex v rYS 1 :

You can also try copying terms to the clipboard and pasting into a text file to see the format.
If you only paste in 1 column of text, it will be assumed to be a list of Replace. You can, of
course, use Easy Data Transform to create the appropriate filter terms and paste them into
memory.

See also
e |nsert
e Substitute

2.3.45 Row Num

Description
Add a new column that contains the row number.

Example
Add a row number starting at 1:
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Product Id
1/A00001

2 A00002

3 A000O3

Row Num E‘%d’@;ﬂ

@ Add a new column with the row number.

New column name: Row Num

Start at: 1 :
Increment: 1 :
Every: 1 .

v

Product Id Row Num
1 AQD0O1 1
2 A00002 2
3 A00003 3
Inputs
One.
Options

¢ Set New column name to the name of the new column you want to create.
e Set Start at to the number you want to use for the first row.
e Set Increment to the amount you wish to increment by.
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e set Every to how often to apply the increment (e.g. set to 5 to increment once every 5
rows).

Notes

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

e You can Pad the row number with zeros to turn it into a column of unique Ids with a fixed
length.

e You can use Row Num with a Calculate transform using operation MSecsToDateTime to
create a sequence of dates.

e You can use Row Num with Calculate transform using operation Modulus and an If

transform to create a sequence of repeating text.
2.3.46 Sample

Description
Selects a subset of rows from the input.

Example
Sample 3 rows from 5:
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Timestamp Temperature ( F) Humidity (RH )
1 2020-10-19720:40 143.5 108
2 2020-10-23T19:45 119.6 127

5 2020-11-05T07:15 130.8 132

Sample - d: E g'
® Sample from all rows. Useful for testing changes to d...
Rows: 3 -
Select: Evenly v
Random seed: 93267 =

disable sampling

'

‘Timestamp Temperature (F) Humidity (RH )
1 2020-10-23T19:45 119.6 127

2020-10-30T16:40 1385 87

Inputs
One.
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Options

¢ Set Rows to the number of rows you want to output. If it is the same or greater than the
number of rows in the input, then the input will be unaffected.

¢ Set Select depending on how you want the rows sampled.

e Check disable sampling to turn off sampling. If sampling is disabled, the transform does
nothing.

Notes

e If you set Select to Randomly (for quality) or Randomly (for speed), rows will be
selected using a pseudo-random number generator, initialized with Random seed.
Changing the seed will change the rows sampled.

e With the same Random seed and the same Select value you should get the same random
sampling, even across Windows and Mac versions of Easy Data Transform.

¢ Random (for speed) is significantly faster than Randomly (for quality), but the results
may be less random.

e If you are transforming a large dataset, then you can use Sample to test a small subset.

e If you need to do something more complex than Sample can handle (e.g. keep only rows
500 to 1000) then use Slice or Row Num followed by a Filter. For the most complex cases
use Row Num, followed by Javascript, followed by a Filter. E.g. this Javascript function
returns 1 for every 10th row between 1000 and 2000 and O otherwise:

return $(Row Num) >= 1000 & $(Row Num) <= 2000 & $(Row Num) % 10 ==
0;
2.3.47 Scale

Description
Scale (normalize) numeric values, e.g. to a percentage or 0 to 1.

Examples
Scale a single column to a percentage:
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Reference

Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale d: E ﬂ

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item

v, Di.s.pgted

1 of 2 columns selected

1)

Scale to : 100
Using:  Sum v

Of: All values v

v

Item Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions 20.5633113897

3 Unknown 13.6227590823




Reference

Scale a table with row, column and grand totals to a percentage (scale to 400 as each value is
also added to the row total, column total and grand total):
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Sum Amount EUR GBP usD ZAR Total
1 Africa 0.00 0.00 0.00 12745.55 12745.55

2 Europe 19842.80 1100.00 0.00 0.00 20942.80
3 North America 0.00  0.00 71251.85 0.00 71251.85

4 Total 19842.80 1100.00 71251.85 12745.55 104940.20

y

R AL

Scale dz v bt

® Scale numeric values, e.g. to a percentage or O t...
IE' Q Filter columns

Sum Amount

EUR
v

v GBP

usph
v

v ZAR_

Total
v _

5 of 6 columns selected

Scale to : 400

1)

Using:  Sum A

Of: All values v

v

Sum Amount EUR GBP usD ZAR Total

1 Africa 0 0 0 12.1455362197 12.1455362197
2 Europe 18.9086737018 1.0482160316 0 0 19.9568897334

3 North America 0 0 67.8975740469 0 67.8975740469

4 Total 18.9086737018 1.0482160316 67.8975740469 12.1455362197 100
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Scale heights and weights so that the largest in each column is 1 and the smallest is 0.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
Scale t:x':1 Eﬂ I

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Name

v Hv.elght.{m} | |

v fo,-'iight (Kg) |

2 of 3 columns selected

Scaleto: 1 :
|

Using:  Maximum v |
|

Of: Each column v |

'

Name Height (m) Weight (Kg)
1 Alice 0.8168316832 0.6632653061

2 Bob  0.9851485149 1

3 Charlie 0.9554455446 0.7755102041
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Scale heights and weights so that the largest in each column is 1 and the smallest is 0.
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Name Height (m) Weight (Kg)
1 Alice 1.65 65.0
2 Bob 1.99 98.0
3 Charlie 1.93 76.0
4 Doug 2.02 89.5
5 Erin 1.89 76.3
| Scale _‘*““ e EL]

@ Scale numeric values, e.g. to a percentage or 0 t...

o — .
IEI Q Filter columns

MName

Height
v E|.g. (m)

Weight (K
v ght (Kg) |
2 of 3 columns selected
Scale from : 0 :
Scale to : 1 -
Using: Minimum & Maximum v
Of: Each column v

v

Name Height (m) Weight (Kg)
1 Alice 0 0

2 Bob 0.9189189189 1




Reference

Inputs
One.

Options

¢ Set Columns to the columns whose values you want to scale.

e set Scale from to the value you want to scale the minimum value to. E.g. 0 if you want the
minimum value scaled to 0. This is only available when Using is set to Minimum and
Maximum.

¢ Set Scale to to the value you want to scale the maximum or sum value to. E.g. 100 for a
percentage.

e Set Using depending on whether you want to use the Sum, Maximum or Minimum and
Maximum values for scaling.

¢ Set Of depending on whether you want to scale for Each column, Each row or for All
values.

Notes

e Whether values are interpreted as numbers depends on locale.

e Non-numeric values (including empty values) are ignored.

e To replace empty values with zeros use the Replace transform.

e To modify the numerical precision of the results use the Num Format transform.
e To add a '%' at the end of values use the Insert transform.

e To copy columns before using Scale use Copy Cols .

e Warnings are shown in the Warnings tab for non-numeric values.

See also:
e Video: How to normalize data

2.3.48 Sequence

Description
Add missing rows from an integer or date sequence.

Examples
Add missing IDs in the current range, with values copied from above:
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Reference

i ID CODE

1 1A

2 SE

3 10cC

Sequence % e

@ Add missing rows from a sequence.
Rows added: Missing integers M
From column: |ID - |
Minimum: User defined b
Minimum value: 1
Maximum: User defined =
Maximum walue: 15
Order: Ascending v
MNew values: Copy from above * |

ID CODE
1 lAa
2 2A
3 3A
4 4 A
5 | 5B
(5 | 6B
7 | 7B
8 | 8 B




Reference

Add missing dates in a specified range as 0 sales:
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Date Sales

112/1/2023 100

2‘?!1;’2!‘.]23 2000

BIBI 1/2023 ‘ 555

Sequence 9= Q{} 31:.
(?) Add missing rows from a sequence. '
Rows added: Missing dates ¥ E
From column:  Date - F
Minimum: User defined v E
Minimum value: | 2023-1-1
Maximum: User defined v
Maximum value: 2023-1-14 i
Order: Ascending b F
New values: User defined -
With value: 0

Date Sales
1 1/1/2023 0
2 2/1/2023 100
3 3/1/2023 0
4 4/1/2023 0
5 5/1/2023 0
6 ©6/1/2023 0
7 1/1/2023 2000
8 8/1/2023 0
. s —



Reference

Create an integer sequence from a dataset with no rows:
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Sequence % Oﬂ B E g
@ Add missing rows from a sequence.
Rows added: Missing integers >
From column: N -
Minimum: User defined >

Minimum value: 0
Maximum: User defined -

Maximum value: 9

Order: Descending *
New values: Blank =
N

1|9

2| 8

3|7

4 | 6

5|5

6 4

7 3

g8 | 2

9 1

10, 0

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Inputs
One.

Options
¢ Set Rows Added to Missing integers or Missing dates depending on the type of
sequence.
¢ Set From column to the column with the incomplete sequence.
¢ Set Minimum to:
o From data to set the minimum value in the sequence to the minimum value in the
selected column.
o User defined to set the minimum value to a value set by the user. Must be in -M-d
or yyyy-MM-dd format for dates, regardless of the date format in the dataset.
e Set Maximum to:
o From data to set the maximum value in the sequence to the maximum value in the
selected column.
o User defined to set the maximum values to a value set by the user. Must be in yyyy-M-d
or yyyy-MM-dd format for dates, regardless of the date format in the dataset.
e Set Order according to whether you want the dataset sorted Ascending or Descending by
the selected column.
¢ Set New values to:
o Blank to set new row values to empty.
o Copy from above to set new row values to the same as the next row sorted above from
the input dataset.
o Copy from below to set new row values to the same as the next row sorted below from
the input dataset.
o User defined to allow the user to choose a value for new row values. Set With value for
the new value to use.

Notes

e Existing sequence values are unchanged.

¢ You can add leading zeros to integers values created using the Pad transform.

e Dates added will try to follow the format of existing dates, using the date formats listed in
the Dates tab of the Preferences window. If you want ISO dates, make sure yyyy-MM-dd
is above yyyy-M-d.

e You can change the format of dates created using the DateTime format transform.

e If you only want to add some values from a sequence (e.g. odd numbers or weekdays) then
you can do this by using Sequence followed by Filter to remove the unwanted values. You
might need to use Calculate with the Modulus and/or Day of week operation to create a
column to filter on.

e Use the Cross transform if you want to combine multiple sequences. E.g. to cross hourly
times (00:00, 01:00 ... 23:00 ) with a date sequence.
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See also
e Video: How to insert missing dates
e New rows
e Fill
e Impute
e Interpolate
2.3.49 Slice

Description
Keep or remove a continuous section of rows.

Example
Keep only the rows between the 'YEAR' rows:
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Reference

1 2 3 4
1 YEAR JAN FEB MAR

2 1980 2569 2385 2754
3 1981 2489 2249 259.1
4 YEAR JAN FEB MAR
5 1982 258.6 230.0 2804

6 1983 2759 2349 2519

4

Slice x‘f’ Ei
® Keep or remove a continuous section of rows.
Mode:  Keep v
From: First row where v
Column: 1 v
Matches: = Equal to v
Value:  YEAR

include 'From' row

To: Last row where v
Column: 1 v
Matches: = Equal to b
Value:  YEAR

include 'To' row

v case sensitive

v

1 2 2 4




Reference

Inputs
One.

Options

e Set Mode depending on whether you want to keep or remove the slice.

e Set From according to how you want to choose the first row of the slice.

Set Column, Matches and Value to match the first row. You can use a column variable for
either Value.

Uncheck Include ‘From’ row if you don't want to include the first row in the slice.

Set To according to how you want to choose the last row of the slice.

Set Column, Matches and Value to match the last row.

Uncheck Include 'To' row if you don't want to include the last row in the slice.

e Check case sensitive to use case sensitive matching for text.

Notes

e If there is no match for the From or To row:

o Mode=Keep will remove all rows

o Mode=Remove will keep all rows

e Number, date and text values are treated differently for Equal to, Greater than, Less than,
Greater than equal, Less than equal and Not equal to operations.

o If both values are numeric, a numeric comparison will be carried out. This is accurate to
approximately 16 digits of precision.

o If both values match a supported date formats in Preferences, a date comparison will be
carried out.

o Otherwise the values will be treated as text.

o For example, an empty value is considered less than O, because they will be compared as
text. So you might want to replace empty values with 0 or remove those rows with Filter,
before comparing them.

e All values are treated as text for Contains, Starts with, Ends with, Matches regex, Is not,
Doesn't start with, Doesn't end with and Doesn't match regex operations.

e Comparisons of text are whitespace sensitive. Cells with whitespace will not match Is
empty. You can use Whitespace to remove whitespace before filtering and Replace to get
of other unwanted characters (e.g. whitespace inside the text).

e See here for more details on Regular expressions (regex).

e If you want to keep or remove a selection of rows by row number, use a Row Num
transform followed by a Filter transform.

2.3.50 Slide

Description
Move non-empty values in selected columns to adjacent non-empty cells.
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Example
Move all non-empty values to the top:
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Alice Bob Charlie
ltask 1
2 task 3
3 task 4
4-task 6 task 7
Slide e dlll === [IDge

® Move non-empty values in selected columns int...
IE‘ Q Filter columns

v Alice

v Bob

v Charlie

3 of 3 columns selected

Direction: Up v

V

Data Characters  Warnings

3 cols x 4 rows
BB ZSHIEY K < > -l

Alice Bob Charlie

1task 1 |task 2 task 3

2 task 4 task 7

3 task @&
Easy Data Transform © 2023 Oryx Digital Ltd
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Inputs
One.

Options
e Check the column(s) you wish to move values in.
¢ Select Direction depending on the direction you wish to move values.

Notes
e Cells containing whitespace are not considered empty.
¢ You can delete rows left empty using Filter. and column left empty using Remove Cols.

See also

e Offset

e Fill

e Whitespace
2.3.51 Sort

Description
Sorts rows by one or more columns.

Examples
Sort by 'Last' and then First' columns:
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Title First Last

1Mr John Smith

2/ Dr |Jane ‘Smith

3 Mr

Albert‘ Smith

4 Mr John Doe

v

R A
Sort ‘s QE} =)
@ Sort rows by text, numeric and date values in th...

@ 1L ®| X

Column Order
1/ Last ¥ Descending ~
2 First ¥ Descending ¥

add rank

V

Title _First _Last

1/Mr  John Doe

4 Mr  John Smith

Sort by 'Category' and then 'Score' columns. Rank for each distinct ‘Category' value:
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Name Category Score
1 Andy Novice 122
Jeint veteran | 120
3 Charles Novice | 123

v

Sort & d’ = EZ
@ Sort rows by text, numeric and date values in th...
@™ L ® X
Column Order
1|'.’.Z:atta*n,:;r;:-r'yr ¥ Descending ¥
2|Sn:nre ¥ Descending ~
v add rank
Rank type: Minimum v
Rank by: Category * h4
Name Category Score Rank

IIIIIIEHHHHHHHIIIIII'F !IIIII%HHHHH%HHIII
EliCharlaes NOovwvice 1232 |



Reference

Inputs
One.

Options
e Click the @ button to add a new sort level.
e Click the T button to move the selected sort levels up.
e Click the V' button to move the selected sort levels down.
o Click the ® button to delete the selected sort level(s).
e Click the X button to clear all sort levels.
e Set Column to the column you want to sort by.
e Set Order depending on whether you want to sort this column Ascending or Descending.
e Check add rank to add a ranking column
o Set Rank type according to how you wish to do the ranking:

» Minimum: Uses the minimum rank of each group.

» Average: Uses the average rank of each group.

» Maximum: Uses the maximum rank of each group.

» Dense: Each successive rank is only incremented by 1. There are no gaps.

» Cumulative: Shows the proportion of rows (0 to 1) with the same or lower numbered

rank.

For example:

Sorted score
1 131
2 123
3 123
4 123
5 120
6 120

Gives the following rankings, depending on Rank type:
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Rank type

Sorted score Minimum Average Maximum Dense Cumulative
131 1 1 1 1 0.167

123 2 3 4 2 0.667

123 2 3 4 2 0.667

123 2 3 4 2 0.667

120 5 5.5 6 3 1

120 5 5.5 6 3 1

o Set Rank by to rank separately for each distinct value in this column. Leave as <None
selected> if you only want a single ranking for all rows.

Notes

e If you add multiple levels, it will sort by level 1 then level 1 values that are the same will be
sorted by level 2 etc.

e Number, date and text values are treated differently for sorting purposes.

¢ Any values that can be converted to numbers will be treated as numbers.

e Any values that match the supported date formats in Preferences will be treated as dates.

e Comparisons of text are case and whitespace sensitive. You can use Case to change the
case and Whitespace to remove whitespace before sorting.

e If you want to rank rows without losing the original order, use Row Num to add a row
number before the Sort, and then use another Sort on the Row Num column to return to
the original order.

e Unsorted columns can be sorted into any order and this may vary between different
released of Easy Data Transform and Windows and Mac versions.

See also:
¢ Video: How to rank data

2.3.52  split Col

Description
Split a column into multiple new columns or rows.
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Reference

Examples
Split the 'Courses' column into multiple columns or rows:

Name Courses

1 Alice  C001,H005
2 Bob  [P0O02

3 Charlie|C001,P003

4 Denzil [E007,C001,H005

split Col %l ¢ B 3 split Col el bR
@ Split a column into multiple new columns or rows. ® Split a column into multiple new columns or rows.
Column: Courses A Column: Courses v
Using: Text delimiter W Using: Text delimiter v
Delimiter: Delimiter:
Into: Columns o Into Rows v
Ordering:  Current h.d Ordering:  Current 4

keep empty keep empty

Min. values: 0 = Min. values: 0 -
Max. values: 100 = . Max. values: 100 -

v v

Name Courses Courses1 Courses2 Courses3 Name Courses
1 Alice  C001,H005 coo1 HO005 1 Alice €001
2 Bob  P002 P002 2 Alice  HO005
3 Charlie C001,P003 Co01 ‘POOB 3 Bob  PO0O2
4 Denzil EOOT,COOLHOOS\EOO'I JEO(H HO005 4 Charlieﬂ
5 Charlie P003
6 Denzil E0O7
7 Denzil €001
8 Denzil HOOS

Split the 'URL' column into multiple columns using colon, slash, question mark or ampersand:
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URL

1 https://www.easydatatransform.com/index.html?7utm=adwords&token=xxx

2 https://www.perfecttableplan.com/download.html

3| https://www.hyperplan.com/buy.htm|?utm=twitter

¢

Split Col e dlll === (D36

@ Split a column into multiple new columns or rows.

Column: Courses A
Using: Regex delimiter v

Delimiter:  [/?&]

Into: Columns v
Ordering:  Current v
keep empty
Min. values: 0 -
Max. values: 100 :
URL URLT URL2 ‘ URL3 URL4 URLS
1 https://www.easydatatransf... https www.easydatatransform.co... index.html utm=adwords  token=xxx

2 https://www.perfecttablepl... https www.perfecttableplan.com download.html

Jbuy.html

3 https://www.hyperplan.co... lhttps |www.hyperplan.com

utm=twitter

Split characters 4 to 13 and 15 onward into new columns:
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ID

1 XXXID34982347-423434
2 XX¥XID34983441-7347877

3 XXKID34973883-07434

V

Split Col clFe dll==Z [I0Ee

® Split a column into multiple new columns.

Column: D
Using:  Lengths v
Lengths: -3,10,-1*

Into: Columns v

Ordering: Current v

ID ID1 ID2
1 XXXID34982347-423434 1ID34982347 423434 "'

2 XXXTID34983441-7347877 ID34983441 7347877

3 XXXID34973883-07434 ID34973883 07434

Inputs
One.

Options

e Select the Column you wish to split.
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e Set Using depending on whether you wish to split using a Text delimiter (usually a single
character), a Regex delimiter or Lengths of each column.

¢ Set the Delimiter for splitting the column. E.g., (comma). For Text delimiter or Regex
delimiter only.

e Set Lengths as a comma separated list of the number of characters in each new column.
Put - in front of a value to ignore it. Use * as a wildcard to mean 'the rest of the value'. Only
1 * can be used. For Lengths only. For example:
o 3,5, 4 will create 3 columns with characters 1-3, 4-8 and 8-11
o-3,5,-4,* will create 2 columns with characters 4-8 and 12 onward
o -*, 3 will create 1 column with the last 3 characters
o 2,-*,2 will create 2 columns with the first 2 and last 2 characters

¢ Set Into to:
o Columns to create a new column for each split value.
o Rows to create a new row for each split value (the original row is removed).

¢ Set Ordering depending on how you want to order values after splitting.

e Check keep empty if you wish to keep empty values (e.g. honor delimiters with nothing in
between). For Text delimiter or Regex delimiter only.

¢ set Min. values to the minimum number of columns/rows you wish to split each value into.
For Text delimiter or Regex delimiter only.

¢ set Max. values to the maximum number of columns/rows you wish to split each value into
(ignored if less than minimum). For Text delimiter or Regex delimiter only.

Notes

¢ Set Min. values to the same as Max. values to always create the same number of columns.

e To split a column by carriage returns or tabs set Using to Regex delimiter and set
Delimiter to \n or \t, respectively.

e |f Into is Columns, new columns are added at the right end. You can change the column
order with Reorder Cols.

e If there is a header, the header of the new column is based on the original header. You can
change the column name with Rename Cols.

e The opposite of Split Col with Into as Columns is Concat Cols.

¢ The opposite of Split Col with Into as Rows is Unique.

See also
e Split Rows

2.3.53 Split Rows

Description
Split each row into multiple rows.
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Examples
Split rows before each column containing 'title":

Guest title Guest first name Guest last Spouse title Spouse first name Spouse last name

1 er ‘John Smith Dr Jane Smith
2‘ Mr Bill Brown Mrs Andrea Brown
Split Rows (f“ feed Ei

® Split each row into multiple rows.
Split each row:
® before each column where name ¢ ¥ title

1time 5 before <None ¥ then every 1 columi

automatically using repeated column names

+

Guest title Guest first name ‘Guest last

Vv case sensitive

1\ Mr John Smith
2

3 Mr Bill Brown
4 Mrs Andrea Brown

Split rows using repeated column names:
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QL Q2 Q3 04 01 Q2 03 04 Q1 Q2

[ |
1/ 232 123 34 5678 2345 23 234 89 341 93i

Split Rows 1:? Eg
@ Split each row into multiple rows.

Split each row:

before each column where name =
2 times| y starting be Q2 then every 4 colun
® automatically using repeated column names

v case sensitive

Ql Q2 Q3 04
1 232 123 34 5678

2| 2345 23| 234 89

3 341 93

Inputs
One.

Options
¢ Split by column name:
o Each row will be split before each column that matches the criteria.

e Split a fixed number of times:
o Define the number of times you want to split each row, starting before which column

and then every N columns.
o The split is added before the designated columns.
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o Splits after the last column are ignored. So you can set times to a large number if you
don't know how many columns there will be.
e Split automatically:
o Find the first column name that appears more than once and split each row before each
column with that name.
e Check case sensitive to use case sensitive matching for column names.

Notes

e Comparisons of column names are whitespace sensitive.

e Splits added before the first column are ignored, as there is already a split there.

e Use New Col or Rename Cols if you need to add additional columns or rename columns
before splitting rows.

e The opposite of Split Rows is Concat Rows.

See also
e Gather

e Split Col
2.3.54 Spread

Description
Spread a column into multiple new columns. Also called wide pivot or crosstab.

Example
Spread 'Quarter' and 'Amount’ columns to multiple columns:
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salesman area Quarter Value

1 Alice North Q1 1.3
2 Alice North 89.3
3 Alice North Q3 443
4 Alice North -E
5 Bob East Qi 4.5
6 Bob East 7.9
7 Bob East Q3 8
8 Bob East 3.3
Spread tf’ EC
@ Spread the selected key and value columns into m...
Key column:  Quarter v
Value column: Value v

Missing value:
Min. new cols: 0

Max. new cols: 100

4>

salesman area Q1 Q2 Q3 Q4

1 Alice North‘ 11.3‘ 89.3‘ 44.3‘ 18

2 Bob East 45 79 8 33
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2.3.55

Inputs
One.

Options

Select the Key column and Value column you wish to spread.

Missing values is used for values missing from the input dataset.

set Min. new cols to the minimum number of new columns you wish to add, compared to
the original dataset.

set Max. new cols to the maximum number of new columns you wish to add, compared to
the original dataset. Ignored if less than minimum.

Notes

¢ Set Min. values to the same as Max. values to always create the same number of columns.
e Use Sort on the key column before this transform if you need to control the order of
columns created.

If there are rows that are duplicates, apart from the value column, this will cause errors.
New columns are added at the right end. You can change the column order with Reorder
Cals.

e You can merge the new columns into a single column with Concat Cols.

e The opposite of Spread is Gather.

Stack

Description
Merge rows from inputs, one on top of the other.

Examples
Stack 3 employee datasets by header name:

Stack d} =) Zi

Name D DOB
@ Merge input datasets one on top of another. Or...

employeesl.c...
1John Black 001 1956'0?'01*0 Align columns by: Header name v

3 cols x 2 rows
2 Paul White 002 1973-03-11 /
ID DOB
ng—_

Name Name ID DOB

q employees2.c...
1 003 Jill Green 1977-12-30*9 Py — 9 Slesiek 1JohnBlack 001 1966-07-01

3 cols x 2 rows 3 cols x 6 rows

2 004 Ahmed Ali 1980-11-05 2 Paul White 002 1973-03-11

DOB D Name 3Jill Green 003 1977-12-30

11968-12-12 005 Lars Hansen *oem"'c"’ees”‘" 4/Ahmed Ali 004 1980-11-05
. . 3 cols x 2 rows |

2 1977-01-05 006 Pierre Martin 5 Lars Hansen 005 1968-12-12

6 Pierre Martin 006|1977-01-05
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Stack 2 employee datasets by column number:

]
Stack C? | :;
Name ID DOB @ Merge input datasets one on top of another. Or...
1 John Black 001 1966-07-01 *employeesl.c,,, Align columns by: Column number v

3 cols x 2 rows

2 Paul White 002 1973-03-11 Name ID DOB

1 John Black 001 1966-07-01

>0 Stack A g 2 Paul White 002 1973-03-11

3 cols x 4 rows

3 Jill Green 003 1977-12-30

fullname id  date of birth 4 Ahmed Ali 004 1980-11-05

1Jill Green 003 1977-12-30 *Qemp"’yeesz‘c'"

3 cols x 2 rows

2 Ahmed Ali 004 1980-11-05

Stack 2 employee datasets with a separator row:

Stack Oﬂ Ez
@ Merge input datasets one on top of another. Or...
Align columns by: Column number w
Name ID DOB v add separator rows
1John Black 001 1966-07-01 *gemploye‘%l‘c'" With value: ol
2 Paul White 002 1973-03-11 eols 2 rovs | Name b DoB
! 1 John Black 001 1966-07-01
i ’
Stack . : 2 Paul White 002 1973-03-11
2 ol x5 rowe I | 3.##### #HHHE BEHEH
|4 il Green 003 1977-12-30
full name id date of birth \| s |Ahmed Al 004|1980-11-05

10l Green 003 19771230 iy @) employees2.c...

i 3 cols x 2 rows
2 Ahmed Ali 004 1980-11-05

Inputs

One or more.

Options

¢ Select Align columns by to Header name if you want line up column values by header
name (e.g. the 'id' column in input 1 with the 'id' column in input 2) and Column number to
align by the column number (e.g. the first column of input 1 with the first column of input
2). The headers will be matched in order:
o case and whitespace sensitive (e.g. 'ID' to 'ID"); then
o case insensitive and whitespace sensitive (e.g. 'ld' to 'ID'); then
o case sensitive and whitespace insensitive (e.g. 'ID' to ' ID ); then
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o case and whitespace insensitive (e.g. 'ld"to ' ID ")

¢ Check use only top dataset columns to ignore columns not in the first dataset.

e Check add separator rows to extra rows to separate the inputs. The value entered for
With value is used for each column of the separator rows.

Notes
e The stacking order depends on the vertical (Y-axis) position of the inputs.
e Stack merges datasets one on top of the other (vertically). To merge datasets side-by-side
(horizontally) use Join.
e If you align by Column number the header of the first input is used.
e Messages are shown in the Warnings tab for:
o duplicated column names within an input dataset when Align columns by is set to
Header name
o columns stacked under columns with different names when Align columns by is set to
Column number
o differing numbers of columns between input datasets
e |tis sometimes useful to Stack a single dataset, so you can add more inputs later.

See also

e Cross

e Join

e Merge datasets
23.56 Stamp

Description
Adds a stamp with time, date and other information as a new row or a new column.

Examples
Add the current date to the end of each row:
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Generation [kW] Grid [kW]  Solar [kW]
1 1.904804444 0.372133333 1.904804444

2 2.072017778 0.470303333 2.072017778

3 1.980881111 0.426542222 1980881111

4

Stamp FECS

® Add a processing date/time stamp. P
Format: -- dd/MM/yyyy -- !

Position: Every row v

\

Generation [kW] Grid [kW]  Solar [kW] Stamp
1 1.904804444 0.372133333 1.904804444 -- 07/06/2021 --

2 2.072017778 0.470303333 2.072017778 -- 07/06/2021 --

3 1.980881111 0.426542222 1.980881111 -- 07/06/2021 --

Add the current date and time to the top of a dataset with a comment:
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Stamp d:} &

@ Add a stamp with processing date, time and othe'
Format: d/M/yyyy HH:mm:ss -- Id/M/yyyy format!!

Position: At start

Data Warnings Info Comment Deta’
1 col x 2 rows @ 1 row ac
(8B L@ F Vi< =21 1

|

1 14/2/2022 17:58:07 -- d/M/yyyy format!!

Inputs
One.

Options

e Supply the stamp format in Format (see below).

Format Meaning

d The day as number without a leading zero (1
to 31)

dd The day as number with a leading zero (01
to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

dddd The long localized day name (e.g. 'Monday'
to 'Sunday"’). Uses the locale to localize the
name.

M The month as number without a leading

zero (1 to 12).

MM The month as number with a leading zero
(01 to 12)
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Format

MMM

Yy

YYYY

hh

HH

SS

AP or A

Meaning

The abbreviated localized month name (e.g.
'Jan' to 'Dec’). Uses the locale to localize the
name.

The long localized month name (e.g.
‘January' to 'December’). Uses the locale to
localize the name.

The year as two digit number (00 to 99).

The year as four digit number. If the year is
negative, a minus sign is prepended in
addition.

The hour without a leading zero (0 to 23 or
1to 12 if AM/PM display).

The hour with a leading zero (00 to 23 or 01
to 12 if AM/PM display).

The hour without a leading zero (0 to 23,
even with AM/PM display).

The hour with a leading zero (00 to 23, even
with AM/PM display).

The minute without a leading zero (0 to 59).
The minute with a leading zero (00 to 59).

The whole second without a leading zero (0
to 59).

The whole second with a leading zero where
applicable (00 to 59).

The fractional part of the second, to go after
a decimal point, without trailing zeroes (0 to
999). Thus "s.z" reports the seconds to full
available (millisecond) precision without
trailing zeroes.

The fractional part of the second, to
millisecond precision, including trailing.
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Format Meaning

ap or a Use am/pm display. a/ap will be replaced by
either "am" or "pm".

t The timezone (for example "CEST").

S (c) The computer name.

S (£) The path of the .transform file,

e.g. /Users/andy/Desktop/mytransfor
m.transform.

S (u) The name of the user (from the USER or
USERNAME environment variable).

Anything after the first ! (exclamation)
character won't be substituted.

¢ Select from Position whether you want the stamp row added to the start or end of the
dataset or to every row in a new column.

Notes
e If you add the stamp to Every Row you can move the column using Reorder Cols.
e The Format text is case sensitive.

See also
e Meta information
e Stack

2.3.57 Stats

Description
Calculates statistics by column and/or row in one or more selected columns.

Example
Calculate column and row averages:
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Grid [kW]  Solar [kW]
1 0.372133333 1.904804444

2 0470303333 2.072017778

3 0.426542222 1.980881111

4

R A
Stats ¢ B 21
@ Calculate sum, min, max, average, median or st...
IE' Q Filter columns

v Grid [kW]

y Solarflwl |

2 of 2 columns selected

Calculation: Average v

On: Columns and rows v

Grid [kW] Solar [kW] Average
1 0.372133333 1.904804444 1.1384688885

2 0.470303333 2.072017778 1.2711605555
3 0.426542222 1.980881111 1.2037116665

4 0.4229929627 1.985901111 1.2044470368

Inputs
One.
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Options
e Check the column(s) you wish to calculate stats for.
¢ Set Calculation to the statistic you want to calculate:
o Sum show the sum of the values.
o Minimum shows the smallest value.
o Maximum shows the largest value.
o Average shows the arithmetic mean of the values.
o Median shows the median of numeric values in the column.
o Mode shows the mode of numeric values in the column.
o Standard deviation is the sample standard deviation (equivalent to Excel function
stddev.s).
o Variance is the square of the sample standard deviation.
o Q1 is the first quartile (calculated using Method 1 here).
o Q3 is the third quartile (calculated using Method 1 here).
o IQR is the Inter Quartile Range.
o Skew is the alternative Pearson Mode Skewness (3 * (Mean — Median) / Standard
Deviation ).
o Percentile (inclusive) is an interpolated value at which the specified Percentile of values
are below or equal to this value. It is similar to the Excel PERCENTILE. INC () function.
o Percentile (exclusive) is an interpolated value at which the specified Percentile of values
are below this value. It is similar to the Excel PERCENTILE.EXC () function.
¢ Percentile is the percentile value to use in Percentile (inclusive) and Percentile
(exclusive) calculation.
e Set On depending on whether you wish to calculate the statistics for columns, rows or both.
o If On is set to Columns an extra row with the results is added to the bottom.
o If On is set to Rows an extra column with the results is added to the right.
o If On is set to Columns and rows an extra row with the results is added to the bottom
and extra column with the results is added to the right. The bottom right cell contains the
calculation across all values.

Notes

e Non-numerical and empty values are ignored.

e Mode may not work as expected with non-integer values, due to precision issues. You can
fix this by using a Num Format transform first.

e Use Num Format to change the precision of the results.

e Use Scale to convert the results to percentages.

e If you want to compute the sum, minimum, maximum or average for each distinct value in 1
or more columns you can use Unique.

See also
e Count
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e Pivot

e Summary
2.3.58 Substitute

Description
Substitute column values into text.

Example
Create an SQL statement to insert 'date’, 'cases’, 'deaths’ and ‘country’ values into 'mytable':

date cases deaths country

12020-05-03 134 4 Afghanistan
2 2020-05-03 7 0 Albania

32020-05-03 141 6 Algeria

v

Substitute ICP =] EC

® Substitute column values into text.

New column name: SQL

Substitution script:

INSERT INTO mytable (country,date,deaths,cases) VALUES (%$(country),$(date),$(deaths),$(cases));

date cases deaths country SqQL
12020-05-03 134 4 Afghanistan INSERT INTO mytable (country date,deaths,cases) VALUES (Afghanistan,2020-05-03,4,134);

2 2020-05-03 7 0 Albania INSERT INTO mytable (country,date deaths,cases) VALUES (Albania,2020-05-03,0,7);

3 2020-05-03 141 6 Algeria INSERT INTO mytable (country,date,deaths,cases) VALUES (Algeria,2020-05-03,6,141);

Inputs
One.

Options

Set New column name to the name of the new column you want to create.

Enter your substitution script into the Substitution script field.

Select a column from Insert variable to add that column variable into the Substitution
script field at the current cursor position.

Click the Evaluate button to evaluate your script over every row and show any errors (only
available if Run>Auto Run is checked).
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Notes

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

e If you want to carry out your transform across more than one dataset, you should Join them

first.
e If you need to do something more complex than this transform allows, try the Javascript
transform.

e Warnings are shown in the Warnings tab for ambiguous column references.
2.3.59 Subtract

Description
Remove rows from the top dataset with key values that are present in the lower dataset.

Example
Subtract from the top dataset all the rows with ids in the bottom dataset:

Subtract 0:'} e E Q
@ Remove rows from the top dataset whose key values are ...
Top key column: Id v
Id First Bottom key column: ID N

1 001 Alice

btract-a.csv
2 002 Bob * o>
. 2 cols x 4 rows
3 003|Charlte

4 004 Dwayne

Id First

© Subtract v g | 1 002 80b

2 cols x 2 rows
2 004 Dwayne

subtract-b.csv
1 00! el @
Zﬁ 1 colx 2 rows

Inputs

Two.
Options

e The output depends on the vertical (Y-axis) position of the inputs.
¢ Click Explore Keys... to compare key values in the 2 datasets.
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e Select Top key column for the column you want to match in the top input dataset.
¢ Select Bottom key column for the column you want to match in the bottom input dataset.
e Check case sensitive to use case sensitive matching for keys.

Notes

e This transform is sometimes called an anti-join.

e If there are 10k rows or less in both datasets, Easy Data Transform will try to guess sensible
default values for Top key column and Bottom key column based on column header
names and contents.

e If the first input has a header, this will be used for the output.

o All values are treated as text and comparisons are whitespace sensitive. You can use
Whitespace to remove whitespace before the subtract.

e All rows in the top dataset with a given key value are removed if that key value occurs 1 or
more times in the bottom dataset.

e You can use Concat Cols to join several columns together (e.g. 'first name' and 'last name'
columns) to form a key column.

e You can use Row Num to create a unique key column.

¢ Use a second Subtract transform to see what was subtracted:

Id First
subtract-a.csv )l Subtract .
() > o h 1 001 Alice
2 cols x 4 rows 2 cols x 2 rows 2 003 Charlie

o Subtract

2 cols x 2 rows

subtract-b.csv

1 colx2 rows

See also
e |ntersect

2.3.60 Summary

Description
Summarize the values in the selected columns.

Example
Create a summary, including dates and statistics:
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date cases deaths country

12020-05-03 134 4 Afghanistan

2 2020-05-03 7 0 Albania

3 2020-05-03 141 6 Algeria

y

A

Summary G EC]

@ Summarise the values of the selected columns.
E IE' Q Filter columns

v, date a

cases

v dgaths

4 of 4 columns selected

v include dates

v include statistics

Metric date cases deaths country

i1 Empty values 0 0 0 0
i 2 Non-empty values 3 3 2 3
3 Numeric values 0 3 3 0
4 Integer values 0 3 3 0
5 Date values 3 0 0 0
6 Text values 0 0 0 3

. 7 Distinct values 1 3 3 3
8 Unique values 0 3 3 3
9 Duplicated values 1 0 0 0
10 Min lenath 10 1 1 7




Reference

Inputs
One.

Options

e Select the Columns you wish to summarize.

¢ Check include dates if you wish to check for date values using supported date formats.
This can be slow for large datasets.

e Check include statistics if you wish to add the sum, average, median and standard
deviation for numeric values.

Notes

e Whether values are interpreted as number or dates depends on Supported date formats
and locale.

e Empty values is the number of values in the column that are completely empty. Values
with whitespace do not count as empty.

¢ Non-empty values is the number of values in the column that are not completely empty.
Values with whitespace do not count as empty.

¢ Numeric values is the number of numeric of values in the column that can be interpreted
as a number.

e Integer values is the number of numeric of values in the column that can be interpreted as
integers (whole numbers). "1.0" (depending on your locale), "0", "-1" and "1e3" are
considered integers.

¢ Real values is the number of numeric values in the column that can be interpreted as reals
(floating point numbers). "1.2345" (depending on your locale) and "1e-3" are considered
reals.

¢ Boolean values is the number of values in the column that can be interpreted as booleans
(true/false). "TRUE", "True" and "false" are considered booleans.

¢ Date values is the number of values in the column that can be interpreted as a date. Only
shown if check for dates is checked.

e Text values is the number of values in the column that cannot be interpreted as empty,
numeric or date.

e Distinct values is the number of different values in the column. Date and numeric values
are treated as text (e.g. '7' is treated as different to '7.0" and '1/1/2020' is treated as
different to '01/01/2020"). Comparison between values is sensitive to case and whitespace.

¢ Unique values is the number of values that only occur once in the column. Date and
numeric values are treated as text. Comparison between values is sensitive to case and
whitespace.

¢ Duplicated values is the number of values that occur more than once in the column. Date
and numeric values are treated as text. Comparison between values is sensitive to case and
whitespace.
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1A
2B

Distinct values 3 G A, B, C
3B

=y Unique values | p— A

4C

Duplicated values 2 e B, C
5C
6C

e Min length is the minimum number of characters of non-empty values in the column.
Whitespace is counted. Date and numeric values are treated as text.

¢ Max length is the maximum number of characters of values in the column. Whitespace is
counted. Date and numeric values are treated as text.

e Average length is the arithmetic mean of the number of characters of non-empty values in
the column. Whitespace is counted. Date and numeric values are treated as text.

¢ Min numeric is the minimum numeric value in the column. Non-numeric and empty values
are ignored.

e Max numeric is the maximum numeric value in the column. Non-numeric and empty
values are ignored.

¢ Range numeric is Max numeric - Min numeric.

¢ Negative numeric is the number of negative numeric values in the column. 0 is not
considered negative here.

¢ Zero numeric is the number of numeric zero values in the column.

¢ Positive numeric is the number of positive numeric values in the column. 0 is not
considered positive here.

e Sum numeric is the sum of numeric values in the column. Non-numeric and empty values
are ignored. Only shown if include statistics is checked.

¢ Average numeric is the arithmetic mean of numeric values in the column. Non-numeric
and empty values are ignored. Only shown if include statistics is checked.

¢ Median numeric is the median of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

e Mode numeric is the mode of numeric values in the column. Non-numeric and empty
values are ignored. Only shown if include statistics is checked.

e Stddev numeric is the sample standard deviation (equivalent to Excel function stddev.s) of
numeric values in the column. Non-numeric and empty values are ignored. Only shown if
include statistics is checked.

¢ Variance numeric is the square of the sample standard deviation. Only shown if include
statistics is checked.
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¢ Q1 numeric is the first quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ Q3 numeric is the third quartile (calculated using Method 1 here). Only shown if include
statistics is checked.

¢ IQR numeric is the Inter Quartile Range. Only shown if include statistics is checked.

¢ Skew numeric is the alternative Pearson Mode Skewness (3 * (Mean — Median) / Standard
Deviation ). Only shown if include statistics is checked.

¢ Min date is the minimum date value in the column. Only shown if include dates is
checked.

e Max date is the maximum date value in the column. Only shown if include dates is
checked.

¢ Most frequent lists the most common text in the column. Empty values are not counted.
Date and numeric values are treated as text. Comparison between values is sensitive to case
and whitespace.

Notes

e If your dataset is large, you might want to Sample it first.

e Use Num Format to change the precision of numerical results.

e You can use Whitespace to remove any whitespace at the start or end of values before
Summary.

e If you wish to have a row displayed per column you can Transpose the table first.

¢ Mode may not work as expected with non-integer values, due to precision issues. You can
fix this by using a Num Format transform first.

See also

2.3.61 Total

Description
Add a new column with a running (cumulative) total of the selected column.

Examples
Total the 'transaction' column:
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area transaction
1 North 100
2 South 200
3 North -50
4 South 320
5 East 200
6 East -50
Total r,‘f EG
@ Add a new column with a running (cumulative) t...
Column: transaction v
By: <None selected> v

v

area transaction Total transaction
1 North 100 100
2 South 200 300
3 North -50 250
4 South 320 570
5 East 200 770
6 East -50 720

Total the 'transaction' column separately for each 'area’ value:
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Easy Data Transform

area transaction
1 North 100
2
3 North -50
Total o dlll==: IPE¢

@ Add a new column with a running (cumulative) t...

Column: transaction

By: area

1 North
2

3 North

4
5
6

'

area transaction Total transaction

100 100
50 50

b

w
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Inputs
One.

Options

e Set Column to the column you want to total.

e Set By to a column if you want a separate running total per value in that column. Leave as
<None selected > if you only want a single running total.

Notes

e Non-numerical values are ignored.

e The By column takes account of case and whitespace in values.

e The new column is added at the right end. You can change the column order with Reorder
Cols and the column name with Rename Cols.

See also

2.3.62 Transpose

Description
Swap (rotate) rows and columns, so that each row becomes a column and each column
becomes a row.

Example
Swap rows and columns:
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Grid [kW] Solar [kW]
1 0.372133333 1.904804444

2 0.470303333 2.072017778

3 0.426542222 1.980881111

Transpose d} B Eg
@ Swap rows and columns.
has header
1 2 3 4

1 Grid [kW] 0.372133333 0.470303333 0.426542222

2 Solar [kW] 1.904804444 2.072017778 1.980881111

Inputs
One.

Options

e Check has header to make the new first row into a header.

Notes
o If the input dataset has a header, it will become the new first column. Use Remove Cols to
remove it.

2.3.63 Unfill

Description
Set adjacent cells with identical values to empty in selected columns.
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Example
Unfill down:
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Easy Data Transform

Country Area  City

1 Country 1
2 Country 1 City 2

3 Country 1 |Areal1 City3

4 Country 1 Area2 City1

5Country 1 Area2 City2

y

Unfill o dll == |93
@ Set adjacent cells with identical values to empty...
E] Q Filter columns

v Cquntry.'

Area

v

v City

3 of 3 columns selected

Direction: Down v

v

Country Area City

1 Country 1 Area1 City1

2 City 2
3 City 3
4 Area2 City 1
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Inputs
One.

Options
e Check the column(s) you wish to unfill.
¢ Select Direction depending on the direction you wish to unfill to.

See also

e Fill

e Slide
2.3.64 Unique

Description
Remove duplicate rows based on keeping only unique values in selected columns

Example

If you have a dataset of orders and you want to:

e keep one row per unique Customer Id

e keep the first listed Name for each Customer Id

e concatenate Product Ids for each Customer Id, delimited by a comma

e sum the Costs for each Customer Id

e keep the latest Date for each Customer Id

¢ add a Count column showing how many rows in the input correspond to each row in the
output
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Name Customer Id Product Id Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020

2 Bob Brown 89456 10.55 01/10/2020 |
3 Charlie Jones CO17783 96352 19.95 02/10/2020 |

4 Robert Brown

98526 10.00 02/10/2020

5 Charles Jones CO017783 38746 25.00 03/10/2020]

v

Unique {f} = E:

@ Remove duplicate rows, keeping only rows with unique values in se...

Column Option
Name Keep first b4
Customer Id Keep unique v
Product Id Concat =
Cost Sum hs
Date Maximum o
Set All ¥ to Keep unique v

'Keep unique' for 1 of 5 columns
Concat delimiter: ,

v add count column

V

Name Customer |d Productld Cost Date Count
1 Alice Anderson C018930 13574 29.95 01/10/2020 1
2 Bob Brown 89456,98526 20.55 02/10/2020 2

3 Charlie Jones CO17783 96352,38746 44.95 03/10/2020 2
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Inputs
One.

Options

e Set an Option for each column:
o Only 1 row is kept where all the Keep unique columns have the same value.
o Keep first keeps the first value in the current sort order.
o Keep first non-empty keeps the first value in the current sort order that is not empty.
o Keep last keeps the last value in the current sort order.
o Keep last non-empty keeps the last value in the current sort order that is not empty.
o Sum sums any numerical values. Empty values are ignored.
o Maximum keeps the maximum numerical or date value.
o Minimum keeps the minimum numerical or date value.
o Average takes the average (mean) of any numerical values. Empty values are ignored.
o Concat to concatenate values. Duplicate values are kept. All values are treated as text.
o Concat unique to concatenate values. Duplicate values are ignored. All values are treated

as text.

e Use the Set button to quickly set the option value for multiple columns.

¢ Set Concat delimiter if you want to add a delimiter between Concat or Concat unique
values

e Check add count column to add a column showing how many rows in the input dataset
created each unique row.

e Check drilldown to allow double-clicking a row in the data table to drilldown to the rows
that contributed to this row in the upstream data.

Notes

e Rows are considered duplicates if they have exactly the same value in all the columns set to
Keep unique. Comparisons are case and whitespace sensitive. You can use Case and
Whitespace to change case and whitespace before deduping.

e If no columns are set to Keep unique the transform won't do anything.

e If you are using Keep first, Keep last, Keep first non-empty or Keep last non-empty the
sort order is important. You can use Sort to change the sort order before this transform.

e Cells containing whitespace are not considered empty.

e The Dedupe transform is a less powerful (but simpler and faster) alternative to Unique.

¢ The opposite Unique is Split Col with Into as Rows

See also
e Dedupe a dataset
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2.3.65 Units

Description
Change units of time, length, temperature etc.

Example
Convert the 'Temperature' column from Celsius to Fahrenheit:
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Temperature
1 -20
2 0
3 20
4 40
5 60
6 80
7 100

Units { o B 23

@ Change units of time, length, temperature etc.
E IE' Q Filter columns

Temperature
v P

1 of 1 columns selected

Dimension: Temperature v
From: Celsius/Centigrade v
To: Fahrenheit v
Temperature
1 -4
2 32
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Inputs
One.

Options

e Check the column(s) you wish to transform.

¢ Set Dimension to the dimensions of the units you wish to convert.
e Set From to the units you wish to convert from.

e Set To to the units you wish to convert to.

Notes

e The locale is used to decide how the number is represented (e.g. decimal separators).

¢ Unit disambiguation:

o Years are 365.25 days.

o Calories are thermal/small/gram (not nutritional) Calories.

o Miles are International/Statute Miles.

o Nautical miles are International Nautical Miles.

o Gallons (US) are liquid gallons.

o Pints (US) are liquid pints.

Warnings are shown in the Warnings tab for non-numeric values.

Non-numerical and empty values are not changed.

Use Copy Cols to copy columns before you transform them.

Use Num Format to change the number format of the results.

Use Extract or Split Col to remove any unit symbols from the value before conversion, e.g.
to change "0.0 Kg" to "0.0".

e If you want to convert units not covered here you can do it using the Javascript transform.

2.3.66 Whitespace

Description
Tidy whitespace (spaces, tabs, carriage returns etc) in the selected column(s).

Example
Tidy tabs, carriage returns and repeated spaces:
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ClB@)<« -

Name

1 -Mr--John<Smith
2 Dr-Jane—Smith

3 Mr-Albert<-Smith--

Whitespace ff E :

® Tidy whitespace (spaces, tabs, carriage returns e...

EI Q Filter columns

Mame

v

4 b
1 of 1 columns selected

v trim leading and trailing whitespace
replace line feeds with spaces

replace tabs with spaces

replace non-standard spaces with spaces
remove carriage returns

convert consecutive spaces to one space

<< < < <<

remove non-printable characters

\

BEAZCE

MName

1 Mr-John-Smith

2 Dr-Jane-Smith
A hAe Al stk C el
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Inputs
One.

Options

e Check the column(s) you wish to transform.

e Check trim leading and trailing whitespace to remove whitespace characters, such as
space and tab.

e Check replace line feeds with spaces to replace LF (\n) characters with spaces.

e Check replace tabs with spaces to replace tab (\t) characters with spaces.

e Check replace non-standard spaces with spaces to replace non-standard spaces (such as
non-breaking space, thin space etc) with spaces.

e Check remove carriage returns to remove CR (\r) characters.

e Check convert consecutive spaces to one space to replace 2 or more consecutive spaces
with a single space.

¢ Check remove non-printable characters to remove characters of Unicode type Other_*.
This include ASCII codes 0 to 31, such as tab, line feed, carriage return, bell and backspace.
It does not remove spaces.

Notes

e The operations are carried out in top to bottom order, e.g. Replace line feeds with spaces
is carried out before Convert consecutive spaces to one space.

e Click the eye icon in the Right pane to show whitespace in the data.

EEEN warnings | @ Info | cComment | Details

2 cols x 3 rows & Rei

B BB | Z|®|F |V
A

EPress to show whitespace in the dataset as symbols:

Space:
1 d Tak: >
Carriage return: “
2 12 Line feed: !
Mon-breaking space: _
3 -3

Other whitespace: O

See also
e Case

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

2.4 Output
24.1 Outputdata

Once you have finished transforming your data you can output it in the following formats:
e CSV

o Excel

e JSON

e HTML

e Markdown
e Plain text
e TSV

e vCard

o XML

e YAML

To create an output, select 1 input and/or transform item in the Center pane and then click
the To File button at the bottom of the Left pane. You can choose the file type in the file type
drop-down list of the Output window.

You can select the output item in the Center pane and change any options related to the
output in the Right pane.

output.csv & B 57
(@) Output to file.
Qutput to:  Single file 9

File: [Users/andyb/Desktop/output.csv

Type: Delimited text

Delimiter: Comma (,) (]

Quoting: As needed (%]

Line endings: Automatic (%]

Encoding: UTF-8 (5]
Byte Order Mark

Write mode:  Overwrite

write header

Alias: outputl
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Set Output to depending on whether you want to output the dataset to a single file or
multiple files.

Set File to the location of the file you want to output (only available when Output to set to
Single file). The location can use file name variables to dynamically change output file names
based on input file names.

Set Files column to the column containing the location of the files you want to output to

(only available when Output to set to Multiple files).

e This column is not output.

e The location can be an absolute location (e.g. /Users/andy/output.csv) or a location
relative to the .transform file location (e.g. results/output.csv).

¢ The location can use file name variables to dynamically change output file names based on
input file names.

e Folders output to must already exist.

e Empty or invalid locations (e.g. file names with illegal characters) are ignored.

¢ Check Confirm files if you want to manually confirm before writing to output files (ignored
for command line processing).

If you are writing to an Excel file the output will be written to a sheet called 'Easy Data
Transform' by default. You can change this by adding the sheet name inside [], e.g.
myfile.xlsx [mysheet].

Set Type to the file type. The default type will be set according to the file extension and the
settings in the Output Extensions tab of the Preferences window.

Set Value types depending on how you want to set JSON types (only available for JSON
files).
¢ Automatic to let Easy Data Transform decide the JSON type depending on the contents of
each column.
e String to set the JSON type for all columns to String
e Manual to choose the JSON type of each column as:
o Automatic (based on column contents).
o Boolean.
o Number.
o String.
If you output a column as Boolean or Number any values not of that type will be output as
null.

Set Delimiter to the delimiter you wish to use (only available for delimited text files, such as
CSV and TSV).
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Set Quoting depending how you want to use quoting in the output (only available for

delimited text files, such as CSV and TSV).

¢ As needed to add quotes (") around values that contain the delimiter character, quote
characters or carriage returns.

e Always to add " quotes around every value.

e Never to never add " quotes around values (delimiters and carriage returns with values are
replaced with spaces).

Set Line endings to the control characters you wish to use to denote line endings (only

available for text files).

¢ Automatic to choose the standard line ending for the current operating system.

e Windows (CRLF) to choose the standard Windows line ending, carriage return+line feed
(\r\n).

e Mac\Unix (LF) to choose the standard macOS/Unix line ending, line feed (\n).

¢ Old Mac (CR) to choose the standard classic (pre mac OS X) Mac line ending, carriage
return (\n).

Set Encoding to the text encoding you wish to use (only available for text files).

Set Formatting depending on how you want to set the Excel cell formatting (only available
for Excel files).
e Automatic to let Easy Data Transform decide cell formatting depending on the contents of
each column.
¢ General to set the cell format for all columns to ‘General'.
e Manual to choose the cell format of each column as:
o Automatic (based on column contents).
o Boolean (expects true or false, not case sensitive)
o Date (expects a date format in Preferences).
o General.
o Number (expects a real or integer number, e.g. 123 or 123.456)
o Text.
o Formula (expects starting with =).
o Time (expects hh:mm:ss or hh:mm, €.g. 13:59:01 or 13:59).
o Hyperlink (expects a hyperlink, e.g. https://www.easydatatransform.com).

Set Byte Order Mark checked to write a Unicode Byte Order Mark to the file (only available
for UTF encodings and ignored when appending to an existing file).

Set Escape special characters checked to escape HTML special characters (for example <
and >) so they are rendered correctly in the HTML (only available for HTML files). Uncheck it
to write 'raw' HTML. Note that you can also set Change to To escaped HTML to escape
selected columns in the Decode transform.
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Check remove empty to recursively remove any nodes that have an empty value and no
children (only available for JSON and XML files). For example:

A AB ABC
1
2 1
o 1

Is output to XML with remove empty checked as:

<root>
<record>
<A>
<B>1</B>
</A>
</record>
<record>
<A>
<B>
<C>1</C>
</B>
</A>
</record>
</root>

Is output to XML with remove empty unchecked as:

<root>
<record>
<A>
<B>
<C></C>
</B>
</BD>
</record>
<record>
<A>
<B value="1">
<C></C>
</B>
</BD>
</record>
<record>
<A>
<B>
<C>1</C>
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</B>
</A>
</record>
</root>

For XML output you can set Root name, Below root and Row name depending on the name
you want to use for the root and row records and any extra information you want to add
below the root.

<?xml version="1.0" encoding="UTF-8"2>
<!-- File created 2023 09 27

- 17 23 38 226
<Bbove>Abovelk/Above>
<Above>Abovelk/Above>

<Above>Above1</Above>
<Above>Abovel</Above>

Above root:

Root name:  root

<root>
Below root: <Below>Below1</Below> A <Below>Belgwl</Below>
<Below>Below2 </Below> v <Below>Belgw2</Below>
Ro ) d ' <record>
W name:  recor cus1</us
Write mode:  Overwrite v </record>
<re
File comment: File created {date} {time} >2<,/v>
</record>
</root>

Use Write mode to determine how existing files are treated:

Werite mode for
Excel files

Overwrite / File

Overwrite / Sheet

Append

New

Disabled

File exists with
named sheet

Overwrite named
sheet, delete all
other sheets

Overwrite named
sheet*

Append to named
sheet

Do nothing

Do nothing

File exists without
named sheet

Add named sheet,
delete all other
sheets

Add named sheet
Add named sheet

Do nothing

Do nothing

File does not exist

Create file with only
named sheet

Create file with only
named sheet

Create file with only
named sheet

Create file with only
named sheet

Do nothing

*Overwriting a named sheet is slower than creating a new file and can cause the file size to
increase each time (due to string indexing by Excel). If this becomes a problem, you can
delete the file and re-output it. Because of this you should use Overwrite / File if the file will
only have 1 sheet.
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Write mode for non-Excel File exists File does not exist
files

Overwrite Overwrite file Create file
Append Append to file Create file

New Do nothing Create file
Disabled Do nothing Do nothing

Check write header to write the header (only available for Excel, Delimited text, HTML and
Markdown files). If Write mode is Append you can check if empty to only write the header
if the file (sheet for Excel files) is currently empty or does not exist (and not for subsequent
appends).

Set File comment to any comment you wish to output to the file (only available for HTML,
Markdown, XML and YAML files). This can include file name variables such as {date}. Leave

it empty to output no comment.

Use Alias to identify the file for batch processing.

2.5 File formats
2.5.1 File formats

Easy Data Transform supports the following data file formats:

Format Input Output
Delimited text (including CSV  Yes Yes
and TSV)

Excel XLSX/XLS Yes Yes
Fixed width Yes No
JSON Yes Yes
HTML No Yes
Markdown No Yes
Plain text Yes Yes
vCard Yes Yes

Easy Data Transform © 2023 Oryx Digital Ltd



Reference

Format Input Output
XML Yes Yes
YAML No Yes

You can manage the default file type for different file extensions in the Input Extensions and
Output Extensions tabs of the Preferences window.

2.5.2 CSV format

Easy Data Transform can input from and output to CSV format files. Default file extension

.CSv.

CSV (Comma Separated Value) format is commonly used for exchanging tabular data
between programs.

CSV is a type of delimited text file format. The column delimiter is usually a comma, but not
always. The row delimiter is line feed, carriage return or carriage return+line feed.

Easy Data Transform supports the following column delimiters:
e Comma (,)

e Semi-colon ()

e Colon (?)

* Pipe ())

e Caret ()

e Tab (\t) (used for TSV format)

e Space ()

e Custom (choose your own)

For files padded to fixed column widths with space see Fixed width format. For file with no
column delimiters see Plain text format.

To output to a CSV file you should typically set Delimiter to Comma (,) and Quoting to As
needed in the Right pane.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output with Delimiter set to Comma (,) and Quoting set to As needed as:

CategoryID, CategoryName, Description, In stock
1,Beverages, "Soft drinks, coffees & teas",true
2,Condiments, Sweet and savory sauces, false
3,Confections,Candies and sweet breads, true

Note that " quotes have been used to enclose values that contain delimiter characters.

Check ignore repeated delimiters if you want to treat 2 or more consecutive delimiters as a
single delimiter. For example, this might be useful if values are separated by a variable
number of spaces:

Area Q1 Q2 Q3 Q4
North 34.4 928.3 83.1 98.3
East 42.1 234.9 88.4 4.1

South  784.4 39.0 55.3 99.1
West 437.4 83.1 078.4 11.3

Type: Delimited text Type: Delimited text
Delimiter: Space () Delimiter: Space ()
V' ignore repeated delimiters ignore repeated delimiters

Area Q1 Qz Q3 Q4 Area Q1 Q2 Q3 Q4 6 7 8 9
1 North 344 9283 831 983 1 North 344 9283 831 983
2 East 421 2349 884 41 2 East 421 2349 884 41
3 South 7844 390 553 99.1 3 South 7844 390 553 991
4 West 4374 831 0784 113 4 West 4374 831 0784 13

Set Quoting to Always if you want to quote every value. Set Quoting to Never if you don't
want to quote values (delimiters, line feeds and carriage returns within values will be changed
to spaces, unless the delimiter is space in which case they will be changed to underscore).
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You will be warned when inputting a CSV format file that has a different number of values per
row. This may be a sign that there are problems with the data (e.g. incorrect quoting).

Data Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

You can also input a file as plain text and split it using delimiters yourself:
1. Input it with a delimiter unlikely to be in the text, e.g. caret (*), to input it as a single

column
2. Use the Split Col transform to transform it into multiple columns using the appropriate
delimiter.

Many CSV file are not well formed. For example, they have unescaped quotes. As the CSV
format is not well-defined, badly formed CSV files can be interpreted in more than one way.
Easy Data Transform will do the best it can in these circumstances.

See also:

e Video: How to convert CSV to JSON

¢ Video: How to convert CSV to Markdown

e Video: How to convert CSV to tab delimited

¢ Video: How to convert CSV to vCard

e Video: How to convert CSV to XML

e Video: How to convert Excel to pipe delimited
e Video: How to convert fixed column width to CSV or Excel
e Video: How to convert JSON to CSV

e Video: How to convert tab delimited to CSV

¢ Video: How to convert XML to CSV

e Video: How to split CSV into multiple files

e Video: How to change CSV file text encoding
e TSV format

2.5.3 Excel format

Easy Data Transform can input from and output to Excel ".xIsx" and ".xIs" format files, even if
you don't have Excel installed.

Excel format is the native format of the Microsoft Excel spreadsheet application. It is
commonly used for exchanging tabular data.
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You can specify the sheet name when inputting or outputting Excel files using square

brackets, for example:

e MySpreadsheet.xlsx[Sheet1] means the sheet named Sheet1 of file
MySpreadsheet.x1sx (the sheet name is not case sensitive).

e MySpreadsheet.xlsx[1] means sheet named 1 of file MySpreadsheet .x1lsx (if it
exists) or else the first sheet.

e MySpreadsheet.x1sx means the first sheet of file MySpreadsheet.x1sx.

Hyperlinks are read in from Excel in the form anchor |hyperlink.

You can specify how to format columns when outputting to Excel using the Formatting
option.

Please note the following limitations of Excel:

e Excel .xlsx files are limited to 1,048,576 rows and 16,384 columns.

e Excel .xls files are limited to 65,536 rows and 256 columns.

e Date values are input using ISO date format yyyy-MM-dd, regardless of your locale.

e Datetime values are input using ISO date format yyyy-MM-ddThh:mm:ss, regardless of
your locale.

e The following characters are not allowed in sheet names: \ / * [ ] : ?

e Writing an Excel file is significantly slower than writing a CSV file for the same dataset.

Note that reading an writing Excel files is at least an order of magnitude slower than reading
and writing delimited text files, such as CSV or TSV.

See also:

¢ Video: How to combine columns in Excel

e Video: How to convert Excel to JSON

¢ Video: How to convert Excel to Markdown

¢ Video: How to convert Excel to pipe delimited
¢ Video: How to convert Excel to XML

e Video: How to convert Excel to YAML

¢ Video: How to convert fixed column width to CSV or Excel
e Video: How to join Excel files

¢ Video: How to convert JSON to Excel

e Video: How to convert XML to Excel

e Video: How to remove Excel duplicates

e Video: How to split a column in Excel

2.5.4 Fixed width format

Easy Data Transform can input from fixed width format files, also known as fixed column width
format. Default file extension ".txt".
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Fixed width format is used for exchanging tabular data between programs. It is often
associated with legacy systems, but is also used for large files where performance is an issue
(e.g. bioinformatics).

In fixed width format each column has a fixed width in characters. There is no column
delimiter. Spaces are typically used as padding to make up the column width. The row
delimiter is line feed, carriage return or carriage return+line feed. For example:

ID Name Payment Country Date
8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 US 08/20/2020
7489 Zadie Green 34567.89 DE 08/20/2020
Is input as:

| ID  Name Payment Country Date

18904 John Black 1234567 GB 08/20/2020

2 3999 Jane Brown 23456.78 US 08/20/2020

'3 7489 Zadie Green 34567.89 DE 08/20/2020

Easy Data Transform will analyze the data and guess the column layout if you set Columns in
the Right pane to Automatic. Or you can choose the column widths by setting Columns to
Manual. Click the "..." button to edit the manual column widths.
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fixed-example.txt @ | 52
File: /Usersfandyb/Dropbox/fixed-example.txt
] - P
{Mns Manual E___/
® @ Fixed Column Widths
Width Starts at Ends at
Column1 |& | (3]
Column 2 13 -~ 7 19
Column3 10 o220 29
Columnd4 9 - 30 38
Column5 10 - 39 48
T
Merge Split Insert Left Insert Right Delete Columns: 5
Preview
DOO0000001111111111222222222233335333333444444444
12345678901 2345678901 2345678901 23456789012345678
ID MName Payment Country Date
8904 John Black 12345.67 GB 08/20/2020
3999 Jane Brown 23456.78 Us 08/20/2020 -
7489 Zadie Green 34567.89 DE 08/20/2020

Help Cancel “
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The current column boundaries are shown on the first few rows in the Preview. The
horizontal offset of each character is shown in gray at the top. The currently selected columns
are highlighted. Click on a column in the Preview to select it in the table, or vice versa.

You can change the column widths using the Width column of the table.

Select 2 or more adjacent columns and click Merge to merge them into 1 column. Click then
Shift+click in either the table or the preview to select multiple adjacent columns.

Select 1 column with a Width > 1 and click Split to split into 2 columns.

Select 1 or more adjacent columns and click Insert Left or Insert Right to add a new column
with width 1 to the left or right of the selected columns.

Select 1 or more adjacent columns and click Delete delete the selected columns.
Click OK to save your changes and Cancel to discard them.

Unwanted columns and rows in the dataset can be removed after input using the Remove
Cols and Filter transforms.

See also:
e Video: How to convert fixed column width to CSV or Excel

2.5.5 JSON format

Easy Data Transform can input from and output to JSON format files. Default file extension
"json".

JSON (Javascript Object Notation) format is commonly used for exchanging data between
programs. JSON data is generally expected to be in UTF8 encoding without a Byte Order

Mark (BOM).
For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:
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"CategoryID": 1,
"CategoryName": "Beverages",
"Description": "Soft drinks,
"In stock": true

coffees & teas",

"CategoryID": 2,

"CategoryName": "Condiments",
"Description": "Sweet and savory sauces",
"In stock": false

"CategoryID": 3,

"CategoryName": "Confections",
"Description": "Candies and sweet breads",
"In stock": true

The dot ('.") character is used in the column header to show nesting. For example:

name

1 Avocado Dip 2 5 0 0 0 1 210 0

Is equivalent to:

"name": "Avocado Dip",
"carb": 2,
"cholesterol": 5,
"fiber": 0O,
"minerals": {

"ca": O,

"fe": O

y

"protein": 1,

"sodium": 210,
"vitamins": {
"a": O,
"C": O
}

Any dots in JSON names are converted to hyphens ('-') on input.

carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

0
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JSON arrays can be input in either long or wide Format. For example:

[

"name": "1",

"Values": [ "a", "b" :|
by
{

"name": "2",

"Values" B [ "C", "d" :|

Input as Long (more rows):

name values
11 a
21 b
32 C
142 d

|
Input as Wide (more columns):

name values.0 values.1

11 a b

22 C d

If children of the top level object are named, then they are flattened slightly different to avoid
creating thousands or millions of columns. For example:

{

"record 1":{
"value": 1

|

"record 2":{
"value": 2

|

"record 3":{
"value": 3

}
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Is flattened into:

_ObjectName_ value
1 record 1 1
2 record 2 2
3 record 3 3

An input JSON format file is expected to have either:

¢ asingle top-level array or object; or

e asingle JSON object on each line (see jsonlines.org).

e a record separator character followed by a single JSON object on each line (see REC7464).

You can specify the JSON type for each columns when outputting to JSON using the Value
types option. The Raw data type is output without quotes or escaping and can be useful for
data that is already valid JSON. Any values that do not match the type selected are output as
a JSON null value.

See also:

e Video: How to convert CSV to JSON
¢ Video: How to convert Excel to JSON
e Video: How to convert JSON to CSV
¢ Video: How to convert JSON to Excel

2.5.6 HTML format

Easy Data Transform can output to tables in HTML format files. Default file extension ".html".
HTML (HyperText Markup Language) format is commonly used for creating web pages. If
you don't need the data to take up a whole page, you can just copy the <table> to

</table> part of the output.

For example:
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| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is output as:

<!DOCTYPE html>
<html>
<head>
<meta charset="UTF-8"/>
<title>C:\Users\andyb\Desktop\output.html</title>
<style>table, td, th{border:1px solid black;text-
align:left;vertical-align:top;border-spacing:0px;border-
color:gray; font-family:Verdana, sans-serif; }th{background-
color:#EOEOEQ; }td, th{padding:5px; }</style>
</head>
<body>
<table>
<tbody>
<tr>
<th>CategoryID</th>
<th>CategoryName</th>
<th>Description</th>
<th>In stock</th>
</tr>
<tr>
<td>1</td>
<td>Beverages</td>
<td>Soft drinks, coffees &amp; teas</td>
<td>true</td>
</tr>
<tr>
<td>2</td>
<td>Condiments</td>
<td>Sweet and savory sauces</td>
<td>false</td>
</tr>
<tr>
<td>3</td>
<td>Confections</td>
<td>Candies and sweet breads</td>
<td>true</td>
</tr>
</tbody>
</table>
</body>
</html>
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Usually you will want to 'escape’ special HTML characters in dataset values when output to
HTML format. For example to convert < to &1t;, so it can be correctly displayed in the
HTML. However, if you wish to write 'raw' HTML, then you can uncheck Escape special
characters in the Right pane. Note that you can also set Change to To escaped HTML to
escape selected columns in the Decode transform.

25.7 Markdown format
Easy Data Transform can output to tables in Markdown format files. Default file extension

".md".

Markdown format is commonly used as a human-friendly markup language, which can be
automatically translated to HTML.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
i 33 Confections Candies and sweet breads true
Is output as:
| CategoryID | CategoryName | Description | In stock
: ———————————— | === | === e e e | ===
I
|1 | Beverages | Soft drinks, coffees & teas | true
: 2 | Condiments | Sweet and savory sauces | false
: 3 | Confections | Candies and sweet breads | true
I

You can also use Markdown when you need a plain text version of your data, for example in a
code comment.

Note that not all Markdown implementations support tables. If your implementation does not
support tables, you may need to output to HTML instead.

See also:
e Video: How to convert CSV to Markdown
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e Video: How to convert Excel to Markdown
2.5.8 Plain text format

Easy Data Transform can input from and output to plain text format files. Default file extension
is ".log" for input and ".log" or ".txt" for output.

Plain text format is used for semi-structured data, such as computer generated log files.

When inputting plain text the dataset is read into a single column. The row delimiter is line
feed, carriage return or carriage return+line feed.

For example:

03/22 08:51:01 INFO :..settcpimage: Associate with TCP/IP image name = TCPCS
03/22 08:51:02 INFO :..reg process: registering process with the system
03/22 08:51:02 INFO :..reg process: attempt 0S/390 registration

03/22 08:51:02 INFO :..reg_process: return from registration rc=0

Is input in plain text format as:
1
1.03/22 08:51:01 INFO :.settcpimage: Associate with TCP/IP image name = TCPCS
2 03/22 08:51:02 INFO :.reg_process: registering process with the system
303/22 08:51:02 INFO :.reg_process: attempt OS5/390 registration

4 03/22 08:51:02 INFO :.reg_process: return from registration rc=0

When outputting plain text:

e Each row ends with a line feed, carriage return or carriage return+line feed, as selected by
the user.

e Typically plain text datasets only have 1 column. But if there is more than one column, the
column values will be concatenated without a delimiter. If you want a delimiter use Concat
Cols and Remove Cols to create a single column that contains the appropriate delimiters, or
output as delimited text.

e Values are not escaped.

2.5.9 TSV format

Easy Data Transform can input from and output to TSV format files. Default file extension

Asv
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TSV (Tab Separated Value) format is commonly used for exchanging tabular data between
programs.

TSV is a type of delimited text file format where values are separated by tab characters and
rows by line feed, carriage return or carriage return+line feed. Tabs and carriage return are
not allowed within data values, so there is no need for quoting or escaping delimiters, as with
CSV files. This means that TSV files are generally a bit more compact and faster to read and
write than CSV files.

To input a TSV file you should set Type to Delimited text and Delimiter to Tab (\t) in the
Right pane. You will usually also want to uncheck ignore repeated delimiters and set
Quoting to Automatic (which is the same as Unquoted for tab delimiters).

You will be warned when inputting a TSV format file that has a different number of values per
row. This may be a sign that there are problems with the data.

Data ! 'Warnings Info Comme.

Number of values per row vary:
1 input row has 2 values: E.g. input row 3
5 input rows have 3 values: E.g. input row 1

To output a TSV file you should set Delimiter to Tab (\t). You will usually also want to set
Quoting to Never in the Right pane. If you have a tab character or carriage return within a
value, then Easy Data Transform will then convert it to a space on output.

For example:
| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true

Is output with Delimiter set to Tab (\t) and Quoting set to Never as:
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CategoryID CategoryName Description In stock
1 Beverages Soft drinks, coffees & teas Lrue
2 Condiments Sweet and savory sauces false

3 Confections Candlies and sweet breads true

See also:
e Video: How to convert tab delimited to CSV
e Video: How to convert CSV to tab delimited

2.5.10 vCard format

Easy Data Transform can input from and output to vCard format files. Default file extension
"vcf.

VCard format is commonly used as way of exchanging contact details between programs.
Note that you need to change the column header names to the values expected by vCard

(using the Rename Cols transform). For example vCard expects the full name column to be
named FN.

Choose an appropriate text encoding. You should probably uncheck Byte Order Mark if you
are encoding in a UTF format, such as UTF-8.

For example:
N FN ORG TELTYPE=WORK\VOICE ADR;TYPE=WORK,PREF
1 Gump;Forrest;;Mr.; Forrest Gump Bubba Gump Shrimp Co. (111) 555-1212 100 Waters Edge;Baytown;

Is equivalent to:

BEGIN:VCARD

VERSION:3.0

N:Gump; Forrest;;Mr.;

FN:Forrest Gump

ORG:Bubba Gump Shrimp Co.

TEL; TYPE=WORK,VOICE: (111) 555-1212

ADR; TYPE=WORK, PREF:100 Waters Edge;Baytown;LA;30314;United States of
America

END:VCARD

See also:
e Video: How to convert CSV to vCard
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2.5.11 XML format

Easy Data Transform can input from and output to XML format files. Default file extension
" xml".

XML (Extensible Markup Language) format is commonly used for exchanging data between
programs.

For example:

| CategorylD CategoryName Description In stock
11 Beverages Soft drinks, coffees & teas true
:2 2 Condiments Sweet and savory sauces false
i 33 Confections Candies and sweet breads true

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<CategoryID>1</CategoryID>
<CategoryName>Beverages</CategoryName>
<Description>Soft drinks, coffees &amp; teas</Description>
<In-stock>true</In-stock>
</record>
<record>
<CategoryID>2</CategoryID>
<CategoryName>Condiments</CategoryName>
<Description>Sweet and savory sauces</Description>
<In-stock>false</In-stock>
</record>
<record>
<CategoryID>3</CategoryID>
<CategoryName>Confections</CategoryName>
<Description>Candies and sweet breads</Description>
<In-stock>true</In-stock>
</record>
</root>

The dot ('.") character is used in the column header to show nesting. For example:

name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0
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Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
</root>

Note that the columns may be input in a different order to the nodes in the XML. You can use

Reorder Cols or Stack transforms to change the ordering. But note that during XML output
nodes with no children are always ordered before nodes with children, regardless of the

column order.
Any dots in XML element names are converted to hyphens ('-') on input.

The underscore ('_") character is used at the start of a column header name to identify it as an
XML attribute. For example:

_name _carb _cholesterol _fiber minerals.ca minerals.fe _protein _sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is equivalent to:

<?xml version="1.0" encoding="UTF-8"?>
<root>
<record carb="2" cholesterol="5" fiber="0" name="Avocado Dip"
protein="1" sodium="210">
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
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</record>
</root>

Repeated XML values can be input in either long or wide Format. For example:

<?xml version="1.0" encoding="UTF-8"?>
<ITEMS>
<ITEM>
<PARAM name="a" value="1"/>
<PARAM name="Db" value="2"/>
</ITEM>
</ITEMS>

Input as Long (more rows):
PARAM. name PARAM. value

1b 2

2a 1

Input as Wide (more columns):

PARAM._ _value PARAM._name PARAM._value.l PARAM._name.l
11 a 2 b

You can set the names for the root and record tags and add extra XML below the root:

<?xml version="1.0" encoding="UTF-8"72>

<!-— File created 2023 09 27
Above root:  <Above>Above1</Above> = 17 23 38 226 >
<Above>Above1l </Above> <Above>Abovelfk/Above>
<Above>Abovelk /Above>
Root name:  root <root>
Below root: <Below>Below1</Below> A <Below>Belgwl</Below>
<Below>Below?2 </Below> v <Below>Belaw2</Below>

<record>

Row name:  record

Write mode:  Overwrite

File comment: File created {date} {time} SVo2</v>

</record>
</root>

Use "' if you need nested tags:
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<?xml version="1.0" encoding="UTF-8"72>
<!-- File created 2023 09 27

17 31 09 740 —->

<Above>Abovel</Above>

Above root: <Above>Abovel</Above> = <Above>Abovel</Above>
<Above>Abovel</Above> .-—-—v_' ap <rootl>
Root name:  root1.root2 ‘:3910‘“)3910";(;3@10"":’
E!HF‘ <Below>Below2</Below>
Below root: <Below>Below1</Below> - \'.%root2>
<Below>Below2 </Below> v <record>
Row name:  record /<v>1<év>
</ record>
Write mode:  Qverwrite v | <record>
File comment: File created {date} {time} / <v>2</v>
</record>
</root2>

</rootl>

Exclamation marks at the start of column names are removed from name tags when output to
XML. This can be useful when you want duplicate tag names with the same parent.

<root>
<family>
<name>Smith</name>
<member:>
- <name>John Smith</name>
1Smith John Smith Jane Smith Bob Smith <name>Jane Smith</name>
<name>Bob Smith</name>
</member>
</family>
</root>

name member.name member.name member . name

<root>
<family>
<name>8Smith</name>
<member>
<name>John Smith</name>
</member>

<member>
. . B ; =>d. Smith</
1 Smith John Smith Jane Smith Bob Smith <name>Jane Smi name>
</member>

<member>
<name>Bob Smith</name>
</member>
</family>
</root>

name member.name [[nember.name [ member.name

You are responsible for ensuring that the names of XML nodes and attributes are valid (e.g.
start with a letter or underscore and do not contain spaces).

If you need really fine grained control over the XML output, you can:
e output the XML to a file

e read the file back in as plain text

e apply transforms

e write it back out as plain text
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output.xml o e |
@ Output to file. |
Output to:  Single file -
File: C:\Users\andy\Desktop\output.xml

Type: Plain text v |

See also:

e Video: How to convert CSV to XML

¢ Video: How to convert Excel to XML

e Video: How to convert XML to CSV

¢ Video: How to convert XML to Excel

e Video: How to convert CAMT 053 XML to Excel or CSV

2.5.12 YAML format

Easy Data Transform can output to YAML format files. Default file extension ".yaml".

YAML (YAML Ain't Markup Language) format is commonly used for exchanging data between
programs and for configuration files.

For example:
| CategorylD CategoryMame Description In stock
11 Beverages Soft drinks, coffees & teas true
122 Condiments Sweet and savory sauces false
|
|
| 33 Confections Candies and sweet breads true
Is output as:

CategoryID: 1

CategoryName: Beverages

Description: Soft drinks, coffees & teas
In stock: true

CategoryID: 2
CategoryName: Condiments

Easy Data Transform © 2023 Oryx Digital Ltd


https://www.screencast.com/t/pmSNo1wHAb8
https://www.screencast.com/t/8E3e9Nlusbqm
https://www.screencast.com/t/UbsTeFU0DNG
https://www.screencast.com/t/mvX4Xf54agop
https://www.screencast.com/t/NkGatwIwnE4u

Reference

Description: Sweet and savory sauces
In stock: false

CategoryID: 3

CategoryName: Confections
Description: Candies and sweet breads
In stock: true

See also:
e Video: How to convert Excel to YAML

2.6 Processing

You can run processing of your data in one of two modes:
¢ Automatic mode: Processing is run automatically as soon as you have stopped making
changes for the amount of time specified in the Preferences window.

DE:%.ED

e Manual mode: You control when processing is run.

@ e
0O 8 & & é Bl > k) O

You can switch between modes by toggling Run>Auto Run, or the equivalent tool bar
button.

Typically automatic mode is better for small to medium datasets, but manual mode may be a
better choice for large datasets.

There are 3 options for running processing in manual mode:

¢ Run>Run Unprocessed: Run processing on any items that are not already processed.

¢ Run>Run Selected: Run processing on one or more selected items, even if they are
already processed. Any upstream or downstream items are also processed.

¢ Run>Run All: Run processing on all items, even if they are already processed. This is
provided for completeness, but you should usually use one of the above 2 options, for
efficiency.
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@ EasyDataTransform File Edit H[j‘g:l View Licensing

. & Auto Run
D 5 h B > [ O Run Unprocessed #
™ Input Run Selected I
From File @ BURAI

From Clipboard @

You can also click the Run button in the Right pane, which is equivalent to Run>Run
Selected. Note that Run, for a clipboard input, applies the options to data previously
imported. If you want to re-import from the clipboard in automatic mode, then you have to
click the Import from clipboard button.

Check View>Timing Profile to see where the processing time is being spent. The length of
the colored bar is proportional to the fraction of total processing spent processing that item.

|

10k.csv
[/}
14 cols x 10k rows
= ] - ] I ] =
Stack ® Filter o Sort " output.csv
14 cols x 110k rows 14 cols x 81,5k rows 14 cols x 81,5k rows 14 cols x 81,5k mows
[
100k.csv
[/}

14 cols x 100k rows

You can stop processing with Run>Stop Run, or the equivalent tool bar button. If you stop
processing in automatic mode it will switch to manual mode.

When an item is processed, all it's upstream items will be processed first. You can only change

the options for an item in the Right pane if all it's upstream inputs and transforms are
processed.

2.7 Comments

You can manage the complexity of large .transform files adding comment text to:

e The Comment field of Note items. These are added to the Center pane by right clicking
and selecting Note from the menu. You can also set an Arrow direction and a Color. If you
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right click on an existing item, the Note item will be placed pointing to that item, if there is
space. The comment will be shown as a tooltip when you hover over the Note item.

Deaths by
date

Spread

v

Latest V.,-L(:U[",\',',’[',_';’.'_',;:; /Remove Cols , Pivot , Sort , Count , Sort Death
COVID data S 310 e P 3 w139 s e e frequencies

, Dedupe NN Join |  PReplace b

6 , Filter /Num Format _/outpu t.xlsx) Deaths by
| | } | Trop—

PR P PR country

Scale to per
10k

& enin = 200 rws

| output.xlsx

_nJ
! 6 ols % 155 rows

Select items in the center pane
to view

e The Comment tab of Input, Transform or Output items. Check View>Show Comments to
show these comments in the Center pane. The comment will be shown as a tooltip when
you hover over the item.
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Data  Warnings Info  Comment*

Sum total COVID cases.

Stats

Sum total COVID cases.
11 cols x 4.?k rows

Name: Stats

Size: 11 cols x 14.7k 3
Transform type: Analysis

Result: Sum row a

Comment: Sum total COVID cases.

I

¢ In the Notes window that is displayed when you select File>Notes... from the main menu.

You can also visually group related items in the Center pane to show that they are related.

2.8 Headers

If the first row of an input is a header (i.e. one that describes the columns below) check has
header for that input in the Right pane.
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vaccination.csv @ ﬁ‘? o

File: [Usersfandyb/Desktop/vaccination.csv

Type: Delimited text e
Delimiter: Automatic &
Quoting: Automatic *
Encoding: Automatic *
Ignore: First 0 row(s) =
+ has header
espace
' simplify whitespace
+ ignore empty rows
watch file
Meta info: Mot added L4

Alias: vaccination
Data Warnings Info Comment Results

3 cols x 5,780 rows

C I:% L@ Show first 10 rows <

country time | becg_wvacc

When you first read in a dataset Easy Data Transform will make a guess about whether the
first row is a header (it will assume it is a header if it contains no dates or numbers).

You can move 1 or more dataset rows to the header using the Header transform.
2.9 Connections

When you select an input or transform item and add a transform or output item, connections
are added automatically.

To select a connection

To select a connection either:

e Click on the connection; or

e Click and drag a box over any part of the connection. This may be easier than clicking the
connection when you are zoomed back.
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transactions.x... | Filter
—/

35 cols x 53.3k rows b 35 cols x 53.3k rows

To delete a connection

To delete a connection:

e Select the connection.

e Select Edit>Delete (or click the Delete tool bar button).

Note that deleting a connection may unset column related parameters downstream, so

should generally be avoided where possible.

e If you want to change an input file, do it by selecting the input and clicking on "..." in the
Right pane, rather than disconnecting the input and connecting a new one.

e If you want to add a new transform between 2 already connected items, you can do it
without disconnecting (see below).

To add a transform to a connection

To add a transform between two already connected items:

e Select the connection.

e Choose the new transform from the Left pane or using the right click menu.

customers-2023.csv [:} Rename Cols
——

14 cols x 10k rows 14 cols x 10k rows

Salect a connectien

customers-2022.csv

14 cols x 10k rows
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To add a connection
To add a new connection between two existing items:
e Hover over the start item.
e Click the '+' that appears.

Filter

transactions.x...

%)

lick to connect from this item.

35 cols x 53.3k rows

e Hover over the end item
e Click the '+' that appears.

Filter

transactions.x...

35 cols x 53.3k rows lick to connect to this item.

Press the 'Esc’ key or click away from an item to cancel adding the connection.

Note that the '+' will only appear if an additional connection is allowed. For example you
can't:

e Create a loop.

e Connect more than once from a transform.

¢ Connect more than once to an output.

2.10 Text

Whitespace (such as Space and Tab characters) and case are always significant, unless stated
otherwise.

You can remove leading and trailing whitespace by checking trim whitespace in the Input or
using the Whitespace transform.

You can change the case using the Case transform.

You can concatenate and split columns of text using the Concat Cols and Split Col transforms.
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2.11 Dates

Set Supported Date Formats in the Preferences window according to how you want to
interpret values as dates.

Format Meaning

d The day as number without a leading zero (1
to 31)

dd The day as number with a leading zero (01
to 31)

ddd The abbreviated localized day name (e.g.
‘Mon' to 'Sun'). Uses the locale to localize
the name.

dddd The long localized day name (e.g. 'Monday'
to 'Sunday’). Uses the locale to localize the
name.

M The month as number without a leading

zero (1 to 12).

MM The month as number with a leading zero
(01 to 12)

MMM The abbreviated localized month name (e.g.
‘Jan' to 'Dec'). Uses the locale to localize the
name.

MMMM The long localized month name (e.g.

‘January' to 'December’). Uses the locale to
localize the name.

%% The year as two digit number (00 to 99).

YYvy The year as four digit number. If the year is
negative, a minus sign is prepended in
addition.

For example:
e To support a date such as 31/1/2019 add a supported date format: d/M/yyyy
e To support a date such as 1-31-19 add a supported date format: M-d-yy

List the date formats in order of preference, with the most likely to be used first.
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Dates with only two year digits, are treated as a date between 1900 and 1999. E.g. "31/1/19"
is interpreted in d-M-yy format as 31st January 1919.

Add today date to a dataset using input file meta information or using the Stamp transform.

Values that are in a recognized date format will be treated as dates in transforms such as:
Calculate, Compare, Filter, If and Sort. Supporting large numbers of date formats will slow
down these transforms.

Change the format of dates using the DateTime Format transform.

Do date calculations, such as calculating the number of days between 2 dates, using the
Calculate or Javascript transform.

Convert between ISO standard datetimes and milliseconds since 1st Jan 1970 using the
Calculate transform.

Convert an ISO standard datetimes (e.g. 2020-10-16T01:51) into separate date and time
columns by using the Split Cols transform on the "T" delimiter.

Add missing dates in a sequence using Sequence.
2.12 Numbers

Set the locale according to how you want to interpret values as numbers. For example:
e |f locale is set to US or UK then 123, 456.7 is a number and 123.456, 7 isn't
e If locale is set to Germany or France then 123.456, 7 isa number and 123, 456.7 isn't

An integer is a whole number. E.g. 1.0 or 1, 0 (depending on your locale), 0, -1 and 1e3 are
considered integers.

Numeric values are recognized in the approximate range -1 x 103% to +1 x 103%,
Numeric calculations are accurate to approximately 16 digits of precision. This means that
Easy Data Transform may consider 12345678901234567 and 12345678901234568 to be

equal, for example using the = operator in a Filter transform.

NaN means 'not a number'. It can be returned by some calculations, for example using
Calculate to raise 1000 to the power 1000 will overflow numerically and return NaN.

Change the format of numbers (e.g. the number of decimal places or the decimal symbol)
using the Num Format transform.
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Change the base of integers (e.g. base 10 to base 16) using the Num Base transform.

Do numeric calculations, such as multiplying 2 columns, using the Calculate or Javascript

transforms.

Add missing integers in a sequence using Sequence.

2.13 Booleans

A boolean value can be true or false.

Canonical value

true

false

2.14 Locale

Allowed values

true (case insensitive) or a
non-zero numeric value

false (case insensitive) or a
zero numeric value

You can set the Locale in the Preferences window.

Locale:

English

United Kingdc 3

Examples

true
TRUE
True
1
1.0
-1
0.1
999

false
FALSE
False
0

0.0

Default

The locale language and country setting affects how some numbers and dates are interpreted
and displayed. Consequently it may have an affect on some transforms, for example the
DateTime format and Num format transforms.

This shows using the DateTime format transform with Format to set to ddd MMMM d yyyy

for different locales:
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Locale

English/United States
English/United Kingdom
German/Germany
French/France
Spanish/Spain
Italian/Italy
Portuguese/Portugal
Chinese/China

Japanese/Japan

Output

Mon May 21 2001

Mon May 21 2001

Mo. Mai 21 2001

lun. mai 21 2001
lun. mayo 21 2001
lun maggio 21 2001
segunda maio 21 2001
F— &R 21 2001

A 58 21 2001

You will be warned if you File>Open a .transform file with a different locale to the one you

have set.

2.15 Meta Information

You can add meta information to input data using the Meta info field in the Right pane when

you select an input item.
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10k.csv i ||fe ]l | wpe
@ Input from file.
File: D:\EDT data\CSV\10k.csv
_— |
Deliie™ o o v
Ignore: . .vrow(s)
€ Meta Information X
[ $(FilePath) $I{CurrentDateTime]|l Clear
Insert: <select> v
OK Cancel = Help

Meta info: At start \

v

Alias: 10k

Data Characters ~ Warnings @ Info  Comment Details
14 cols x 10,001 rows @) Read

b B¢ O HHE Y (<= =T N

L\H;H.LUI.L

cA
1 D:\EDT data\Ccsv\1l0k.csv 2022-12-05T09:30:29 ]

Set it to At start, At end or Every row, depending on where you want the meta information
to appear. Then click on the ... button to edit which information you wish to show. The
following placeholders are substituted by their actual values at the time of input.

Meta Information Description Example

$ (ComputerName) The name of the computer.  MyComputer

$ (CurrentDate) The current date, in ISO 2020-08-18

format.
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Meta Information

S (CurrentDateTime)

S (DataColumns)

$ (DataRows)

S (DataValues)

S (FileCreatedDate)

S (FileCreatedDateTime

)

S (FileName)

$ (FilePath)

S (FileSheetName)

S (FileSizeBytes)

$ (FileUpdatedDate)

S (FileUpdatedDateTime
)

Description

The current datetime, in ISO
format.

The number of columns in
the dataset (not including
meta data).

The number of row in the
dataset (not including meta
data).

The number of columns x
rows in the dataset (not
including meta data).

The date the file was
created, in ISO format. Only
available for file input.

The datetime the file was
created, in ISO format. Only
available for file input.

The name of the file,
including it's extension. Only
available for file input.

The full path (location) of the
file. Only available for file
input.

The name of the sheet. Only
available for Excel file input.

The size of the file in bytes.
Only available for file input.

The date the file was last
updated, in ISO format. Only
available for file input.

The datetime the file was last
updated, in ISO format.
Only available for file input.

Example

2020-08-18T18:00:00

10,000

100,000

2020-08-18

2020-08-18T18:00:00

myfile.csv

/Users/andy/Documents

/myfile.csv

Sheetl

1,234,567

2020-08-18

2020-08-18T18:00:00
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Meta Information Description Example

S (UserName) The name of the user (from  Andy
the USER or USERNAME
environment variable).

See also:
e Stam

2.16 Column variables

Transforms such as If, Filter, Insert, Replace and Substitute allow you to use the values of
columns on the same row using column variables. Column values can be referenced either:

e By column header name, e.g. $ (item cost) for the 'item cost' column; or
e By column index, e.g. s (1) for the first column.

Notes:

e The column name is case sensitive. E.g. column 'A' is referenced by variable $ (a) and
column 'a' is referenced by variable $ (a).

e Whitespace at the start or end of the column name is ignored. E.g. column ' A" is
referenced by variable $ (a).

e Whitespace within the column variable is important. E.g. column 'AB' is not referenced by
variables $ (A B), $ (AB) $( AB) or $(AB ).

e If multiple columns have the same name, the first column from the left with that name will
be used.

e Reference by name takes priority over reference by index. For example, if there is a column
named "1" then $ (1) will refer to that rather than the first column.

e Column variables are replaced as text. For example if column 'A’ has value '2' and column
'‘B' has value '3, then $ (2) *$ (B) evaluates as '2*3' (not '6").

e Column names can contain $, ( and ) characters. For example:
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KA
If ol == l[h3¢
@ Create a new column with values conditional on other columns.

New column name: Value
@eselr @anp N L ®
Logic Column Op. Value

1IF currency v = ¥ UsD
2 THEN= $%(value(%))
3 ELSE= £f$(value(f))

v case sensitive

Data Characters Warnings Info Comment Details
5 cols x 2 rows @ 1 match(es) IF/ELSE IF, 1 match(es) ELSE
6B ¢ @ H&2 Y S B | B | R [ A |
transaction currency wvalue($) wvalue(f£) Value
1 2634543 USD 34232.33 $34232.33

2 9233663 GBP 62022.94| £62022.94

2.17 Regular expressions

Easy Data Transform allows the use of regular expressions in the Compare, Extract, Filter, If,

Replace, Slice, Split Col and Split Rows transforms. It is also available as part of the Javascript
language in the Javascript transform.

Regular expressions are a powerful way to match patterns in text (including text
representation of dates and numbers). For example, you can use a regular expression in the
Replace transform to swap first and last names:

Match Type Replace With
1 Regex ¥ Aw+Ns*(w+) A2\

Turns:
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Full name

1 John Smith
2 Mary Brown

3 Jill Jones

Into:
Full name

1 Smith, John
2 Brown, Mary

3 Jones, Jill

Regular expressions are far too big a topic to cover here. However there are many detailed
resources online, such as www.regular-expressions.info and regexr.com.

2.18 Fuzzy matching

Easy Data Transform supports the use of fuzzy matching in various transforms, including the
Cluster, Dedupe, If, Filter and Lookup transforms.

Fuzzy matching allows you to match 2 values that are similar, but not identical. For example if
you set fuzzy match closeness to 80% then 2 values that are 80% the same or better are
considered a match.

For example, doing a fuzzy match to this value:

100 avenue street, townsville, ohio

Gives:

Value Fuzzy closeness
100 avenue street, townsville, 100%

ohio

100 avnue street, townsville, 98%

ohio
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Value Fuzzy closeness
100 avenue street townsville ohio 95%

100 avenue st., townsville, ohio 89%

100 avenue st, townsville 72%
100 av. st., citysville, texas 52%
townsville, ohio 46%
742 evergreen terrace, 36%

springfield, oregon

Fuzzy matching treats everything as a string and takes account of whitespace. It can optionally
take account of case.

Fuzzy matching is significantly slower than exact matching. The closeness score is based on
Levenshtein distance.

2.19 Drilldown

If you check allow drilldown for a transform, double-clicking a cell in the Right pane data
table shows the rows in the upstream dataset that this cell/row was derived from. For
example you can double-click a cell in a pivot table to drilldown into the rows it was
calculated from:
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Pivot Oa = :G
@ Create a pivot table to summarize the selected columns.
Columns: Match type v |
Rows: Added/Excluded vi
Values: Clicks v
Summarize by: Sum v
Set non-calculated: Zero v

v add totals
Total by: Rows and columns v
[ v allow drilldown] |
Data Characters  Warnings Info  Comment Details

6 cols x 5 rows

LR 7 eMEY

@) pivot table created;
)€)12) 20T

Added/Excluded (Empty) Broad match Exact match Phrase match Grand Sum !
1 (Empty) 24913 0 0 0 24913
0 223 1903 103 2229
3 Excluded 0 / 26 632 0 658
€ Drilldown ¥ double-click 0O %
=)
Search term Match type Clicks Impr. CTR *
43  print at home place cards  Broad match Added 5 5100 ||
232 place card Broad match _ 3 89 3.37¢ i
485 size of place cards Broad match Added 1 7 14.2¢
544 printable dinner place cards Broad match _ 3 2 150'(- :
4 b

The following transforms allow drilldown:
e Count

e Dedupe

e Ngram

e Pivot

e Unique

Note that enabling drilldown slows down processing and requires more memory.
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See also:
e Video: How to drilldown into data

2.20 Batch processing

To apply the current .transform file to multiple input files/sheets select File>Batch
Process... . The Batch Process window will appear with a column for each input item and a
column for each output item. The Alias for each item is displayed in the column header.

orders.xlsx
(V) [orders]

14 cols x 830 rows

~

Alias: orders

Alias: output

o

o Join © output.csv

|Alias: customers 24 cols x 830 rows 24 cols x 830 rows

“\

customers.csv

11 cols x 91 rows

& Batch Process

{customers.flame} is replaced with the file stem of the Wput with alias ‘customers'
} is replaced with the file extension of the fput with alias 'customers'
e} is replaced with the file stem of the input With alias ‘orders’

is replaced with the file extension of the input

{date}, e} and {datetime} are replaced by the processing dafg, time and datetime.
Click 'Hg8p' for more details.

Adi Remove | Clear

Input alias=customers Input alias=orders Output alias=output (Overwrite)
1|C:\Users\andy\batch\customers.csv ... |C\Users\andy\batch\order* xIsx[*] ... th\out\{orders.fname}_{orders sheet}.csv ...
logging Process| Stop v make a sofld on completion
. orders orders
wildcards file name sheet name
V| log results to y\Desktop\batch_log.txt| ... |Append ~ Close Help

Note:

All input and output items must have an alias.

An output item can't have the same alias as another output or input item.
Disconnected input and output items are not shown.

Output items with Write mode=Disabled are not shown.

Click Add to add a new processing row.
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Click Remove to remove the selected processing row(s).
Click Clear to remove all processing rows.

Check clear 'Append’ outputs before first append if you want to clear output files you are
appending to before the first append.

Check log results to if you want to log the results to a text file. Set the file location and set
the write mode to Overwrite or Append. You can use {datetime}, {date} and {time} in
the file location.

In the input column(s) you can use * and ? wildcards for file name stems, file extensions and
Excel sheet names. E.g.:

Input Description

/Users/andy/Documents/*.csv All files with extension .csv in the Documents
folder

/Users/andy/Documents/d?.csv All the files with name 'd" plus a single

character in the Documents folder

/Users/andy/Documents/data.xlsx[* Al the sheets in data.xlsx in the Documents

] folder
iUserS/andy/DocumentS/* -xlsx[data All the sheets beginning with 'data’ in all the
] xslx files in the Documents folder
Note:

e |f there is more than 1 input column on a row that specifies multiple files or sheets, then an
output will be created for each possible permutation of input files/sheets in the row. E.g. 3
input files from column 1 x 4 sheets from column 2 = 12 outputs to process.

e Excel sheet names are not case sensitive.

¢ You cannot use wildcards for folder names.

¢ Batch processing will ignore files in sub-folders. Add them as extra rows.

e All the files input to an input item or output from an output item should be the same file
type as the original.

In the output column(s) you can use the file name variables to dynamically change output file
names based on input file names.

You can write to multiple sheets of an Excel file.
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This example shows using a wildcard for the input file name and sheet and file name variables
to set the output file name based on the input file with alias sales:

Input alias=sales Output alias=output (Overwrite)
1/C\Users\andy\batch\* xlsx[*] ... C\Users\andy\batch\output\{sales.fname}.xlsx[{sales.sheet}]

But make sure to set the corresponding output Write mode=0Overwrite/Sheet.
Click Process to start processing the rows.
Click Stop to stop processing the rows.

Check make a sound on completion if you want to play a sound when all processing is
finished.

Click Close to close the window.

Note:

e Whether an output file is created, overwritten or appended to depends on the Write mode
of the output item.

e We recommend you output to a different folder than the one the input files are in.

See also:
¢ Video: Batch processing

e Batch processing examples
e Command line arguments

2.21 Command line arguments

Easy Data Transform accepts the following command line arguments:

Argument Description
<file name> The .transform file to open at start-up.
-cli Close the application once any processing on the opened

file is complete.

-log <location> Appends the command line output to the file at
<location>. -cli must also be set.

—file . Sets the input or output file with the given alias to the
<alias>=<location> location (path) specified. Input Excel files should include the
sheet name, e.g. file.x1lsx[sheet]. Output Excel files
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Argument Description

may optionally include a sheet name. The file type should
be the same as the original.

-new_window Don't load the last opened .transform file, even if open
previous file at start-up is checked in Preferences.

~verbose Output additional information to the terminal. Useful for
debugging problems.

This allows you to run Easy Data Transform from the Mac Terminal or a script. For example:

Torun /Users/andy/Documents/myfile 1.transform with the output with alias
outputl output instead to /Users/andy/Documents/datal.csv

/Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform
'/Users/andy/Documents/myfile 1.transform' -file
'outputl=/Users/andy/Documents/datal.csv' -cli -verbose

To run /Users/andy/Documents/myfile2.transform with the input with alias input1
input instead from sheet sheetl of /Users/andy/Documents/data 2.xlsx

/Rpplications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform
/Users/andy/Documents/myfile2.transform -file
'inputl=/Users/andy/Documents/data 2.xlsx[sheetl]' -cli -verbose

Use wildcards to transform multiple files in a folder:

for £ in in*.csv;

do /Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransfo
rm '/Users/andyb/Dropbox/cli/cli.transform' -file cli-in=$f -file
cli-out=out-$f -cli -verbose; done

Use file name variables to dynamically change output file names based on input file names.

You can also use the Mac 'open' command:

open /Applications/EasyDataTransform.app --

args /Users/andy/Documents/myfile\ 1.transform -file
outputl=/Users/andy/Documents/datal.csv -cli

open /Applications/EasyDataTransform.app --

args /Users/andy/Documents/myfile2.transform -file
'inputl=/Users/andy/Documents/data 2.xlsx[sheetl]' -cli

But note that no command line output is shown if you use ‘open'.
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Put single quotes (') around any arguments with spaces or a backslash (\) in front of each
space (as shown in the examples above).

If you are using wildcards, then it is usually a good idea to output to a different folder to the
one that you are inputting from.

Select File>Command Line... to show sample command line text which you can copy and
modify. It will also warn you of potential issues.

To run on a schedule, call the command line interface (or a script file that calls the command
line interface) from a scheduling program, such as launchd.

See also:
e Batch processing

e Run jobs on a schedule

2.22 File name variables

You can dynamically change the name of an output file based on input file names using file
name variables. For example, if the input file with alias orders has file name
orders dec 2022.csv, then setting the output filename to

output {orders.fname}.csv will write to output orders dec 2022.csv.
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Alias: orders

orders-dec-2...

14 cols x 830 rows

Join output_{orde...
/] — 8
18 cols x 2.2k rows 18 cols x 2.2k rows
order-details....
5 cols x 2.2k rows
File: C:\Users\andy\Desktop\output_{orders.fname}.csv

You can also include dates and times in your output file names.

Output variables Meaning Example

{<input alias>.fname} The name of the input file If the input with alias orders
being processed with the is using
corresponding alias. file /Users/andy/Documen

ts/orders 2020.csv
then {orders. fname} is
replaced with

orders 2020.

{<input alias>.ext} The extension of the input If the input with alias orders
file being processed with the s using
corresponding alias. Does file /Users/andy/Documen
not include the '.". ts/orders 2020.csv

then {orders.ext} is
replaced with value csv.
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{<input alias>.sheet}

{<input
alias>.folder}

{<input alias>}

{date}

{time}

{datetime}

Easy Data Transform © 2023 Oryx Digital Ltd

The sheet of the input file
being processed with the
corresponding alias (Excel
only).

The folder (directory) of the
input file being processed

with the corresponding alias.
Does not include the final /.

The name of the input file
(plus an underscore and the
sheet name, if an Excel file)
being processed with the
corresponding alias.

Date processing was carried
out in year_month_day
format.

Time processing was carried
out in
hours_minutes_seconds_milli
seconds format.

Date/Time processing was
carried out in
year_month_day_hours_minu

If the input with alias orders
is using

file /Users/andy/Documen
ts/orders 2020.xlsx
with sheet Sheet1 then
{orders.sheet} is
replaced with value Sheet1.

If the input with alias orders
is using

file /Users/andy/Documen
ts/orders 2020.csv
then {orders.folder} is
replaced

with /Users/andy/Docum
ents.

If the input with alias orders
is using

file /Users/andy/Documen
ts/orders 2020.csv
then {orders} is replaced
with value orders 2020.

If the input with alias orders
is using

file /Users/andy/Documen
ts/orders 2020.xlsx
with sheet Sheet1 then
{orders} is replaced with
value
orders 2020 Sheetl.

2020 04 18

15 21 56 599

2020 04 18 15 21 56 5
99
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tes_seconds_milliseconds
format

{version} The Easy Data Transform vl 390
version number

File name variables can be used for output file names set in the Right pane, in batch
processing or through command line arguments.

2.23 .transform files

.transforms file are stored in a simple XML format. So you can edit them with a standard text
editor. However we recommend you make a copy first.

The results of transformations are not stored in the .transform file, and are recalculated
whenever you File>Open... the file.

The contents of Input and Output files are not stored in the .transform file, only their
locations. These locations are stored as ‘absolute’ locations, so you can move the .transform
file without changing the locations of the Input and Output files.

If you open a .transform file in a different location from that in which it was saved and it can't
find Input and Output files at the expected location it will look for them in the same location
relative to the old .transform file. This allows you to easily move .transform files to different
locations and computers if you keep the Input and Output files in the same relative location
(e.g. in the same folder as the .transform file). This even works between Windows and Mac
(and vice versa),

Example:

e mytransform.transformisin C:\Users\andy\Documents\ on Windows and uses
Input file MyData.csv in sub-folder MyData (C:
\Users\andy\Documents\Data\MyData.csv).

e mytransform.transformis moved to /Users/Bob/Documents/EDT on a Mac.

e Whenmytransform.transform is opened it will look for MyData.csv
in /Users/andy/Documents/Data.

e If it can't find that it will look for MyData.csv in sub-folder MyData
(/Users/Bob/Documents/EDT/Data/MyData.csv).

If you paste in data From Clipboard this is stored in the .transform file. We don't recommend
you do this for large datasets as XML is not very efficient for storing large amounts of data.
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2.24 Portability

By default Easy Data Transform stores your preferences in macOS Library/Preferences.
However you can store your preferences in an easydatatransform.ini file in the same folder as
the Easy Data Transform .app file. This means you can install Easy Data Transform on a device
without admin access. It also allows you to store everything on a portable device, such as a
USB memory stick. You can even move your portable device between Windows and Mac
computers.

To use Easy Data Transform portably:

e Install Easy Data Transform into an appropriate folder on the portable device. Make sure
you have write permission to the folder.

e Start Easy Data Transform.

e Open the Preferences window.

¢ In the General tab set the Store these preferences in field to portable .ini file.

e Click OK.

e You may also wish to copy your .transform files to the portable device.

If you change the folder your portable version is installed in (e.g. you install a new version to
a different folder) you should copy across your easydatatransform.ini file to the new folder.

If you move your portable device from one computer to another (e.g. Windows to Mac) the
path of files may change (e.g. from D:\my usb key\my transform.transform

to /Volumes/my usb key/my transform.transform). Easy Data Transform will try to
be intelligent about handling these changes of path by:

e storing recent .transform file paths as relative rather than absolute paths

e by treating relative .transform paths as relative to the Easy Data Transform .app file.

It is possible to have Windows and Mac versions of Easy Data Transform on the same device
sharing a single easydatatransform.ini file and common input, output and .transform files. Just
make sure you install the Windows .exe and Mac .app into the same folder. We also
recommend that they are the same version of Easy Data Transform.

If you have problems installing Easy Data Transform to a USB key see Mac Install
Troubleshooting.

For the purposes of licensing, installing to a USB key, or other portable device, counts as one
of your 3 allowed installs.

Note If you install Easy Data Transform Windows .exes or Mac .apps into 2 different folders
and set them to use .ini files, they will each store their preferences in their own .ini file.
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2.25 Keyboard shortcuts

Using keyboard shortcuts can improve your productivity. If you are using Easy Data Transform
a lot we suggest you find the time to learn at least some of them. The following keyboard
shortcuts are available for the Mac version of Easy Data Transform:

Key Shortcut Action

A Cmd+A Select all in Center pane.

B Cmd+B Show the Batch Process
window.

C Cmd+C Copy selected data with
header from the Right pane.

Cmd+Shift+C Copy selected data without
header from the Right pane.

D Cmd+D Duplicate the selected
branch in the Center pane.

F Ctrl+F Find items that match a
search term in the Center
pane.

Ctrl+Cmd+F Toggle setting Right pane

item to fullscreen. Only
works if 1 item in Right

pane.
Option+I Input From File.
Option+Shift+I Input From Clipboard.
K Cmd+K Search transforms by
keyword.
L Cmd+L Toggle the Log pane

visibility on/off.

M Cmd+M Toggle cursor magnification
for Center pane on/off.

N Cmd+N New .transform file.

@) Cmd+0 Open .transform file.
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Key

Backspace

\

Left arrow

Shortcut

Cmd+Shift+0

Option+0O
Cmd+R
Cmd+Shift+R
Cmd+S

Cmd+T

Cmd+U

Cmd+7

Cmd+Shift+Zz

Backspace

Cmd+,

Cmd+,

Cmd+=

Cmd++
Cmd+-

Option+ [

Option+]

Cmd+\

Cmd+Left arrow

Action

Show the Open Recent
window.

Output To File.

Run unprocessed items [4].
Run selected items [4].
Save .transform file.

Toggle two screen mode
on/off

Toggle user interface
between light and dark
themes (if available).

Undo
Redo

Delete selected item(s) in
Center pane.

Toggle the Timing Profile
on/off.

Show Preferences window.

Zoom Center pane so all
items fit.

Zoom Center pane in.
Zoom Center pane out.

Move keyboard focus to
Center pane.

Move keyboard focus to
Right pane.

Stop processing.

Move Center pane selection
from item to highest[1] item
that inputs to it.
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Key Shortcut Action

Right arrow Cmd+Right arrow Move Center pane selection
from item to highest[1] item
that it outputs to.

Up arrow Cmd+Up arrow Move Center pane selection
from item to highest[1]
sibling[3].

Down arrow Cmd+Down arrow Move Center pane selection
from item to lowest[2]
sibling[3].

1.9 Cmd+1 ... Cmd+9 Select inputitem 1to 9
(based on height in Center
pane).

Cmd+Shift+l ... Select output item 1to 9
Cmd+Shift+9 (based on height in Center
pane).

F1 Fl Show help.

F5 FS (Re)process all [4].

F8 F8 Show options and data in the
Right pane.

F9 F9 Show only options in the
Right pane.

F10 F10 Show only data in the Right
pane.

[1] Highest=nearest the top of the Center pane.

[2] Lowest=nearest the bottom of the Center pane.

[3] Two items are considered siblings if they have inputs from the same item(s) or they both
have no inputs.

[4] If Run>Auto Run is unchecked.

You can also use the keyboard to add transforms in the Center pane. Just select the item(s)
you want to add the transform to and start typing the name. Only eligible transform that

contain the typed letters will be displayed (spaces are ignored).

For example, to add the Rename Cols transform an existing Input item:
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e select the input items

e type ren

e press the Return key

If you want to see a list of all the transform names, press the Space key before you start
typing. You can use the Del or Backspace key to undo letters typed.

You can quickly change selection in the Center pane using arrow keys with the Cmd key.

Left Arrow Up Arrow

V‘,Remove Cols

Dedupe

4

4 cols x 14.7k rows 4 ls x 209 rows

Right Arrow

Pivot L/ Sort

2 als x 210 rows 2 @ls x 210 rows

Spread

v

104 colg x 209 rows

| Down Arrow |

If you are zoomed in you can scroll the Center pane by pressing the Shift key and dragging
the canvas.

2.26 Dark mode

Select View>Toggle Ul Theme (or the corresponding status bar button) to swap between
light and dark user interface themes. You can also change the Center color scheme in the
Colors tab of the Preferences window.
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3.1 Add a transform between existing items

To add a new transform between existing items (e.g. between 2 already connected
transforms) see connections.

3.2 Add metadata to a dataset

You can add meta data to an input dataset by setting the Meta info field. See meta
information for more information.

10k.csv % B2 <
@ Input from file.
File: DAEDT data\CSV\10k.csv
- DM _/ _/ _‘I...-""

Ignore: . .vrow(s)
€ Meta Information X
[ $(FilePath) $I{CurrentDateTime]|l Clear

Insert: <select>

OK Cancel = Help

™

Meta info: At start

Alias: 10k

Data Characters Warnings @ Info Comment Details
14 cols x 10,001 rows @) Read

b B¢ O HE Y V2| 2| Ny [ 37 NN

Reeiar Cl+
1 [ D:\EDT data\Ccsv\1l0k.csv 2022-12-05T09:30:29 ]
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3.3 Add missing data values

You can add missing values based on the average (mean), median or mode of non-empty
values in the same column using the Impute transform.

For example you can add missing ages for Titanic passengers based on the average age
supplied for the other passengers:
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Pclass Sex Age SibSp Parch |+ E

21 2male 35 0 0 i
22 2 male 34 0 0 i
)

23 3 female 15 0 0 ]
24 1l male 28 0 0 '
25 3 female 8 3 1 i
26 3 female 38 1 5 :
27 3 male 0 0 E
28 l male 19 3 2 i
29 3 female 0 0 It
30 3male 0 0 i
=il 1l male 40 0 0 E

impute FELS

@ Infer values of missing data.

o — 11
E] Q Filter columns

Pclass
Sex
Age
v g
-
1 of 9 columns selected
Using: Average v

Easy Data Tran$ Of }:'l." rows x Digital Ltd
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See the Impute transform documentation for more details.

See also:

e Video: How to impute missing data
e Replace empty values

e Profile a dataset
3.4 Add or remove a header

To add or remove a header just check or uncheck the has header checkbox for the
appropriate input item.

vaccination.csv @ CF E

]

File: /Users/andyb/Desktop/vaccination.csv

Type: Delimited text o
Delimiter: Automatic &
Quoting: Automatic t
Encoding: Automatic <
Ignore: First O row(s) 2
v has header
Espace
+ simplify whitespace
+ ignore empty rows
watch file
Meta info: Mot added [+

Alias: vaccination
Data Warnings Info Comment Results

3 cols x 5,780 rows

C I_% £ @ Show first 10 rows <

country time bcg_vacc

You can also make the first row of your dataset into a header using the Header transform.

3.5 Change a connection

To change a connection see connections.
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3.6 Change encoding

When Easy Data Transform inputs a text file (e.g. a CSV file) it will make a guess at the
encoding. You can explicitly set the encoding by selecting an input item and changing
Encoding from Automatic to one of the other encodings in the Right pane.

vaccination.csv @ i
File: /Users/andyb/Desktop/vaccination.csv

Type: Delimited text
Delimiter: Automatic
Quoting:  Automatic

Encnding‘.

lgnore: First 0 row(s)

LB <<

Similarly you can also set the encoding of a text file output by selecting the output item and
changing Encoding in the Right pane.

output.csv @ E g
File: /Usersfandyb/Desktopfoutput.csv

Type: Delimited text
Delimiter: Comma (,)
Quoting: As needed

Line endings: Automatic

Encndin

Byte Order Mark

OO

See also:
¢ Video: How to change CSV file text encoding

3.7 Clean a dataset

Data is often 'dirty’ and needs to be cleaned up before further processing. You can quickly
find unwanted characters by looking in the Characters tab of the Right pane to see what
types of characters occur in which columns.
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Data Warnings (Dinfo  Comment  Details

Sample: All 29 rows ¥ v show bars

SupplierlD CompanyName ContactName ContactTitle Address City Region PostalCode

Uppercase 80 60 61 64 33 95 18
Lowercase 408 293 428 347 185 24

Digit 49 81 124
Dot 9 2 12

Colon

Apostrophe 6 2

Dash 2 1 5 2 2

Forward Slash

Other 3 1

Non-ASCII 2

Space 51 32 32 74 2 7
Leading Space 1

Trailing Space 1

Double Space 1

Note that some of these categories are non-exclusive. For example: a space might be
counted as a space, whitespace and a leading space, and a symbol might also be a non-ASClII
character.

Hover over a cell for more details.

[} 2
2 Non-ASCI| character(s) out of 559 character(s)
sampled from all row(s) in column 'CompanyName' (0.36% of all).

Examples:
Row 19: New England Seafood Cannery i

You can turn the colored bars off.
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Data Characters Warnings @Info i

Sample: All 29 rows ~ show bars |

SupplierlD CompanyName

Uppercase 80
Lowercase 408
Digit 49

And you can restrict it to sampling only a subset of rows for improved speed in large
datasets.

Data Characters =~ Warnings @ Inffo C

Sample: RIS V' show bars
10,000 rows
100,000 rows

All 500,000 row
Lowercase " 7,267 7,033

ountry Item Type

Upperc 1,252 1,250

You can use the Characters tab in conjunction with the Replace and Whitespace transforms
to quickly clean your data. Replace can easily remove non-ASClIl, symbols etc by replacing
them with nothing:

Easy Data Transform © 2023 Oryx Digital Ltd



How do I?

Replace FE LT

@ Replace multiple text in the selected column(s).
E Q Filter columns

Name
Voo

Customer Id

Product Id

1 of 5 columns selected

@1V ®E & X

f—MathyH Replace With
Text

Exact text
, Regex

Empty

s Warnings Info L P

@) No changes
25 P

- Punctuation | VAL el ORI

Symbols Customer Ild  Product Id *

I Whitespace C018930 1357

4 Currency b
Non-ASCIl  p |

Letters

g . .
L Digits

v

See also:

e Video: How to clean data
e Add missing data values
e Profile a dataset
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3.8 Convert to percentages

You can convert to percentages using the Scale transform.
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Item Disputed
1 Billing Accuracy $4,128,367.37

2 Terms & Conditions  $1,722,366.90
3 Unknown $1,141,031.66

4 Delivery & Installation $1,091,424.82

5 Service Delivery $238,914.81
6 Technical Issues $53,816.33
Scale d: E ﬂ

@ Scale numeric values, e.g. to a percentage or 0 t...
E Q Filter columns

Item

v, Di.s.pgted

1 of 2 columns selected

1)

Scale to : 100
Using:  Sum v

Of: All values v

v

Item Disputed
1 Billing Accuracy 49.2885132433

2 Terms & Conditions 20.5633113897

3 Unknown 13.6227590823
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3.9 Duplicate a series of transforms

To duplicate multiple items in the Center pane (e.g. a sequence of transforms) right click on
the first item and select Duplicate Branch.

solar.xlsx

J  [data) '. J Javascript _ >, Interpolate
6 cols x 2.8k rows 7 cols x 2.8k rows T o
v wea[g:igf'sx . Filter I , Javascript
23 cols x 25.4k rows 23cols| INPUT '
»-_J Transform »
Qutput 3
Duplicate Branch Ctrl+D
Connect..
Disconnect
Disconnect Upstream
Disconnect Downstream
@ Delete Del
y 5”["3;’2]""‘ _, Javascript » ,Interpolate

ot ol S

6 cols x 2.8k rows 8 cols x 2.8k rows

7 cols x 2.8k rows

weather.xlsx
A [data]

23 cols x 25.4k rows

Filter

23 cobs x 8.5k rows

v

Interpolate

R P AU &
8 cols x 2 8k rows

Filter

23 cols x 8.5k rows

Javascript

24 cols x 8.5K rows

3.10 Dedupe a dataset

There are 2 transforms for removing duplicate rows from datasets:
e Dedupe removes duplicate rows, keeping only the first row in each group that it considers
to be duplicates of each other
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¢ Unigue creates a single aggregate row from each group that it considers to be duplicates of
each other

Dedupe is simpler. Unique has more flexibility.
Using Dedupe

To keep only the first row with each Customer Id from this dataset:

Name Customerid Productld Cost Date
1 Alice Anderson C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones C017783 96352 19.95 02/10/2020
4 Robert Brown C018917 98526 10.00 02/10/2020
5 Charles Jones 'C017783 28746 25.00 03/10/2020

To get this dataset:

Name Customerld Productld Cost Date
1 Alice Anderson  |C018930 13574 29,95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones |CD1??83 96352 19.95 02/10/2020

Drag the dataset file onto the Center pane of Easy Data Transform. Then click the Dedupe
transform in the Left pane.

0a:.lE*::iupe—e:w:an"n... © Dedupe

5cols x5 rows 5 cols x 3 rows
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Then check the Customer Id column in the Right pane.

KA
Dedupe o ¢ N
@ Remove duplicate rows by matching values in al...
Explore Duplicates...
IE' Q Filter columns i
'r
Name =
Customer Id .
v
Product Id .'
Cost ,'
[ - |'
1 of 5 columns selected :
Matching: Exact M
v case sensitive .
ignore whitespace
ignore punctuation '
Mode: Remove duplicates v

Only the first row with each Customer Id is kept. Use Sort if you want to change the order
before the Dedupe transform.

If you only want to remove rows with the same Customer Id and Product Id, check both the
Customer Id and Product Id columns.

If you want to use fuzzy matching to also remove rows that are similar, but not identical, set
Matching to Fuzzy.
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To see what rows will be removed and experiment with different options, click the Explore
Duplicates... button.

€ Explore Duplicates O X
Columns to match: Matching: Exact v
E Q Filter columns »
V' case sensitive
Name =
ignore whitespace
v Customer Id ignore punctuation
Product Id Y
4 >

1 of 5 columns selected

> O Found 3 non-duplicates and 2 duplicates in <0.1 seconds

Data Summary

hide unchecked columns hide rows with no duplicates o
Name Customer ld Productld Cost Date Grou
1 Alice Anderson  C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Robert Brown C018917 98526 10.00 02/10/2020
4 Charlie Jones C017783 96352 19.95 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020
4 >
OK Cancel

Note that Dedupe takes account of whitespace. So you might need a Whitespace transform
before the Dedupe transform.
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See also the Dedupe documentation.
Using Unique

To aggregate all rows with the same Customer Id:

Name Customerld Productld Cost Date
1 Alice Anderson |C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456 10.55 01/10/2020
3 Charlie Jones |CD1??83 96352 19.95 02/10/2020
4 Robert Brown C018917 98526 10.00 02/10/2020
5 Charles Jones C017783 28746 25.00 03/10/2020

To get this dataset with:

e The first Name for that Customer Id

e A comma separated list of Product Ids for that Customer Id
e The total Cost for that Customer Id

e The last Date for that Customer Id

Name Customer |d Product Id Cost Date
1 Alice Anderson  C018930 13574 29.95 01/10/2020
2 Bob Brown C018917 89456,98526  20.55 02/10/2020
3 Charlie Jones C017783 96352,28746  44.95 03/10/2020

Drag the dataset file onto the Center pane of Easy Data Transform. Then click the Unique
transform in the Left pane (if you can't see Unique, then check show advanced is checked in
the Left pane).
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dedupe-exam... Unique
o ——g -

Scols x Srows 5 cols x 3 rows

Then set the Unique options as shown below:

Unique tf} = EC

@ Aggregate rows with unique values in selected c...

Column Option
Name Keep first v
Customer Id Keep unique A
Product Id Concat v
Cost sum b4
Date Keep last v
Set All ¥ to Keep unique ¥

‘Keep unique' for 1 of 5 columns
Concat delimiter: ,

add count column

One aggregated row is created for each Customer Id. Use Sort if you want to change the
order before the Unique transform.

If you only want to create a new aggregate row for rows with the same Customer Id and
Product Id, set both the Customer Id and Product Id columns to Keep unique.

Note that Unique takes account of whitespace. So you might need a Whitespace transform
before the Unique transform.

See also the Unique documentation.
See also:

¢ Video: How to remove Excel duplicates
e Video: How to merge rows in Excel
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3.11 Find the difference between dates/datetimes

You can calculate the number off days difference between two dates using the Calculate
transform. For example:

Start End
131/12/2019 7/1/2020

2 01/01/2021 15/1/2021

3 07/01/2021 8/1/2021

y

KA
Calculate t,ff} N

@ Perform calculations on 1 or 2 columns to creat...

Operation: - Subtract v

Value 1: End hs

Value 2 type: Column v

Value 2: Start v
Start End End-Start

131/12/2019 7/1/2020 7
2 01/01/2021 15/1/2021 14

3 07/01/2021 8/1/2021 1

You can convert a datetime into a date using a transform such as Extract.

Alternatively, you can calculate the difference between two dates or datetimes using Date
objects in the Javascript transform.
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There are 4 ways to create a Javascript Date object:

Date format Description

new Date(year, month, day, hours, Specified date and time specified as numeric
minutes, seconds, milliseconds) .
parameters (January is month 0!).

new Date (text date) Date and time specified as text.
new Date (milliseconds) Milliseconds after 1st January 1970.
new Date () Current date and time.

Notes:

e A text date should be in yyyy-MM-dd format.

¢ A Date object always includes a time. If no time is set, then the time is assumed to be
midnight GMT.

e One and two digit years will be interpreted from 1900.

Examples

To calculate the number of milliseconds between a date in the 'date' column and 31st Dec

2000:

return new Date( $(date) ) - new Date( "2000-12-31" );
Or:

return new Date( $(date) ) - new Date( 2000, 11, 31 );

To calculate the difference between datetimes in the 'start' and ‘end' columns in hours:

return ( new Date( $(end) ) - new Date( S(start) ) ) / ( 60 * 60 *
1000 );

To calculate how many days ago 'date’ occurred (rounded down):

return Math.floor( ( new Date() - new Date( S$S(date) ) ) / ( 24 * 60 *
60 * 1000 ) );

For more information see the Javascript documentation.
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3.12 Handle column name/order changes in inputs

If you have a .transform file that you want to run multiple input files through (perhaps with a
different input file each month, via the command line from a script, or as a batch process) you
need to be aware of differences in column name and column order in the input files.

To change the file being used by an input, select the input item and change the file location in
the Right pane (e,g, by clicking the "..." browse file button), rather than disconnecting the
input and connecting a new one. Otherwise column-related parameters downstream will be
reset.

Same columns in the same order, but with different names

Easy Data Transform references columns by their position (e.g. 3rd column from the left) not
their column name. So differences in column names (e.g. first column is called "id" in input 1
and "UniquelD" in input 2) are not generally an issue. But you need to be careful if you are
using the Stack transform with Align columns by set to Header name, as this will reorder
columns by name. If you want to always output the same column names, regardless of the
input column names, you should use a Rename Cols transform to set the names.

Same columns with the same names, but in a different order

If columns are in different orders in different input files (e.g. the "ID" column in the first
column in input 1 and the last column in input 2) you need to put the input columns into a
standard order before applying other transforms. You can so this using the Stack transform
with Align columns by set to Header name. You can stack your input under a dataset with
just the columns in the correct order (no data rows).
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Stack JCP Eg

@ Merge input top of another. Or...
Align columns by: Header name v
ID title first last

Data =~ Warnings CD Info Comment g
No rows 4 cols x 2 rows @) 2 inputs stacked
‘ BB L@ F Yk < 22T M L

ID title first last

1 001 Mr John Smith
_header-only.csv
2 2 002Ms Jane Smith

4 cols x 0 rows l

Stack

4 cols x 2 rows

@

input.csv

4 cols x 2 rows

f

. title first last ID
{1 Mr John Smith 001

'2Ms Jane Smith 002

Same columns with different names, in a different order

Easy Data Transform can't handle this automatically. But you can create a new .transform and
use Reorder Cols and/or Rename Cols transforms to output to a new file with the correct
column names/ordering. You can then input this to the original .transform.
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3.13 Handle datasets with many columns

Easy Data Transform can help you to easily remove or rename columns in datasets with large
numbers of columns.

Remove multiple empty columns
If your dataset has a large number of empty columns you can remove them by checking
ignore empty columns when you input it.

orders.xlsx[orders] | |BE||e 2

(%) Input from file.
File: 1dyb/Dropbox /EDT_datajorders.xlsx[orders]

<3

Type: Excel XLSX

{3

Ignore: First 0 row(s)
+ has header
+ trim whitespace
' simplify whitespace
v ignore empty rows

+ ignore empty columns

watch file

Remove multiple columns

To quickly remove a large number of columns using the Remove Cols transform, you can do

it by filtering column names. For example, to remove the columns with name that contain

"id":

e Add a Remove Cols transform.

e Type id into the filter field. All the columns whose names contain "id" should now be visible
(not case sensitive).

e Click the Unselect all button.

e Click the Clear button.

All the columns whose names contain "id" should now be removed by the transform. You can

repeat this process as often as needed.
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Remove Cols e dll==eEe

(%) Uncheck the column(s) you wish to remove.

[:Cl id Q)

OrderlD

CustomerlD

EmployeelD

Rename multiple columns

To quickly rename a large number of columns using the Rename Cols transform, you can do

it using Replace text:

e Add a Rename Cols transform.

e Click the Replace text button.

e Enter the text you want to Replace and the text you want to replace it With. You can match
as Text, Exact text or Regex, with case sensitive matching optional.

e Click Apply to make the change.

e Click Close.

[ NN Replace Rename Cols s dIE=NMES
@ Rename column headers.
Match type:  Text case sensitive <+ Ao c
Replace: ID 0Old name New name
i " OrderiD Orderld
1 Preview: Changes applied CustomerID Customerid
F Close { EmployeelD Employeeld
OrderDate OrderDate

14 cols X B30 rows

See also:

e Handle large datasets

3.14 Handle large datasets

Large datasets (e.g. with millions of rows) can slow down processing. If slow processing is a

problem you can:

e Add a sample transform straight after the input and set Rows to pass through only the first
100 or so rows. Once you have completed all your transforms you can then Disable
sampling to pass through all rows.

¢ Set Maximum memory usage to a higher value in the Preferences window, to ensure you
don't run out of memory.

e Set Optimize processing for to Minimum memory use in the Preferences window, to
reduce memory usage.
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e Uncheck Run>Auto Run to give yourself full control over processing.

. &
DEI?“—T-;‘:-E@L:- 5] O

or
e Check Run>Auto Run and:

o Set Right pane processing delay in the Preferences window to a longer time (say 5
seconds) to ensure that changes aren't processed until you have finished making the
changes.

o Set Write mode to Disabled in output files, until you are ready to write them.

You can check View>Timing Profile to see where the processing time is being spent.

|

10k.csv
/]
14 cols x 10k rows
= ] I ] o ] =
Stack Filter Sort output.csv
0 e T P
14 cols x 110k row s 14 cols x 81.5k rows 14 cols x B1.5k rows 14 cols x B1.5k rows
I
100k.csv
L]
14 cols x 100k rows
See also:

e Handle datasets with many columns
e Manage a large number of Center pane items

e Processing

3.15 Input a fixed width format file

To input data from a fixed width file see fixed width format.

3.16 Manage a large number of Center pane items

Large .transform files can have 100+ Input, Transform, Output and Note items in the Center

pane. There are various techniques you can use to keep this manageable:

e Place items in conceptual groups with space bewteen. Use Note items to describe the
purpose of the group.
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! 6 ols % 155 rows

[ output.xlsx
—v )

Select items in the center pane
to view

e Try to avoid connections crossing items and other connections where possible.

o Set Edit>Snap To Grid on to make it easier to keep items neatly aligned.

e Select View>Show Tool Tips>Detailed, so that you can see detailed tooltips when
hovering over an item.

e Add comments in item Comment tabs. You can see these in tooltips when you hover over
the items. You can also select View>Show Comments to show them on items.

e Select View>Magnify Cursor to magnify items while zoomed back.
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7 Qeadep# ®

"How Do I? @

o Spread

deaths b

106 cols x 2Bk rows

date

s Count

I \
III
Vi_ Dedupe

u

1nin
e Select View>Find Items to select items in the Center pane that match one or more search
terms.

e Configure the mouse wheel zoom and pan behavior using the Zoom wheel behavior field
of the General tab in the Preferences window.

e Hold down the shift key and drag on the Center pane to scroll left/right/up/down.
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Y Dedupe

< rows 18 cols x 830 rows
o
Prass Slhilii V4
1
| Y tax-rates.csv
" 11 cols x 70 rows
|

See also:

e Handle large datasets

3.17 Merge datasets

Easy Data Transform has two main options for merging two datasets. Stack and Join.

Stack datasets

If you want to merge the two datasets so they are one on top of another, use the Stack
transform. For example, to Stack these two datasets:
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Name D DOB

John Black 001 01/07/1966

Paul White 002 11/03/1973

Barry Green 003 30/12/1977,

+

i Name ID DOB

Jane Brown 004 03/11/198

! Jill Taupe 005 01/03/198

To get this dataset:

Name ID DOB
1 Q‘I_F'I Black 001 1966-07-01

2|Paul White 002 1973-03-11

3 @r}f Green 003 19??—12—_3?)

4 Jfone Brown 004 1980-11-02\

51;1\|Taupe 005 1981—93-[&)

¢ Drag the two dataset files onto the Center pane of Easy Data Transform.
e Select the two datasets using Cmd+click.
e Click the Stack transform in the Left pane.
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stack- example-1a....

3 cols x 3 rows

Stack

3 cols x5 rows

/]

stack-example-1b....

3 cols x 2 rows

The datasets are now stacked in the vertical order that the datasets are shown on the screen.
The top dataset is shown first. You can swap the vertical positions of the datasets to change
the order in which they are stacked.

If you want to stack column n of the first dataset above column n of the second dataset, set
Align columns by to Column number.

If you want to stack columns by common header names (even if they aren't in the same
order), set Align columns by to Header name.

If you want to stack a large number of files you can do it by using batch processing to write to
an output item with Write Mode=Append.

Join datasets

If you want to merge the two datasets side-by-side using a common (‘key') column, use the
Join transform. For example, to Join these two datasets:
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Name ID DOB ID Department Level
fohn Black 001 1966-07-00 1601 Engineering 1 "\
Paul White 802 1973-03-11 2|003 Engineering 2

Barry Green @031 1977-12-30 + 3|004 Marketing 1

Jane Brown 004 1980-11-03 41002 Sales 2

5l Sales 3
Q0 J

LN

Jill Taupe |0OS 1981-[!3—_{5)

By common ID value to get this dataset:

Name 1D DOB Department Level

1 ﬂQ’h_H Black I|Eﬂ1\'lEFEIEI-{]?'—EI Engineering 1 )
2|Paul White | 002 1973-03-11 Sales 2
3|Barry Green|003 [1977-1.2-30 Engineering 2

4l)ane Brown| 004 [1980-11-03 Marketing 1

SU&Taupe (I_ﬂj,l%l—ﬂS—ﬂ}lSale& 3y

¢ Drag the two dataset files onto the Center pane of Easy Data Transform.
e Select the two datasets using Cmd+click.
e Click the Join transform in the Left pane.
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join-example-1a.csv

3 cols x 5 rows

o Join

S5 cols x5 rows

join-example-2a.csv

3 cols x 5 rows

e Set both Top key column and Bottom key column to the common (‘key') column.

| Join | % | B2 2

@ Merge 2 input datasets side by side using common (k...

Explore Keys...

Top key column: 1D (%]

include top non-matching rows

Bottom key column: 1D el
include bottom non-matching rows
case sensitive
detailed report

The datasets are now joined side-by-side using the common column. The top dataset is
shown on the left. You can swap the vertical positions of the datasets to change the order in

which they are joined.

If you just want to join row N of one dataset to row N of another dataset, you can use the
Row Num transform to create a common column in each dataset.

Set include top non-matching rows and include bottom non-matching rows depending
on what you want to do with top and bottom dataset rows for which there are no matches.
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Note that matching columns takes account of whitespace. So you might need to do
Whitespace transform before the join.

If you only want one column from the second dataset you can use the Lookup transform.

If you want to find key values that are in one dataset but not the other (an 'anti-join") you can
use the Subtract transform:

Clone
/]
14 cols x 750 rows
Filter » .. Subtract Rows not joined
e @ from top dataset
11 cols x 87 rows 11 cols x 9 rows
Join
(/]
/ 24 wols x 720 rows
Filter Subtract ioi
NP © Eowsbn;tjmr;e? .
14 cols x 750 rows 14 cols % 30 rows rom bottom datase

If you are merging numerical datasets you can also use an Interpolate transform.

See also:
¢ Video: How to join Excel files

3.18 Move a .transform file

To move a .transform file to a different location on the same computer use File>Save As... or
Finder. You either leave the Input files at the original location or move them to the same
location relative to the .transform file (e.g. if they were in the same folder as the .transform
file before, move them to the same folder as new .transform file).

To move a .transform file to a different computer, move the Input files to the same location
relative to the .transform file (e.g. if they were in the same folder as the .transform file before,

move them to the same folder as new .transform file).

See also .transform files.
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3.19 Open multiple main windows

To open an additional Easy Data Transform Main window, select File>New Window.
3.20 Output nested JSON or XML

You can use the dot ('.") character in the column header to show nesting. For example:
name carb cholesterol fiber minerals.ca minerals.fe protein sodium vitamins.a vitamins.c

1 Avocado Dip 2 5 0 0 0 1 210 0 0

Is output to JSON as:
[

"name": "Avocado Dip",
"Carb": "2",
"cholesterol": "5",
"fiber": "O",
"minerals": {

"ca": "O",

"fe": "O"
bo
"protein": "1",
"sodium": "210",
"vitamins": {

"a": "O",

"c": "O"

]

And to XML as:

<?xml version="1.0" encoding="UTF-8"7?>
<root>
<record>
<name>Avocado Dip</name>
<carb>2</carb>
<cholesterol>5</cholesterol>
<fiber>0</fiber>
<protein>1</protein>
<sodium>210</sodium>
<minerals>
<ca>0</ca>
<fe>0</fe>
</minerals>
<vitamins>
<a>0</a>
<c>0</c>
</vitamins>
</record>
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</root>

For more details see:
e JSON format
e XML format

See also:

e Video: How to convert CSV to XML
e Video: How to convert CSV to JSON

3.21 Output to Excel

To output results from a transform to an Excel .xIsx/.xls file:
e Select the transform item in the Center pane.
e Click To File at the bottom of the Left pane.

Y L ] Easy Data Transform v1.16.0 (licensad to Oryx Digital Ltd)

DB o AR S HF @ * How Do I?

R Caly
Fegmamy Caly

Reorder Cols

PR E A

Foplack
Row Num
Sample
Slice
ot vaccination.csv
Spiit Col @ 3 cols x 5.8k rows
Spdit Rows @
Spread 7)
® L Stack
Stamp @ 3 cols x 10,3k nows
Stals @
Substitute @
@ y vaccination2.csv
Summaty @ 3 cals x 4.5k raws
Tetal (@)
Transpose @
Urique @
Units @
Whitespace  (F)
v Qut

Stack 3| [
Mlign columns by;  Header name

Merge input datasets one on top of another,Orders by the
vertical positions of the input datasets.
Warnings | Info | Comment | Results

3 cals x 10,258 rows

Gl 2| e Show first 10 rows (B
country time bog_vacc

1 afg 1982 10

2 afg 1983 10

3 alfg 1284 M
4  afg 1985 17
5 alg 1986 1B
6 afg 1987 27
7 aig 1988 40
8 afg 1989 38
9 afg 1980 30
10 alg 1991 1

Last 10, 248 rows not shown

[ Email us questions/feedback

e Select *.xIsx or *.xls from the file type drop-down list that appears.

Easy Data Transform
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« CSV file (*csv)

. Excel file (*xis)

PR Al £Ta Pk ke )

Note that Excel .xIsx files are typically limited to 1,048,576 rows and 16,384 columns.

See also:

e Write to multiple sheets of an Excel file

¢ Video: How to convert fixed column width to CSV or Excel
e Video: How to convert JSON to Excel

¢ Video: How to convert XML to Excel

3.22 Profile a dataset

In the Right pane you can double click on a column header or click the corresponding button
to show a profile of the data in each column. For example the different data types (text,
numeric etc) and the frequencies of different values. Potential discrepancies (such as missing
values) are highlighted in red.

You can use profiling in conjunction with Filter, Remove Cols and Replace transforms to
remove unwanted rows, columns or values; and with the Impute transform to add missing
values.
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Data Characters Warnings (1) Info Comment
12 cols x 891 rows
B & £ D e |l E|Y =4

Column; = Embarked

Show: 20 C  Most frequent values bars ® %
Value Frequency
— 5 644 [ 72.28%
10 o= 168 / 18.86%
4 o 77/ 8.64%
{empty) 2/ 0.22%

RIS

Details

3 Read
IR 2

Column Values

Sample: All 891 rows

include dates include statistics

Metric Value
Empty wvaluas

Non-empty values
Numeric values
Integer values
Real walues
Boolean values
Text walues
Distinct values
Unigque values
Duplicated walues
Min length

Max length

Average length

For large datasets you might want to set Sample to less than the full dataset for speed. You
can also leave include dates and include statistics unchecked for speed (include dates
checks against every date format listed in Preferences).

See also:

e Video: How to profile data
e Summary

e Add missing data values

e Clean a dataset

3.23

Perform the same transforms on many files

You can perform the same set of transforms on multiple inputs in one operation using batch

processing or command line arguments.

Example 1
To convert a folder full of json files to .csv files:

1. Select File>New to create a new .transform file.

Easy Data Transform
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2. Drag one of the .json files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

3. Click on the To File button at the bottom of the Left pane and set the location of a .json
file to create. Ensure the options (encoding etc) are correct in the Right pane.

test.json output.csv

__..0

6 cols x 155 rows 6 cols x 155 rows

9

4. Select File>Batch Process.
5. In the Batch Process window change the . json file name to *. json, so that all the
. json files in that folder will be processed.

€ Batch Process* X

Input locations can include wildcards and Excel sheet names:

E.g. 'C\Users\andy\Documents\output_*.csv' or 'C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'C\Users\andy\Documents\output_{test} {datetime}.csv'.

Where {test} is replaced with the file stem of the input with alias 'test'.

And {datetime} is replaced by the processing date and time.

Click "Help' for more details.

Add Remove | Clear

Input alias=test QOutput alias=output (Overwrite)
1|C:\Users\andy\Desktop\*,.json ... C\Users\andy\Desktop\output_{test}.csv

Process| Stop

Close Help

6. Press the Process button. A . csv file will now be created for each . json file in the folder.
In the example above the {test} file name variable will be replaced by the file name of
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the input file with alias test (if you just output to output.csv then you would be
continually overwriting the same file).
7. Select File>Save to save your .transform for future use.

If you want to process input files from another folder then click Add to add a new row and
change the input folder.

Example 2
To merge multiple .csv files into a single .csv file:

8. Select File>New to create a new .transform file.

9. Drag one of the .csv files onto the Center pane. Ensure the options (encoding etc) are
correct in the Right pane.

10.Click on the To File button at the bottom of the Left pane and set the location of a
merged.csv file to create, in a different folder to the input .csv files. Ensure the options
(encoding etc) are correct.

© test.csv gmerged .CSV

14 cols x 10k rows 14 cols x 10k rows

4. In the Right pane set Write Mode to Append and check write header and if empty.
This ensures that only one header will be written, rather than one for every input file.

Easy Data Transform © 2023 Oryx Digital Ltd



How do I?

merged.csv d} E :

@ Output to file.

File: C:\Users\andy\Desktop\merged.csv

Type: Delimited text v

Delimiter: Comma () v

Quoting: As needed A

Line endings: Automatic v

Encoding:  UTF-8 v
v rle

Write modg: Append v
V' write header v if file empty

Alias: merged

5. Select File>Batch Process.

6. In the Batch Process window:

e change the input .csv file name to * . csv, so that all the . csv files in that folder will be
processed.

e Check clear '‘Append’ outputs before first append so that any existing data in the output
file is cleared before Easy Data Transform start appending to it.
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€ 5a

Input locations can include wildcards and Excel sheet names:

E.g. 'C\Users\andy\Documents\output_*.csv' or 'C:\Users\andy\Documents\output_data.xlsx[*]".
Output locations can include variables {test}, {date}, {time}, {datetime}:

E.g. 'C:\Users\andy\Documents\output_{test} {datetime}.csv".

Where {test} is replaced with the file stem of the input with alias ‘test'.

And {datetime} is replaced by the processing date and time.

Click "Help' for more details.

Add = Remove Clear W clear 'Append’ outputs before first append

Input alias=test Output alias=merged (Append)
1 C:\Users\andy\Desktop\*.csv ... C\Users\andy\Desktop\merged.csv

Process| Stop

Close Help

7. Press the Process button. A single merged. csv file will now be created that contains a
concatenation of all the other . csv files.
8. Select File>Save to save your .transform for future use.

If the headers are different orders in different .csv files, then you can Stack by header name in
your .transform to get a consistent column order before outputting.
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cols-in-order....

14 cols x 1 row

Stack merged.csv
9 —® g
28 cols x 10k rows 28 cols x 10k rows
test.csv
@
14 cols x 10k rows

Stack (‘fj EG

@ Merge input datasets one on top of another. Or...

Align columns by({ Header name v

See also:

e Video: Batch processing

3.24 Replace empty values

You can replace empty values using the Replace transform.
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! nl n n3

1 123.8 9876.1

2981234 23.3
3 288
Replace d} E C

@ Replace multiple text in the selected column(s). Can use powerf...

El Q Filter columns

ni

v

v "

JHE

3 of 3 columns selected
@ T VB & X

Match Type Replace With
1 Empty v 0.0

- !
Vv case sensitive

y

ni nZ n3

11 123.89876.1 0.0

2981234 00 233

3 288 00 00
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See also:
e Add missing data values

3.25 Run jobs on a schedule

Easy Data Transform doesn't currently have it's own scheduler. However you can run jobs on
a schedule (e.g. at 5pm every day) by using pretty much any scheduler to call the Easy Data
Transform command line interface:

1. Create the .transform file that details the transformations you want to carry out.
2. Call Easy Data Transform command line interface (or a script that calls the command line
interface) from your scheduler.

You can use launchd, which is part of macOS (but not very friendly). Or you can use any
number of third party scheduler applications , such as LaunchControl.

@ LaunchControl File Edit Job View Window Help
[ ] @ local.job.plist

User Agents B © Label Daily data transform Unload
Q- r

File .. Status [Applications/EasyDataTransform.app/Contents/MacOS/EasyDataTransform /
Usersfandyb/daily.transform -cli

Program to run

com.dropbox.Dro  + Ok
com.google.keyst « Ok

Set Executable.., Edit File.., Enable Globbing
com.google.keyst « Ok
com.oryxdigital.ai + SIGABRT Default argv[0] B
com.oryxdigital.ai + SIGABRT | 4 -
Start calendar interval
org.virtualbox.vbc Unloaded Maonth Day Weekday Hour  Min...

Any < Any < Any = 17 =00 =2

Remaove All Add

You can change the input and output file names through the command line interface. Add -
cli to close Easy Data Transform after the job is finished.

Some schedulers will also allow you to call Easy Data Transform on an event, e.g. when a file is
added to or updated in a particular folder.

3.26 Scrape web data

You can scrape data from a web browser by selecting it and dragging into the Center pane of
Easy Data Transform (or copying and clicking From Clipboard).
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o Select data in web a browser

Symbo/lCompany Name IChangel
v 208.17-8.28-3.83%
CVX Chevron Corporatio 160,95 3.63-2.21%)

e Drag onto Easy Data Transform
B Easy Data Transform v1.27.0 (licensed to Oryx Digital Ltd)*

DBRE v O0QRKRQAFH ® | *HowDo I?
i Input
From File ®
From Clipboard ®

INJ
v Visa Inc.
MA Mastercard Incorporated

CVX Chevron Corporation

BAC Bank of America Corporation

e Drop

€ Easy Data Transform v1.27.0 (licensed to Oryx Digital Ltd)*
_ Eile Edit View Licensing Help

DB8RE v~ JQRQFH ® | *HowDol?

! Y

v Input
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See also:
e Video: How to scrape web data
3.27 See changes from a transform

The following transforms allow you to highlight changes made by the transform:
o Case

° m

e DateTime Format

e Decode

e Extract

e Fill

e Whitespace

Check the compare changes checkbox below the data table to highlight changes made by
the transform.
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CEEW warnings | Info | Comment | Details

3 cols x 4 rows % 2 changed,10 unchanged
B eV ! ][ 1
Gender
Andy M
2 Claire Green F detail of

white m selected change

4 Emma Black F

I:ampare changes - | ‘T* ‘john'->'John’

next/previous change
change color

Click on or hover over a cell to see details of each change.

Click on the up and down arrows to move between changes. Changes hidden by dataset
filtering are skipped.

If you want to see rows that were removed by a transform such as Dedupe, Unique or Filter,
you can do that using Subtract. The dataset needs to have a column of unique key values to
use in the Subtract. If it doesn't have one, then add one first using Row Num.
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orders.csv Row Num » . Subtract

/] — 0 /]
14 cols x 913 rows 15 cols x 913 rows \ 15 cok x 83 rows

Dedupe
® P
15 cok x 830 rows
T
Subtract ¥

¥ Nl
@ Remove rows from the top dataset whose key val... |

Top key column: Row Num v

Bottom key column: Row Num v

v case sensitive

3.28 Set output file name from input file

To set an output file name based on the name of one or more input files, see File name
variables.
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Alias: orders

orders-dec-2...

14 cols x 830 rows

Join output_{orde...
/] —
18 cols x 2.2k rows 18 cols x 2.2k rows
order-details....
5 cols x 2.2k rows
File: C:\Users\andy\Desktop\output_{orders.fname}.csv

3.29 Show whitespace

Click the eye icon in the Right pane to show whitespace in the data.

EEE warnings | (D Info | Comment | Details

2 cols x 3 rows & Rei

B B | Z]|®|F YV
A

Epress ta shaw whitespace in the dataset as symbols:

Space:
1 1 Takb: 5
Carriage return: =
2 2 Line feed: !
Mon-breaking space; _
3 =3

Other whitespace: O
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3.30 Split a dataset into multiple files

Easy Data Transform supports splitting datasets into multiple files in 2 different ways.

Example 1: Simple splitting

To split a dataset according to whether the Gender column contains M or F, use a pair of
Filter transforms.
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Filter

@ Filter rows by text, date or numeric values in sel...

KA
¥ N

'

male_employ...

19 cols x 10 rows

female_empl...

19 cols x 8 rows

@ @ |§=g) ég:l X Keep ¥ | Matching any
Column Op. Value
1 Gender y.= ¥ M
Filter
L/
19 cols x 10 rows
employees.csv
19 cols x 18 rows
Filter
/]
19 cols x 8 rows
Filter ICP @ Eg

el I

Column
1 Gender

v

Keep
Op.

@ Filter rows by text, date or numeric values in sel...

Matching any

Value

Example 2: Split according to row values

To split a dataset according to Region column values

e Use transforms (such as Substitute) to create a column with the file location you want to
output to, based on the Region column. The location can be an absolute path
(e.g. /Users/andy/output.csv) or a path relative to the .transform file location (e.g.
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results/output.csv). Folders output to must already exist. Empty or invalid values are
ignored. This column is not output (use the Copy Cols transform if you want it to be).

e Create an output with Output to set to Multiple files and the Files column selected.

¢ Set Confirm files checked to be prompted before writing (recommended).
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Multiple files FECS
® Output to fi J
Output to: | Multiple files v
Files columr): Region file v
Confirm files: V'

Type: Delimited text v

Sl S P PP /vi

o (ST

Data = Wamings ()Info  Comment ¢ »

3 cols x 5 rows @ written
PRZO@F YK =2 2AT ML
Name Region Name Region Region file

1John Smith  North 1John Smith  North  North_staff.csv

2 Jane Green West 2 Jane Green West West_staff.csv

3 Brad White South 3 Brad White South  South_staff.csv

4 Faisal Ali East 4 Faisal Ali East East_staff.csv

5 Jill Black North 5 Jill Black North  North_staff.csv

l l t’_ﬁ East_staff.csv

° sales_staff.csv © Substitute © Multiple files | B North_staff.csv

2 cols x 5 rows 3 cols x 5 rows 3 coks x 5 rows E? South staff.csv

T E& West_staff.csv

Substitute Ou = EC

® Substitute column values into text.

New column name: Region file
Substitution script:

$(Region)_staff. csv|

Insert variable: <select> ¥  Evaluate

Data = Wamings Info  Comment (|»
3 cols x 5 rows 05 evaluated
(6B @ F VK< = AT 1L
Name Region Region file

1John Smith  North  North_staff.csv
2 Jane Green  West West_staff.csv
3 Brad White South  South_staff.csv
4 Faisal Ali East East_staff.csv

5 Jill Black North  North_staff.csv
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Example 3: Split by size

To split a dataset into files of 1000 rows each:

Multiple files FECI
@ Output to file.
Output to:  Multiple files v
Files column: File name v
L
Row Num
& £y Confirm files: Vv
@ Add a new column with the row number. . Type: Excel XLSX -
Start at: 1 - . .
Formatting: Automatic n .
Increment: 1 = - . ‘ B split-1.xlsx
Write mode: Overwrite ¥ Sheet b
) .
Every: 1000 = v write header B split-2.xIsx
) .
\ E split-3.xlsx
) .
E split-4.xlsx
: i Multiple files S enli
o L10k.csv o Row Num o Substitute o p | B split-5.xisx
14 cols x 10k rows 15 cols x 10k rows 16 cols x 10k rows 16 cols x 10k rows Eﬁ Sp|it*6.X|5X
) .
E split-7.xlsx
) .
E split-8.xlsx
KA [ 2 I
Substitute C}} s N E 5p|lt*9.X|5X
) .
(3) substitute column values into text. E split-10.xlsx
New column name: File name
Substitution script:
output\split-$(Row Num).xlsx
See also:

e Video: How to split CSV into multiple files

3.31 Trigger an update when an input changes

Check watch file in the Right pane for an input file if you want to trigger processing
(Run>Auto Run checked) or set it to 'Needs update' (Run>Auto Run unchecked) whenever
the input file changes.
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100k.csv el = ZG
@ Input from file.
File: D:AEDT data\CSV\100k.csv

L~~~

ignore empty . .nns

[ v watch file ]

Note:

e If you are also outputting to this file in the same .transform you are inputting it, it may cause
the .transform to run forever.

e The update may not be triggered if the file is deleted and replaced with a new file with the
same name.

3.32 Use Easy Data Transform from a USB key

See Portability.
3.33 Visualize data

Currently Easy Data Transform does not support charting beyond data profiling. However it
can easily integrate with other tools that do. For example. by outputting a CSV for import into
the visualization tool, or copying and pasting via system clipboard.

For example, you can copy and paste data direct from Easy Data Transform to rawgraphs.io:
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@ cory

Data = Chara Warnings  Info  Comment  Details
2 cols x \
B Bz

countriesAndTerritories deaths per 10k
1 Ecuador 0.18
2 United Kingdom 0.09
3 Italy 0.08
4 Spain 0.06
5 Netherlands 0.05
; &« C @ O B https://app.rawgraphs.io

RAWGraphs 2.0 beta

! e Paste
|
I

1. Load your data \

(7] Paste your data

I, Upload your data
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2. Choose a chart
e Choose chart type

Show Allcharts -

Correlations, proportions ~ “*ttt Networks Correlations

||| Alluvial Diagram Arc Diagram ‘ I Bar chart
I i

Multi-set bar chart
[ | I I Correlations, proportions

Stacked bar chart

Correlations, proportions

Beeswarm plot
Distributions, time series,

Bar Chal’t .I.l & - proportions
3. Mapping o Choose columns
DIMENSIONS CHART VARIABLES

Aa countriesAndTerritories Bars X Size Color

_ Aa countriesAndTerritories X # deathspe.. Sum ~ X Aa C.. CSV(unique) ~ X

# deaths per 10k

4. Customize e Customize

ARTBOARD +

Belgium

CHART = Brazi
Canada
Padding 1 =
Denmark
Bars orientation Horizontally # Dominican_Republic
Ecuador |
Sort bars by Name ]
France
SERIES + italy
Netheriands
COLORS =
Panama
Color scale Ordinal - Peru
Portugal -
Color scheme | I -
Romania -
Belgium W #9E0142 Spain
Brazil B #8E2440 Sweden
Switzeriand
Canada B #D8454B
United_Kingdom
Denmark W #EB6349 United_States_of_America
deaths per 10k [sum]
Dominican_Repub... [l #F68550 oo 0ts o%e o0 o2 ot ote ote
See also:

e Video: How to visualize data with rawgraphs.io

Easy Data Transform © 2023 Oryx Digital Ltd



https://www.screencast.com/t/YSjp8vaMc2

How do I?

3.34 Write to multiple sheets of an Excel file

To write to multiple sheets (tabs) of the same Excel file you need to set the Write mode of

each output item to Overwrite/Sheet (to clear the sheet first) or Append (to add to existing
sheet data).

customers.xlsx[records] @ (f' i

File: /Usersfandyb/customers.xlsx[records]

Format as: MNumber/Bool/Date/Text

<
(ﬂ__r_ite mode:  Overwrite H Sh@ a

v

customers.xlsx
./  [records]

customers.csv

11 cols x 91 rows

11 cols x 91 rows

customers.xlsx
2/ [summary]

12 cols x 9 rows

Y Summary

12 cols x 9 rows

customers.xlsx[summary] @ (f' E:

File: /Users/andyb/customers.xlsx[summary]

Format as: Mumber/Bool/Date/Text H
'ﬁ';i_te mode:  Owverwrite £ SheeD ke
Wit O] T

If you set the Write mode to Overwrite/File for an item then the write will remove existing
sheets.
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Expert tips
Expert tips

Here are some tips to help you be more productive with Easy Data Transform.

1. Type a keyword in the transform keywords field to quickly find the right transform.

et Transform

= —
I\"-i._ g I'GLJ:FJ 1“' |

A

Gather @
Unigue @

2. To add a transform click an existing Center pane item and type the first few letters of the
transform name.

[ COVID-19-geo...
v [COVID-19-ge...

11 cols x ﬁ:.?k rows

S

3. Check the show advanced checkbox in the Left pane to see all available transforms.

- Transform

All transforms (2]
show advanced

([ |
\K -

Calculate @
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4. Uncheck Run>Auto Run to take full control of when items are processed.

. @
1DE%§@R:- 5] O

5. Hold down the shift key and drag on the Center pane to scroll left/right/up/down.

Y Dedupe

{rows 18 cols x 830 rows

Press ST

v

\\\
\\_

tax-rates.csv

11 cols x 70 rows

6. Use Note items to remind yourself how a complex .transform works.
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b

_.iv{outp[:gt.xlsx

6 ols % 155 rows

Select items in the center pane
(8] \.l'iE"-r’v'

7. Look in the Warnings and Info tabs in the Right pane to troubleshoot potential issues.

Data @ info | Comment

Number of values per row vary:
2730 input rows have 1 value: E.g.input row 2

8. To select multiple items in the Center pane, left click with the mouse and drag a box over
the items you want to select.
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9. Try to avoid disconnecting transforms, as this can reset column related options
downstream. Add a transform to an existing connection instead. You can also delete a

transform without deleting it's connections.

customers-2023.csv E} Rename C0|S
_>o

14 cols x 10k rows 14 cols x 10k rows

Select a connection

customers-2022.csv

14 cols x 10k rows

10. Add a Sample transform straight after the input of a large dataset and set Rows to pass
through only the first 100 or so rows. Once you have completed all your transforms you can

then Disable sampling to pass through all rows.

11. Check View>Timing Profile to see where the processing time is being spent.

|

10k.csv
(/]
14 cols x 10k rows
=] I O |
Stack Filter Sort output.csy
— G — G — 0 P
14 cols x 110k rows 14 cols x 81,5k rows 14 cols x 81,5k rows 14 cols x 81,5k mows
.
100k.csv
(/]

14 cols x 100k rows

12. Click the eye icon in the Right pane to show whitespace in the data.
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EEEN warnings | @ Info | cComment | Details

2 cols x 3 rows & Rei

B BB | Z|®|F |V
A

Epress to show whitespace in the dataset as symbols:

Space:
1 21 Tak: +
Carriage return: “
2 12 Line feed: !
Mon-breaking space: _
3 3 Other whitespace: O

13. Check compare changes in the Right pane to see changes from a transform (selected
transforms only).

IEEEW warnings | Info | Comment | Details
3 cols x 4 rows & 2 changed,10 unchanged

BB £ e |V ¢
Gender

Andy M

2 Claire Green F detail of

WHite m selected change

4 Emma Black F

I:r::mpare changes . | T ‘john'->'John’

next/previous change
change color

14. Select a column and click the bars icon in the Right pane to show the frequency of values.
Potential issues are shown in red.
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Data Characters Warnings @ Info Comment Details
12 cols x 891 rows 3 Read
BB /0D elME Y > || \AIE -
[ ] [ ] Column Values
Column: Embarked ||« Sample:
Show: 20 .  Most frequent values bars % include dates
Value Frequency Metric
— 3 644 [/ 72.28% Empty valuas
10l C 168 / 18.86% Mon-empty walues
Q 77/ 8.64% Numeric values
{empty) 2/ 0.22% Integer values

Real walues
Boolean values
Text walues
Distinct values
Unigque values
Duplicated walues
Min length

Max length

Average length

All 891 rows

include statistics

Value

B89

15. Enable drilldown to double-click on a cell and see how the information was derived.

16. Filter data in the Right pane.
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Data Warnings
11 cols x 14,658 rows

OENPZ Y

dateRep
1 2020-05-03

2 2020-05-02
3 2020-05-01
4 2020-04-30

5 2020-04-29

Info

Comment

Details

o Reac

&< ([0 TN

day month year

30

29

2020

2020

2020

2020

2020

cases dea™

134

164

222

122

124

17. If you need several similar branches of transforms you can create one branch and

duplicate it.

18. If you have 2 or more monitors connected to your computer try View>Two Screen

Mode to show the Right pane on your second monitor.

19. Use batch processing with wildcards (e.g. *.csv) to process a folder full of input files in one

operation.

20. Use command line arguments to run .transform files from a batch or script file.

21. Use file name variables to set the name of an output file based on the name of an input

file, date created etc.
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as: |

/

guest-list.xlsx

@ [wedding_sa... Q{!;lLlestlist}_c)_,_

9 cols x 68 rows 9 cols x 68 rows
{guestlist}_output.csv 0{} @ EG
@ Output to file.
Output to:  Single file v
File: C:\Users\andy\Desktop\{guestlist}| output.csv

22. Use column variables when you want to use values from columns in transforms such as If
and Filter.

]
[Filter | - IC? =2 E;
(%) Filter rows by text, date or numeric values in selected...
@ @ B & || X| keep (2]

Column Op. Value

1 Transaction B > B 3%(Threshold)

23. Learn keyboard shortcuts. For example, you can quickly change selection in the Center
pane using arrow keys with the Cmd key.
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Left Arrow Up Arrow

V‘,Remove Cols

Dedupe

4 —
Right Arrow

4 cols x 14.7k rows 4 ls x 209 rows

Pivot L/ Sort

2 als x 210 rows 2 @ls x 210 rows

Spread

v

104 colg x 209 rows

| Down Arrow |

24. Change focus between the Center and Right panes using Option+[ and Option+].

25. Check the gray Left pane buttons when not available checkbox in the General tab of
the Preferences window for Left pane buttons to be disabled until the appropriate items in
the Center pane are selected.

26. Double-click on an item in the Center pane to show it fullscreen.
27. Check watch file in the Right pane for an input file if you want to trigger processing
(Run>Auto Run checked) or set it to 'Needs update' (Run>Auto Run unchecked) whenever

it changes.

28. Check View>Show Row/Col Changes to show changes in the number of rows and
columns in the Center pane.
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row(s) no change to

column(s) column(s) rOWs or
added added removed columns
i New Rows M o Calculate s ® Count : ® Case
12 cols x 1.8k rows 13 cols x 1.8k rows 2 cols x 89 rows 2 cols x 89 rows
row(s)
removed

29. Use the Subtract transform to perform an 'anti-join'.

Clone
9
14 cols x 750 rows
Filter » . Subtract Rows not joined
0 ® from top dataset
11 cols x 87 rows 11 cols x 9 rows
Join
/]
24 wols x 720 rows
Filter Subtract joi
P © fRowsbn;tjou;eii .
14 cols x 750 rows 14 cols x 30 rows rom bottom datase

30. Deploy Easy Data Transform as a portable application so you can run it from a USB key or
install it on computers where you have limited access rights.

31. Find items matching one or more search terms in the Center pane using View > Find
Items.

32. Magnify under the cursor in the Center pane using View>Magnify Cursor.
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aed@p# ®

"How Do I? @

/0 Spread

deaths by date
106 cols x 2Bk rows
b Lg Count
'|I II
\
II
\

1
\_ nedupe \ 1nin

33. Use the right click menu to insert control characters into a text option for a transform.
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)

| Concat Cols | 1% | F S

@ Concatenate selected columns into a single new colu... a

_' EI IC}L Filter columns .:I

name

id

nametype

recclass

gy mass (g)
10 of 10 columns selected
Delimiter:

Undo '

EIENN Charz . Details
11 cols x 45,71 id 10 cols

(o & & *@ Paste IR 2R

name id
1 Aach 1
o PPN Insert Control Character [ 2 Carriage Return
Line Fee -.;
3 Bbee Tab

-
34. Experiment with changing Optimize processing for from Minimum memory use to

Maximum speed in Preferences to see if that improves performance. It may be slower or it
may use up all your memory.

35. Change the Center pane color scheme in the Colors tab of the Preferences window.
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(] ] Preferences
General Dates Input Extensions Qutput Extensions

Color scheme: Custom

Selection: from operating system |

Connections: |

Fill Border Text

Inputs:

Transforms:

Outputs:

Motes:

Shadows:

Hotblack [B) << Set Custom To

Preview

Oulput.csy
o

®

36. Select View>Toggle Ul Theme to swap between light and dark user interface themes.
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¥ How DoI?
Input
[From File
From Clipboard
Transform

Al transtarms

Cesnpars Cols
Cancat Cols
Concat Rows

Capy Cols

Qrders by the

ment  Results

Show first 10 rows

Email us questions/feedback

37. Select File>New Window to open a new Main window.
38. Set the Center pane mouse wheel behavior in the Preferences window.

] Preferences

Dates Input Extensions QOutput Extensions Colors

Forward=Zoom in (+Option=Scroll up)
Store these preferences in:  Forward=Zoom out (+Option=Scroll up)
Does nothing

User interface font: Default
Data table font: Courier New, 13 pt Choose... Default
Locale:  English United Kingdo 3 Default

@) Cancel
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5 Support

5.1 Forum

There is a discussion forum online at forum.easydatatransform.com. You can use this to ask
questions, share what you are doing and keep up to date with news.

5.2 Contact support

If you have any questions or suggestions, please post a question on
forum.easydatatransform.com or email us at support@easydatatransform.com.

5.3 Report abug

Please report any bugs you find to support@easydatatransform.com Please include:

e your operating system (e.g. macOS 12)

e the version of Easy Data Transform (from Easy Data Transform>About Easy Data
Transform)

e a step-by-step description of how we can reproduce the problem

e your .transform file and input data files (where appropriate)

e a screen capture or video can often be helpful

The step-by-step description is particularly important - if we can't reproduce your problem,
then we probably won't be able to fix it.

We treat all data sent to us as confidential, unless you tell us otherwise. If your data is
particularly sensitive, it might be enough to send us just the first few rows with sensitive
values changed. Keep the same column structure though.

5.4 Request an enhancement

We are always very interested to hear your suggestions on how the software can be
improved. Please post a feature suggestion on our forum.easydatatransform.com or email us
at support@easydatatransform.com.
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transform file 286

-A-

abs 27

add 27
aggregate 227
and 27,91

Automatic and manual processing.

-B-

base (numeric) 130
base64 decode/encode
batch processing 279
binary 130
boolean 270

-C-

calculate 27

case 35

Center pane 21
chop 38

classify 40
cleaning data 298
clone 40

cluster 40

column variables 274

command line arguments

comments 262
compare cols 44
concat cols 47
concat rows 49
connections 265

copy 304
copy cols 55
count 57
cross 59

crosstab 203
CSV format 241
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dark mode 291

date format 60

dates 268

day of week/month/year 27
decimal separator conversion 133
decode 67

dedupe 69

divide 27

drilldown 277

duplicate 304

-E-

Excel format 243
expert tips 351
extensions 23
extract 72

-F-

file extensions 23
file formats 240

file splitter 341
filename variables 283
fill 78

filter 80

Fixed width format 244
forum 366

fuzzy matching 276

-G -

gather 84
group by 84

-H-

hashing 86

header 89, 264
hexadecimal 130

HTML 250

HTML escape/unescape 67



- -0-

if 91 octal 130
impute 95 offset 140
input 24 or 27,91
insert 100 outliers 142
interpolate 102 output 235
intersect 105
Introduction 8
-P-
-j - pad 147
paste 304
Javascript 106 percent 302
join 110 percentile 211
JSON format 247 pivot 149
pivot longer 84
. L - pivot wider 203

Plain text format 253
portability 287
power 27

Left pane 21

locale 270

Log pane 21 preferences 21
logarithm 27 Preferences window 21
long pivot 84 processing 261

lookup 114 profiling data 327

profiling time 261
psuedo-random 152

-M -

Main window 20 = Q =
Markdown format 252

meta information 271 Quick start guide 8

month 27
moving 117 - R -
moving average 117
multiply 27 random 152
rank 192
- N - regular expressions 275

remove cols 154
newcol 121 rename cols 156
reorder cols 157
new rows 123 |
ngram 126 “?phace 159
num base 130 ng.t pane 21
num format 133 rolling average 117

numbers 269 rownum 168
run processing 261

running average 117
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visualization 346

-S- W

sample 170

scale 172 web scraping 335
scheduling 281, 335 whitespace 232, 340
scrape web data 335 wide pivot 203
scripting 106

sequence 180

slice 187 - X -

slide 189 XML escape/unescape 67
sort 192 XML format 256
split col 196 wor 27

split file 341

split rows 200

spread 203 - Y -

stack 205

stamp 207 YAML format 260
standard deviation 211 year 27

stats 211

substitute 214
subtract 27,215
summary 216

system requirements 8

-T-

text 267
time format 60
total 220

transpose 223
TSV format 253

-U-

unfill 224

unique 227

units 230

Unix timestamp 27
unpivot 84

URL encode/decode 67
USB key use 287

-V -

vCard format 255
vcf format 255
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